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Welcome to Live

1.1  The Ableton Team Says: Thank You

Live is the result of musicians wanting a better way to create, produce and perform music us-

ing a computer. A great deal of effort has been put into making Live easy and fun to use, yet

at the same time capable of helping you create music with unlimited depth and sophistication.
This effort continues even as you read these lines... in fact, a new, improved Live version might
already be available for download! Please check on our website now!, or choose the Check for

Updates command from the Help menu.
We hope you enjoy using Live and that it enhances your creative process.

Your Ableton Team.

1.2  What's New in Live 102

1.2.1  Device Additions and Improvements

* Wavetable (page 541) is a new dual-oscillator wavetable synthesizer that's both easy to

program and deeply powerful.

¢ Echo (page 359) is a new and highly-flexible delay effect with lots of modulation possi-
bilities. It's capable of a wide range of sounds from classic analog-style delays to modern,
digital approaches.

1 http://www.ableton.com/downloads
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* Drum Buss (page 356) is a new effect that brings analog-style character, body, and glue
to drum tracks. Drum Buss combines a range of commonly used drum processing tools into
a single device:

* Pedal (page 397) is a new effect, inspired by three classic guitar distortion pedals. Pedal
is capable of a range of distortion sounds from warm overdrive to aggressive distortion to
heavy and broken fuzz tones.

* Utility’s (page 415) Gain control can now be adjusted from -infinity dB to +35 dB. The
Left/Right Phase buttons now invert the signal at Utility’s input rather than at its output. A
Bass Mono section allows you to convert frequencies below an adjustable point to mono,
with an adjustable crossover control.

* EQ Eight (page 364) can now boost or cut frequencies down to 10 Hz.

1.2.2  Capture MIDI

Capture MIDI (page 257) introduces a new way of (not) thinking about MIDI recording.

Now, Live is always listening to MIDI input on armed or input-monitored tracks. Press the Cap-
ture MIDI button after you've played to create a clip containing your music. Live will automati-
cally try to find the tempo and set appropriate loop boundaries.

With Capture MIDI, you never have to worry about losing your experiments and improvisations
because you forgot to start recording. You can always capture what you've just played, after
you've played it.

1.2.3  Multi-Clip Editing

Up to eight MIDI clips can be viewed simultaneously in the Detail View.

Within the multi-clip view (page 185), clicking a clip’s notes or its loop bar selects this clip for
editing.

If multiple clips of different lengths are selected, the editor will show as many loop iterations as
are necessary for the clips to realign.
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1.2.4  Nested Group Tracks

Group Tracks (page 236) can now be created or moved within other Group Tracks. There is
no limit to the number of nested Group Tracks.

1.2.5  Arrangement Editing Improvements

* Holding [CTRL](PC) / [CMD](Mac) while scrolling will zoom to the mouse pointer’s posi-
tion. Holding [ALT] while scrolling will zoom the amplitude or pitch of the selected tracks.

¢ All Arrangement clips within a time selection can be moved using the left and right arrow
keys. Hold [ALT](PC) / [CMD]{Mac) while scrolling to temporarily toggle the grid on or off.

« [CTRL][Shiff](PC) / [ALT][Shift](Mac)-dragging within an Arrangement clip will slide the
material within the clip without moving the clip itself. Hold [ALT](PC) / [CMD](Mac) while
dragging to temporarily toggle the grid on or off.

* Holding [Shift] while dragging the edge of a warped audio clip in the Arrangement will
stretch the audio.

* Arrangement clips can be moved by dragging the upper half of the clip. Dragging in the
lower half will select time.

* It's now possible to activate, deactivate, or reverse a selected range of time. If the time
selection includes only a portion of a clip or multiple clips, Live will split the clips as neces-
sary, then perform the action on the split clips.

¢ Live now plays back MIDI notes in the Arrangement even if playback is started at a posi-
tion after the beginning of the notes. This behavior can be toggled off or on via the Chase
MIDI Notes command in the Options menu.

* Double-clicking in a MIDI track in the Arrangement will create a new clip. The clip will be
the length of the Arrangement’s grid resolution.

* When editing in the Arrangement or Detail View, Follow is now paused rather than dis-
abled. Follow will resume when scrubbing or restarting playback.

* [CTRL][L](PC) / [CMD][Ll(Mac) will now toggle the Arrangement loop on or off.

¢ Audio or MIDI files can be imported via an “Import...” command in the Create menu. The
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file will be inserted at the Insert Marker position in the Arrangement View or in the selected
clip slot in the Session View.

* The Lock Envelopes switch (page 310) can be MIDI or key mapped.

1.2.6  Automation Improvements

* Clip fades are now always available directly on the clip if the track is tall enough.

* In the Arrangement, all automation lanes are shown or hidden via the Automation Mode
button or the [A] key. When automation lanes are visible, the content lanes are minimized
to the height of the clip headers.

* ltis possible to Split or Consolidate clips in a time selection within an automation lane.

* Introduced fade edge handles in the Arrangement View, which allow users to change the
duration of a fade in (via the Fade In Start Handle) and fade out (via the Fade Out End
Handle) without affecting the fade peaks. However, a fade edge cannot move beyond the
fade peak. To do this, the clip start/end must be used to increase the size of the clip.

* Breakpoints now snap to the grid (or to existing breakpoints) when moved horizontally.

* Breakpoint values can now be adjusted vertically without moving the breakpoints in time.

* Automation segments can be moved horizontally.

* Itis now possible to create an automation breakpoint by double-clicking anywhere in an
envelope view/automation lane. In the Arrangement View, this means that MIDI clips can

only be created by double-clicking in the content lane.

¢ Automation values are now displayed when hovering over or dragging breakpoints or
avtomation segments.

* The [Shift] modifier is no longer required for moving automation segments past existing
breakpoints.

1.2.7  Navigation Improvements

* In Arrangement View, Detail View, Simpler and Sampler, holding [CTRL](PC) / [CMD]
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(Mac) while scrolling will zoom to the mouse pointer’s position.
* The Detail View now zooms to show the selected time within an Arrangement clip.

* Pressing [Z] will zoom to the time selection in the Arrangement and Detail Views. Press
[Shift][Z] to zoom back out.

* On U.S. keyboards, it is now possible to zoom by pressing [+] without holding [Shift].
* Audio effects can now be dragged to the Master track’s Scene Launch area.

* Dragging clips from existing tracks to the clip/device drop area creates a new track with
those clips, and also the devices from the original tracks.

* Dragging frozen clips and tails to the clip/device drop area in the Arrangement View cre-
ates new frozen tracks (which also contain the devices from the original track).

* Holding [Shift] while scrolling will scroll horizontally on both Mac and Windows (this pre-
viously only worked on Macs).

* The Show All Tracks command in the View and context menus in the Arrangement View
minimizes all tracks, allowing you to see as many as possible on your screen.

1.2.8  Mixing Improvements

A number of small improvements make mixing easier:

* A [right-click](PC) / [CTRL-click](Mac) command can switch each track’s Pan control to a
Split Stereo Pan control. In Split Stereo mode, you can adjust the stereo position of the left
and right channels independently.

* Double-clicking on a knob or slider will reset it to its default value.

¢ Individual Drum Rack pads can now be routed to one of the Drum Rack’s internal return
chains.

1.2.9  Browser Improvements

* A new Collections section (page 60) of the browser allows you to tag browser items
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with up to seven colors. Each color can also be given a custom name. Searching or brows-
ing within a Collection will then show only items with that tag applied.

* Uninstalled Packs or Packs with available updates can be installed directly from the brows-
er.

* Group Tracks (including nested Group Tracks) now appear when unfolding Sets in the
browser, and can be dragged into the current Set.

1.2.10 Setup Improvements

* Itis now possible to provide custom names for input and output channels via the Input/
Output Config buttons in the Audio preferences. These names then appear in all Input/
Output choosers.

* Itis now possible to choose between different metronome sounds via the Metronome's
pull-down and context menus.

* The Metronome can be set to click at various note divisions via its pull-down and context
menus. The default Auto setting follows the time signature’s denominator. Note divisions
that don't fit into one bar of the current time signature will be disabled.

* When Enable Only While Recording is enabled in the Metronome’s pull-down and context
menus, the Metronome will only be audible while recording. The Enable Only While Re-
cording setting is not saved and must be enabled every time Live is started.

* The Computer MIDI Keyboard is now off by default, and can be toggled on and off with
the [M] key.

¢ Context menu items now react when the mouse is released, instead of after the initial
mouse click. This makes it possible to drag away from a selection to cancel triggering an
item, while keeping the context menu open. When hovering over disabled context menu
items, they are no longer highlighted.

1.2.11  Interface Improvements

* Updated the appearance of clips.

¢ Enabled sample dots on waveforms. When zooming in, it's easier to see where samples
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are on the Beat Time Ruler.

* MIDI notes are now drawn in their clip’s color in the Note Editor.

* Added an Assign Track Color to Clips menu item to the context menu of track headers. The
command applies the track color only to clips in the currently active view (Session or Ar-
rangement).

* Incorporated a new font throughout the interface.

* Live's dials and sliders now look sharp at any zoom level.

* Introduced a set of five new Themes (page 32) in place of the previously available Live
“Skins".

* The clip/device drop area is now always displayed in Session View to enable dragging.

* Added Pen Tablet Mode to Live's Look/Feel Preferences. Pen Tablet Mode allows graphic
tablets and touch screens to control Live. This replaces the “AbsoluteMouseMode” options.
txt entry.

* Live now supports HiDPI monitors on Windows 10.

1.2.12  File Handling Improvements

* The Undo history is no longer cleared when saving a Live Set.

* The Export Audio/Video dialog now shows toggles for Encode PCM and Encode MP3.
When Encode PCM is on, a lossless audio file is created. WAV, AIFF, and FLAC formats
are available for PCM export. When Encode MP3 is on, a CBR 320 kbps MP3 file is cre-
ated. It is possible to export PCM and MP3 simultaneously. If neither toggle is enabled, the
Export button will be disabled.

* Saving a Set creates a Backup folder within the Project. This folder contains the 10 most
recently saved versions of the Set.

* Recorded audio files now include a timestamp in the filename.

* Live Sets now load samples faster, which may reducing the loading time of some Sets.
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* Large Live Sets can now be closed 5-10 times faster.

Numerous changes for Windows 10:

* Live now supports the Jump List.

* When using Live 9 and 10 in parallel, they no longer ask for admin rights if you start them
interchangeably.

* Owners of both Live 9 and 10 can choose which version of Live to open a Live Set with, by
using the [right-click](PC) / [CTRL-click](Mac) command on that Set and selecting “Open
With”.

¢ ltis now possible to associate .als files with a specific Live version, via “Control Panel” -
“Apps” - “Default Apps”.

1.2.13  Max for Live Updates

* Max for Live is now bundled with the Live installation and is loaded whenever Live is
started.

* Max for Live devices can now support multiple audio inputs and outputs, and routing is
available via the Live API.

1.2.14 Push Device Visualizations

* Compressor’s Gain Reduction view and Sidechain controls are now available on Push 2.
* EQ Eight's filters and spectrum are now visible on Push 2s display.

* Operator’s envelopes are now displayed graphically on Push 2’s display.

1.2.15 Push Note Layouts

* Melodic Sequencer + 32 Notes is a new note layout on Push 1 (page 608) and Push 2
(page 663) that uses the bottom 32 pads for notes and the top 32 as a step sequencer.
Pressing notes selects them for sequencing. This mode allows for real-time playing and step
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sequencing at the same time. Holding Note (Push 1) or Layout (Push 2) temporarily shows
the loop length controls in the fifth row of pads.

* When using the Loop Selector layout in Drum Racks and Simpler’s Slicing Mode, holding
Note (Push 1) or Layout (Push 2) momentarily toggles the 16 Velocities layout.

* When using the 64-pad layout, holding Note (Push 1) or Layout (Push 2) momentarily
shows the loop length controls in the top row of pads.

* Holding Shift while pressing Note (Push 1) or holding Shift while pressing Layout (Push 2)
now locks the alternate layout on. Pressing Note (Push 1) or Layout (Push 2) again returns
to the original layout.

* Layouts are now remembered per track.

* Holding Duplicate and tapping a loop length pad copies the contents of that page and
allows you to paste it to another page by tapping the corresponding loop length pad.

* Holding Delete and tapping a loop length pad deletes the content of that page.

1.2.16 Push MIDI Clip Mode

* When using MIDI tracks in Clip Mode (page 688), Push 2's display shows the notes
within the selected MIDI clip.

* MIDI clips can be cropped from Push 2.

1.2.17 Additional Push Improvements

¢ Control Surfaces, including Push 1 and 2, are now available when Live runs as a ReWire
slave.

* The Repeat button’s state is now remembered for each track.

* Added Split Stereo Pan Mode to Push 1 and 2. When Split Stereo Pan Mode is active
while in Global Mix Mode, the current pan value is displayed but the pan dial is inactive.
In Track Mix Mode, either the pan dial or stereo pan sliders are shown, depending on the
active pan mode.
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* Itis now possible to convert audio to MIDI from Push 2, via the Convert button.
* The Collections folder for color labels is now a root level entry in the Push 2 browser.
* Nested chains can now be displayed, folded, and unfolded on Push 2.

* On Push 2, holding a track’s selection button arms the track.
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Chapter 2

First Steps

2.1 Learn About Live

Live comes with a set of interactive lessons to take you step by step through the key features of
the program. The lessons are organized in a table of contents, which can be opened directly in
the program via the Help menu. We highly recommend following the lessons. Many users have
told us that the lessons helped them become familiar with the program very quickly.

We also recommend that you read the Live Concepts chapter (page 41), which encapsulates
everything that Live is and can do, and is therefore a worthwhile read for both beginners and
experienced users. The remaining chapters of this manual serve as in-depth reference for the
material infroduced in Live Concepts.

2.1.1  Using the Info View and Index

Live's Info View tells you the name and function of whatever you place the mouse over. For cer-
tain items, you can create your own text and it will appear in this window.
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The Info View and its Show,/Hide Button.

If you require more information on a specific user interface element or topic, please consult this
reference manual. The index, found at the end of the manual, contains the names of all user in-
terface elements and will lead you to the relevant section.

2.2  Setting up Preferences

Live's Preferences window is where you can find various settings that determine how Live looks,
behaves and interfaces with the outside world. This window is accessed from the Preferences
command, which in Windows is available in the Options menu and in OS X is available in the
Live menu. Preferences can also be accessed with the [CTRL][,](PC) / [CMD][,](Mac) shortcut.

Live's Preferences are distributed over several tabs:

* In the Look/Feel tab, you can modify various settings, including the language used for text
display and the color scheme, or “Theme,” for the Live user interface. This is also where
you can adijust the size of objects displayed on the screen: the Zoom Display slider allows
you to zoom Live's screen to any percentage between 50% and 200% of the standard
interface size.

* The Audio Preferences are used to set up Live's audio connections with the outside world
via an audio interface. Please take the time to follow the program’s built-in “Setting up Au-
dio I/O" lesson, which will walk you through all the steps required to set up and optimize
the settings for any given system. To access the lesson, use the Help View command from
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the Help menu.

* The Link/MIDI Preferences are used to help Live recognize external devices for three sepa-
rate and distinct purposes:

—Playing MIDI notes. To learn how to route an external device into Live for MIDI input,
or how to send MIDI to an external device, please see the Routing and I/O chapter
(page 214).

—Controlling parts of the interface remotely. This subject is covered in detail in the
MIDI and Key Remote Control chapter (page 573).

—Syncing the program with external devices, either via Ableton Link or via MIDI.
Please see the Link, Synchronization, and ReWire chapter (page 705) for details.

* The File/Folder Preferences pertain to Live's file management (page 59) and the loca-
tion of plug-in devices (page 270).

* The Library Preferences allow you to specify a default location for various types of in-
stalled files, including Packs and your User Library, as well as whether or not samples and
other files are self-contained when saving Sets (page 96).

* The Record/Warp/Launch Preferences allow customizing the default state for new Live
Sets (page 83) and their components (page 131), as well as selecting options for
new recordings (page 245).

* The Licenses/Maintenance Preferences are used to manage licensing and installation of
the Live platform (page 37).

2.3  The Main Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a number of
views, and each view manages a specific aspect of your Live Set, which is the type of document
that you create and work on in Live. If you have multiple monitors (or even one very large moni-
tor), you can open a second window to display all of Live's views at the same time.

Each one of the selector buttons at the screen borders calls up a specific view; clicking this one,
for instance, opens and closes Live's browser:
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The Browser Selector.

You can run Live in Full Screen Mode by selecting the Full Screen command from the View menu.
Full Screen Mode can also be toggled by pressing [F11](PC) / [CTRL][CMD][F](Mac). On Win-
dows and versions of OS X prior to 10.9, you can leave Full Screen mode by clicking a button
that appears in the lower right corner of the screen.

Turn Full Screen Off (Windows and OS X 10.8 or older).

When using OS X version 10.9 or higher, Live uses the operating system’s native full screen con-
trols. You can turn Full Screen Mode on by clicking the arrows in the top right corner.

Turn Full Screen On (OS X 10.9 or higher).

When in Full Screen Mode on OS X version 10.9 or higher, Live's menus will appear when mov-
ing your mouse pointer to the top of the screen. You can turn Full Screen Mode off by clicking the
arrows on the right side of the menu bar.

Enabling the Second Window option via [CTRL][Shiff][W](PC) / [CMD][Shiff][W](Mac) or in the
View menu opens a second window that will display an alternate collection of Live's views.

If Live's browser is open, you can adjust the main window’s horizontal split by dragging.
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Adjusting the Main Window Split.
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Chapter 3

Authorizing Live

Live is protected against illegal use by a copy protection scheme. This scheme has been de-
signed to meet the highest security standards while avoiding hassles for our customers. If you
find this procedure to be an inconvenience, please understand that the copy protection secures
your investment: It allows Ableton to provide you with support and to continue developing Live.

Please be aware that the standard Live license grants you the right to use Live on only one com-
puter at a time. You can, however, authorize Live more than once under the legal and technical
conditions described later (page 37).

The first time you run Live, you will be prompted to complete the authorization process. The soft-
ware will walk you through the steps.

If the computer that you wish to authorize is connected to the internet, you can authorize imme-
diately by pressing the appropriate button in the dialog box. If you do not have an internet con-
nection, press the “No internet on this computer” button and follow the instructions.

3.1  Copy Protection FAQs

3.1.1 Can | Use Live or Other Ableton Products Without a Seridl
Number?

If you do not (yet) own Live or its add-on products, you can still try them out, but saving and
exporting will be disabled.
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If trying Live or another product raises your interest in purchasing it, please visit the Ableton web-
shop?. This site contains information about Ableton’s distributor and dealer network. It also offers
you the opportunity to buy Ableton products online.

3.1.2  What if | Change My Computer’s Components?

If you change your computer components for some reason, Live may indeed ask you to autho-
rize the software another time. Live does not need to be reauthorized when computer peripher-
als are replaced (audio or MIDI hardware, printers, modems). But you may need to authorize
again if the motherboard, processor or network card is replaced. On some computers, reformat-
ting a hard drive will require a new authorization.

3.1.3 Can | Authorize Live More than Once?

The standard Live license allows you to use Live on only one computer at a time. However, the
Ableton server will provide you with two authorizations in good faith that you will use Live on
only one machine at a time.

You can therefore run Live on both a studio desktop computer and a tour laptop, but not at the
same time.

Should the Ableton server reject your demand for another authorization, please contact Able-
ton’s technical support®.

To use Live on more than one computer at a time, you may require a secondary license or a site
license. Ableton offers these licenses at special rates.

3.1.4  Can | Play my Set from a Computer That Is Not
Authorized?

Even if Live is not authorized, you can still load and perform a Live Set with no time limitation.
You cannot, however, save or export your work. When you go on tour, consider taking along
your Live USB installer and a backup of the last state of your Live Set(s). In case of an emergen-
cy, you can install and run Live on any computer available and play your backup Live Set(s).

2 http://www.ableton.com/shop
3 http://www.ableton.com/help
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3.1.5 What Do | Do About Problems or Questions Regarding
Copy Protection?

Please visit Ableton’s technical support page.
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Chapter 4

Live Concepts

This chapter introduces the essential concepts of Live. We advise you to read this chapter early
in your Live career, as a solid understanding of the program'’s basic principles will help you fully
exploit Live's potential for your music-making.

4.1 The Browser

Live's browser (page 59) is the place where you interact with your library of musical assets:
the core library of sounds that are installed with the program, any additional sounds you've
installed via Ableton Packs, presets and samples you've saved, your Ableton and third-party
devices, and any folders that you've added manually.

Live's Browser.
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4.2 Live Sets

The type of document that you create and work on in Live is called a Live Set (page 83). Live
Sets reside in a Live Project — a folder that collects related materials — and can be opened ei-
ther through the File menu’s Open command or via Live's browser.

A Llive Set in the Browser.

4.3  Arrangement and Session

The basic musical building blocks of Live are called clips. A clip is a piece of musical material: a
melody, a drum pattern, a bassline or a complete song. Live allows you to record and alter clips,
and to create larger musical structures from them: songs, scores, remixes, DJ sets or stage shows.

A Live Set consists of two environments that can hold clips: The Arrangement is a layout of clips
along a musical timeline; the Session is a real-time-oriented “launching base” for clips. Every
Session clip has its own play button that allows launching the clip at any time and in any order.
Each clip’s behavior upon launch can be precisely specified through a number of settings (page
201).

Clips in the Session View (left] and in the Arrangement View (Right).

The Arrangement is accessed via the Arrangement View (page 101) and the Session via the
Session View (page 119). If you're using Live in a single window, you can toggle between the
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two views using the computer’s [Tab] key or their respective selectors. If you're using two win-
dows, pressing [Tab] will swap the Session and Arrangement from one window to the other.

Because the two views have distinct applications, they each hold individual collections of clips.
However, it is important to understand that toggling or swapping the views simply changes the
appearance of the Live Set and does not switch modes, alter what you hear or change what is
stored.

The Arrangement and Session View Selectors.

The Arrangement View and the Session View interact in useful ways. One can, for instance, im-
provise with Session clips and record a log of the improvisation (page 126) into the Arrange-
ment for further refinement. This works because Arrangement and Session are connected via
tracks.

4.4 Tracks

Tracks host clips and also manage the flow of signals, as well as the creation of new clips
through recording, sound synthesis, effects processing and mixing.

A Track in the Arrangement View.

The Session and Arrangement share the same set of tracks. In the Session View, the tracks are
laid out in columns, while in the Arrangement View they are stacked vertically, with time moving
from left to right. A simple rule governs the cohabitation of clips in a track:
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A track can only play one clip at a time.

Therefore, one usually puts clips that should play alternatively in the same Session View column,
and spreads out clips that should play together across tracks in rows, or what we call scenes
(page 121).

A Scene in the Session View.

At any one time, a track can be playing either a Session clip or an Arrangement clip, but never
both. So, who wins2 When a Session clip is launched, the respective track stops whatever it is
doing to play that clip. In particular, if the track was playing an Arrangement clip, it will stop it in
favor of the Session clip — even as the other tracks continue to play what is in the Arrangement.
The track will not resume Arrangement playback until explicitly told to do so.

This is what the Back to Arrangement button is for, which is found in the Master Track in the Ses-
sion View and at the top-right of the scrub area in the Arrangement View. This button lights up
to indicate that one or more tracks are currently not playing the Arrangement, but are playing a
clip from the Session instead.
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The Back to Arrangement Button in the Session View.

The Back to Arrangement Button in the Arrangement View.

We can click this button to make all tracks go back to playing the Arrangement. Each track in the
Arrangement View also has its own Back to Arrangement button, allowing you to resume Ar-

rangement playback of only certain tracks.

A Single Track’s Back to Arrangement Button.

We can also capture the current state into the Arrangement by activating the Arrangement Re-
cord button. Disengaging Record Mode or stopping Live using the Stop button leaves us with an
altered Arrangement.
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4.5 Audio and MIDI

Clips represent recorded signals. Live deals with two types of signals: audio and MIDI. In the
digital world, an audio signal is a series of numbers that approximates a continuous signal as
generated by a microphone or delivered to a loudspeaker. A MIDI signal is a sequence of com-
mands, such as “now play a C4 at mezzo piano.” MIDI is a symbolic representation of musical
material, one that is closer to a written score than to an audio recording. MIDI signals are gen-
erated by input devices such as MIDI or USB keyboards*.

It takes an instrument (page 259) to convert MIDI signals into audio signals that can actually
be heard. Some instruments, such as Live's Simpler (page 514), are for chromatic playing of
one sound via the keyboard. Other instruments, such as Live's Impulse (page 463), have a dif-
ferent percussion sound assigned to each keyboard key.

Audio signals are recorded and played back using audio tracks, and MIDI signals are recorded
and played back using MIDI tracks. The two track types have their own corresponding clip
types. Audio clips cannot live on MIDI tracks and vice versa.

Information about inserting, reordering and deleting audio and MIDI tracks is found here (page
235).

4.6  Audio Clips and Samples

An audio clip contains a reference to a sample (also known as a “sound file” or “audio file") or
a compressed sample (such as an MP3 file). The clip tells Live where on the computer’s drives to
find the sample, what part of the sample to play and how to play it.

When a sample is dragged in from Live's built-in browser, Live automatically creates a clip to
play that sample. Prior to dragging in a sample, one can audition or preview it directly in the
browser; the switch in the browser with the headphone icon activates previewing.

4 For anintroduction to MIDI and digital audio, please see http://en.wikipedia.org/wiki/Midi and
http://en.wikipedia.org/wiki/Digital_audio.
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Samples Are Dragged in from Live’s Browser.

Live offers many options for playing samples in exciting new ways, allowing you to create an
abundance of new sounds without actually changing the original sample — all the changes are
computed in real time, while the sample is played. The respective settings are made in the Clip
View (page 131), which appears on screen when a clip is double-clicked.

An Audio Clip’s Properties as Displayed in the Clip View.

Many powerful manipulations arise from Live's warping capabilities (page 155). Warping
means changing the speed of sample playback independently from the pitch so as to match the
song tempo. The tempo can be adjusted on the fly in the Control Bar's Tempo field.

Tap § 200.00 [Hll| IIll 4 / 4 | O® ~ None ~

The Control Bar's Tempo Field.

The most elementary use of this technique, and one that usually requires no manual setup, is
synchronizing sample loops to the chosen tempo. Live's Auto-Warp algorithm actually makes it
easy to line up any sample with the song tempo, such as a recording of a drunken jazz band’s
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performance. It is also possible to radically change the sonic signature of a sound using extreme
warp settings.

4.7  MIDI Clips and MIDI Files

A MIDI clip contains musical material in the form of MIDI notes and controller envelopes. When
MIDI is imported from a MIDI file (page 81), the data gets incorporated into the Live Set,

and the original file is not referenced thereafter. In Live's browser, a MIDI file appears with a
special icon, and with the .mid file extension.

MIDI Files Are Dragged in from Live's Browsers.

As you'd expect, a MIDI clip’s contents can be accessed and edited (page 171) via the Clip
View, for instance to change a melody or “paint” a drum pattern.

A MIDI Clip’s Properties as Displayed in the Clip View.

4.8 Devices and the Mixer

A track can have not only clips but also a chain of devices (page 259) for processing signals.
Double-clicking a track’s title bar brings up the Device View, which shows the track’s device
chain.



Live Concepts | 49

The Device View Displaying a MIDI Track’s Device Chain.

Live's built-in audio effects (page 333), MIDI effects (page 423) and instruments (page
435) are available from the browser and can be added to tracks by dragging them from there
into the Device View, or info a Session or Arrangement track.

Live's Built-in Devices Are Available from the Browser.

You can also use plug-in devices (page 270) in Live. VST and Audio Units (Mac OS X only)
Plug-ins are available from the browser’s Plug-Ins label.
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Plug-In Devices Are Available from the Browser’s Plug-Ins Label.

Consider an audio clip playing in an audio track. The audio signal from the clip reaches the left-
most device in the chain. This device processes (changes) the signal and feeds the result into the
next device, and so on. The number of devices per track is theoretically unlimited. In practice, the
computer’s processor speed imposes a limit on the number of devices you can use at the same
time, a topic that deserves separate discussion (page 713). Note that the signal connections
between audio devices are always stereo, but the software’s inputs and outputs can be config-
ured to be mono in the Audio Preferences.

When the signal has passed through the device chain, it ends up in Live's mixer (page 231). As

the Session and Arrangement share the same set of tracks, they also share the mixer. The mixer

can be shown in both views for convenience. To optimize the screen layout, the individual mixer
sections can be shown or hidden using the View menu'’s entries.

The Live Mixer in the Arrangement View (Left) and Session View (Right).

The mixer has controls for volume, pan position and sends, which adjust the contribution each
track makes to the input of any return tracks. Return tracks only host effects, and not clips. Via
their sends, all tracks can feed a part of their signal into a return track and share its effects.
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The mixer also includes a crossfader (page 239), which can create smooth transitions between
clips playing on different tracks. Live's crossfader works like a typical DJ mixer crossfader, ex-
cept that it allows crossfading not only two but any number of tracks — including the returns.

Live's Crossfader.

Devices that receive and deliver audio signals are called audio effects. Audio effects are the
only type of device that fit in an audio track or a return track. However, two more types of de-
vices are available for use in MIDI tracks: MIDI effects and instruments.

Consider a MIDI track playing a clip. The MIDI signal from the clip is fed into the track’s device
chain. There, it is first processed by any number of MIDI effects. A MIDI effect receives and
delivers MIDI signals. One example is the Scale effect, which maps the incoming notes onto a
user-defined musical scale. The last MIDI effect in the chain is followed by an instrument. Instru-
ments, for instance Live's Simpler and Impulse, receive MIDI and deliver audio. Following the
instrument, there can be any number of audio effects — as in an audio track.

A MIDI Effect an Instrument and an Audio Effect in a MIDI Track.

If a MIDI track has no instrument (and no audio effects), then the track’s output is a plain MIDI
signal, which has to be sent somewhere else to be converted into audio. In this case, the track’s
mix and Send controls disappear from the mixer.
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The Mixer for a MIDI Track without an Instrument.

4.9  Presets and Racks

Every Live device can store and retrieve particular sets of parameter values as presets (page
264). As presets are stored independently from Live Sets, new presets become part of your
user library that any project can draw from.

Live's Instrument, Drum and Effect Racks (page 281) allow saving combinations of devices

and their settings as a single preset. This feature allows for the creation of powerful multi-device
creations and effectively adds all the capabilities of Live's MIDI and audio effects to the built-in
instruments.

4.10 Routing

As we have seen, all tracks deliver signals, either audio or MIDI. Where do these signals go?
This is set up in the mixer’s In/Out section, which offers, for every track, choosers to select a
signal source and destination. The In/Out section, accessible through the View menu's In/Out
option, is Live's “patchbay.” Its routing options (page 211) enable valuable creative and tech-
nical methods such as resampling, submixing, layering of synths, complex effects setups and

more.
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Track Routing Is Set up Using the In/Qut Section in the Arrangement (Left) or Session View (Right).

Signals from the tracks can be sent to the outside world via the computer’s audio and MIDI inter-
faces, to other programs that are connected to Live via ReWire (page 710) or to other tracks

or devices within Live. Tracks can also be combined into a Group Track (page 236) which
serves as a submixer for the selected tracks.

Likewise, a track can be set up to receive an input signal to be played through the track’s de-
vices. Again, tracks can receive their input from the outside, from a ReWire program or from

another track or device in Live. The Monitor controls regulate the conditions under which the
input signal is heard through the track.

It is also possible to route signals to external hardware devices from within a track’s device
chain, by using the External Audio Effect (page 369) and External Instrument (page 461)
devices. (Note: these devices are not available in the Lite or Intro Editions.)

4.11 Recording New Clips

Audio tracks and MIDI tracks can record their input signal and thereby create new clips (page
245). Recording is enabled on a track by pressing its Arm button. With multiple tracks se-
lected, pressing any of their Arm buttons will arm all of them. You can also hold down the [CTRL]
(PC) / [CMD](Mac) modifier when clicking the Arm buttons to arm several tracks at once. If the
Exclusive Arm option is enabled in the Record Preferences, inserting an instrument into a new or
empty MIDI track will automatically arm the track. When the Control Bar’s Arrangement Record
button is on, every armed track records its input signal into the Arrangement. Every take yields a
new clip per track.
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Track Arm Buttons, as They Appear in the Session View.

It is also possible to record into Session View slots on the fly (page 248). This technique is

very useful for the jamming musician, as Session recording does not require stopping the music.
Clicking the Session Record button records a new clip in the selected Session scene in all armed
tracks.

1.1.1. pHO® + &£ @

The Control Bar's Session Record Button.

Clicking the Session Record button again defines the end of the recording and launches the new
clips. As these actions are subject to real-time launch quantization, the resulting clips can be
automatically cut to the beat.

Tap | 120.00 lII|III} 4 / 4 | C@® .

The Control Bar's Quantization Chooser.

Session recording in conjunction with overdubbing and Record Quantization is the method of
choice for creating drum patterns, which are built up by successively adding notes to the pattern
while it plays in a loop. It only takes a MIDI keyboard (or the computer keyboard) and a MIDI
track with Live's Impulse percussion instrument to do this (page 463).

4.12 Avutomation Envelopes

Often, when working with Live's mixer and effects, you will want the controls’ movements to
become part of the Set. The movement of a control across the Arrangement timeline or Session
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clip is called automation (page 301); a control whose value changes over time is automated.
Automation is represented by breakpoint envelopes, which can be drawn, edited and recorded

in real-time.

The Automated Pan Control and its Envelope.

Practically all mixer and effect controls in Live can be automated, even the song tempo. Record-
ing automation is straightforward: all changes of a control that occur while the Control Bar’s
Automation Arm and Arrangement Record buttons are on become automation in the Arrange-
ment View. Automation is recorded to Session View clips if controls are adjusted while recording
with the Automation Arm button enabled.

Changing an automated control’s value while not recording is similar to launching a Session clip
while the Arrangement is playing: It deactivates the control’s automation (in favor of the new
control setting). The control will stop tracking its automation and rest with the new value until the
Re-Enable Automation button is pressed or a Session clip that contains automation is launched.

4.13 Clip Envelopes

Envelopes can be found in both tracks and clips. Clip envelopes (page 313) are used to au-
tomate or modulate device and mixer controls. Audio clips have, in addition, clip envelopes to
influence the clip’s pitch, volume and more; these can be used to change the melody and rhythm
of recorded audio. MIDI clips have additional clip envelopes to represent MIDI controller data.
Clip envelopes can be unlinked from the clip to give them independent loop settings, so that
larger movements (like fade-outs) or smaller gestures (like an arpeggio) can be superimposed
onto the clip’s material.
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An Envelope for Clip Transposition.

4.14 MIDI and Key Remote

To liberate the musician from the mouse, most of Live’s controls can be “remote-controlled”
via an external MIDI controller. Remote mappings are established in MIDI Map Mode (page
578), which is engaged by pressing the MIDI switch in the Control Bar.

In this mode, you can click on any mixer or effect control, and then assign it to a controller sim-
ply by sending the desired MIDI message (for example, by turning a knob on your MIDI control
box). Your assignments take effect immediately after you leave MIDI Map Mode. Session clips
can be mapped to a MIDI key or even a keyboard range for chromatic playing.

MIDI keys and controllers that have been mapped to Live's controls are not available for record-

ing via MIDI tracks. These messages are filtered out before the incoming MIDI is passed on to

the MIDI tracks.

# Mkey - mpl] 0% D

The Key,/MIDI Map Controls.

Session clips, switches, buttons and radio buttons can be mapped to computer keyboard keys as
well. This happens in Key Map Mode (page 583), which works just like MIDI Map Mode.

Live offers, in addition to this general purpose mapping technique, dedicated support for Able-
ton Push (page 585) and Push 2.
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4.15 Saving and Exporting

Saving a Live Set saves everything it contains, including all clips, their positions and settings,
and settings for devices and controls. An audio clip can, however, lose the reference to its cor-
responding sample if it is moved or deleted from disk. The links between samples and their clips
can be preserved with a special command, Collect and Save (page 95), which makes a

copy of each sample and stores it in a project folder along with the Live Set.

A separate Save button in the Clip View saves a set of default clip settings (page 145) along
with the sample, so that each time the sample is dragged into the program, it will automatically
appear with these settings. This is especially useful if you have made warp settings for a clip and
want to use it in multiple Live Sets.

Exporting audio from Live can be done from both the Session and Arrangement Views. By de-
fault, Live will export the audio coming through on the Master output as an audio file of your
specifications via Export Audio/Video (page 74).

Live can also export individual MIDI clips as MIDI files (page 82).
Exporting and saving material for later use in Live can be done very conveniently with the Live

Clip format (page 82). Session View clips can be dragged back out of a Live Set to the
browser, and thereby exported to the disk as Live Clips.

A Live Clip in the Browser.

Live Clips are a very powerful way of storing ideas, as they save not only the clip’s Clip View
settings, but also the corresponding track’s instruments and effects chain. Live Clips in the brows-
er can be previewed and added to any open Live Set just like sample files. In the Live Set, they
restore the original clip’s creative options.

Using Live Clips, you can build your own personalized library of:
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* MIDI sequences with matching instruments and effects, e.g., a MIDI drum pattern with the
associated Impulse and effects settings;

* Different regions or loops (page 138) referencing the same source file;

* Variations of a sample loop created by applying Warp Markers (page 155), clip enve-
lopes (page 313) and effects (page 259);

¢ |deas that may not fit your current project but could be useful in the future.
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Chapter 5

Managing Files and Sets

Various types of files are used in making music with Live, from those containing MIDI (page
81) and audio (page 72), to more program-specific files such as Live Clips (page 82)

and Live Sets (page 83). This chapter will explain everything you need to know about work-
ing with each of these file types in Live. However, we should first take a look at Live's browser,
through which most files arrive in the program.

5.1  Working with the Browser

Live's browser is the place where you interact with your library of musical assets: the core library
of sounds that are installed with the program, any additional sounds you've installed via Ableton
Packs, presets and samples you've saved, your Ableton and third-party devices, and any folder
on your hard drive that contains samples, tracks, etc.
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The Browser.

The browser display is divided into left and right sections, called the sidebar and the content
pane respectively. To resize the sections, drag the divider line horizontally.

5.1.1  Understanding the Browser’s Hierarchy

Working in the browser involves choosing one of the labels from the Collections, Categories or
Places sections in the sidebar, and then selecting from the items that appear in the content pane.

Collections

The Collections labels each have their own assignable color, which you can use to tag items
(including folders) that appear in the browser’s content pane. These labels (or “tags”) enable
you to quickly organize and access particular browser items (for example, your favorite or most-
used items).
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You can assign Collections labels via a selected item'’s [right-click](PC) / [CTRL-click](Mac) con-
text menu, or by using the number key shortcuts [1] through to [7]. Use [O] to reset color assign-
ments.

Note that Collections labels can also be assigned to multiple browser items within a selection.
Additionally, it is possible to assign a color label to different item “types”. For example, you can
assign the same color label to a drum sound, a MIDI effect, and a plug-in.

Clicking on a Collections label in the sidebar shows all items tagged with that color. Folders that
appear in the Collections labels can be unfolded to show their contents.

The Edit Button in the Browser.

Each label can be renamed via their [right-click](PC) / [CTRL-click](Mac) context menu, or by
pressing [CTRL][R](PC) / [CMD][R](Mac). You can choose which labels are visible in the brows-
er, by clicking the Edit button next to the Collections header, and checking the Show/Hide Label
option next to each label.

Editing Shown and Hidden Collections in the Browser.
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To exit Edit Mode, press the “Done” button.

Favorites A
Orange

Yellow i
Green

Blue

Purple

Gray

The Done Button in the Browser.

Note that when a hidden unassigned color becomes assigned to a browser item, the Collections
label for that color will be shown in the sidebar automatically. However, visible color labels are
not automatically hidden if all their assignments are removed.

Browser Items and Their Assigned Colors in the Content Pane.

In the content pane, square icons indicate the respective color(s) assigned to each item. Note
that although multiple colors can be assigned to an item, no more than three of those colors will
be shown in the content pane.

Categories

The Categories labels show all items of a given type, regardless of where they are in your
library. Use this section to explore and discover all of the instruments and sounds you have in-
stalled. The Categories section is organized as follows:
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* Sounds — all of your Instrument Racks (page 281) and instrument presets, organized by
the type of sound they make (rather than by their devices.)

* Drums — all of your drum presets. This includes full drum kits, which are available as Drum
Racks, as well as single drum hits, which are delivered as Instrument Racks.

¢ Instruments — all of your Instrument Racks, as well as “raw” Live instruments and their pre-
sets, organized by device (rather than by the type of sound.)

* Audio Effects — all of your Audio Effect Racks, as well as “raw” Live audio effects devices
and presets.

* MIDI Effects — all of your MIDI Effect Racks, as well as “raw” Live MIDI effects devices
and presets.

* Max for Live — all of your Max for Live (page 553) devices and presets, as well as any
Racks that are built with those devices, organized into Audio Effect, Instrument and MIDI
Effect folders.

* Plug-Ins — your third-party VST and/or Audio Units plug-ins (page 270).
* Clips — all of your Live Clips.
¢ Samples — all of your raw audio samples.

¢ All results — this section appears after you've typed something into the search field. It
shows search results for every section of the browser in a single list.

Places

The Places labels show the contents of folders on your hard drives. Use this section when you
want to access a particular place, such as a folder you've added or an add-on Pack. The actual
contents of the Places section will vary depending on how you've configured your library, but
will contain at least the following:

* Packs — all Packs that come pre-installed with Live, as well as any that you've installed
yourself. Each Pack appears as a folder in the content pane, which can be unfolded to
reveal that Pack’s contents. Presets, samples, and Live Clips installed by Packs will also ap-
pear in the appropriate Categories labels. The Packs label also shows updates for installed
Packs, as well as additional Packs that you can install. Please refer to Downloading and
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Installing Packs in the Browser (page 64) for more information.

* User Library — the User Library is the default location for items you save yourself, including
default presets, grooves, your personalized Racks and device presets, your own samples,
Live Clips, etc. Files that you save to your User Library will also be available in the appro-
priate Categories labels.

* Current Project — all of the files that are contained in the currently active Project (page
88). If you're working on a Live Set that you haven't yet saved, the current Project refers
to a temporary location.

* any folders from any of your hard drives that you've added to Live's Browser.

Moving through the files in Live’s browser can be done with either the mouse or the computer
keyboard:

* Scroll up and down in the Browser with the up and down arrow keys, the mousewheel, or

by clicking and dragging while holding the [CTRL][ALT](PC) / [CMD][ALT](Mac) modifier.

* Close and open folders, or move between the sidebar and content pane with the left and
right arrow keys.

By default, any previously open folders will close when you open a new one, but you can over-

ride this behavior by holding [CTRL](PC) / [CMD](Mac) while opening new folders.

5.1.2  Downloading and Installing Packs in the Browser

The Packs label in the browser shows you all Packs that come pre-installed with Live, as well as
any that you've installed yourself.

To check for existing updates for your installed Packs, navigate to the Packs label and expand
the Updates section.
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Available Updates for Installed Packs Appear in the Browser.

You can also view Packs that you own, but have not installed. These uninstalled Packs appear in
the Available Packs section within the Packs label.

Downloadable Packs Appear in the Browser.

You can download any of these Updates or Available Packs by pressing the download icon next
to it.

Press the Download Icon to Download a Pack.

While the Pack is downloading, the download icon changes to a pause icon that indicates the

progress of the Pack’s download.
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Press the Pause Icon to Pause a Pack Download. The Download Progress Is Indicated in Yellow.

Should you need to, you can pause downloads and resume them at a later point. To pause a
download, press the pause icon. When a download is paused, the paused icon changes back
to a download icon.

To resume a paused download, press the download icon again.

(Note: you can download multiple selected Packs at the same time. You can also pause and
resume downloading multiple selected Packs.)

When the download is complete, you can install the Pack by pressing the Install button.

Press the Install Button to Install a Pack.

Upon pressing the Install button, Live will display a progress bar that indicates the status of the
process.

Note that you can download a Pack, pause, resume or cancel a download, or install a Pack by
choosing the appropriate command in that Pack’s [right-click](PC) / [CTRL-click](Mac) context
menu.

Sometimes you might need to know the size of a Pack before you download and install it. For ex-
ample, you may have limited space on your hard drive. You can configure the browser to show
the size of all Packs that appear in the Updates and Available Packs sections. To do this, [right-
click](PC) / [CTRL-click](Mac) on the Name header in the browser’s content pane and choose
the Size option in the context menu.
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Show or Hide the Size of Packs in the Browser.

You can delete an installed Pack via its [right-click](PC) / [CTRL-click](Mac) context menu. Note
that deleted Packs will appear in your list of Available Packs.

It is possible to configure Live's Preferences to show or hide Updates and Available Packs in the
browser. To do this, press the Show Downloadable Packs toggle in the Library Preferences.

Show or Hide Downloadable Packs in the Browser.

5.1.3 User Folders

Live's browser allows you to work with your creative tools regardless of where they are installed
on your computer. This allows you to, for example, store large sample collections on one or
more external drives, and still use the browser to access their contents - there is no need to keep
them in a single centralized location.

In order to work with your own folders in Live, you must first add them to the browser, either by
dropping them directly into Live from the Explorer (Windows)/Finder (Mac) or by pressing the
Add Folder button in the browser’s sidebar.

After adding a user folder, Live will scan it, which “teaches” the browser about its contents. Fol-
lowing this, it will appear in the Places section of the sidebar.
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Note: adding a user folder does not actually move the folder to a new location, but simply
makes it available in Live's browser. If you reorganize your drives using Explorer (Windows)/
Finder (Mac), Live may not be able to find user folders if they've been moved. For example, if

a user folder is contained on an external hard drive, and Live is opened without the drive at-
tached, the user folder will still appear in the browser but will be grayed out. You can attempt to
find it by using the [right-click](PC) / [CTRL-click](Mac) context menu’s Locate Folder command,
or tell Live to “forget” this folder via the Remove from Sidebar command. You can also use this
command to remove folders that aren’t missing, but which you simply don’t want to work with

anymore.

5.1.4  Searching for Files

Live's browser is equipped with a search field that filters the contents of the selected sidebar la-
bel as you type. To search across all locations, press [CTRL][F](PC) / [CMD][F](Mac).

The Browser’s Search Field.

The results will include files that match all search terms, as opposed to any. For example, if
you search for “acoustic bass,” the search will yield all acoustic bass sounds — not all acoustic
sounds and all bass sounds.

For mouse-free searching, we suggest the following sequence of shortcuts:
1. [CTRL][F](PC) / [CMDI][F](Mac]) to place a cursor in the search field;
2. Type your search terms;
3. Down arrow key to jump to the search results;
4. Up and down arrow keys to scroll the search results;

5. [ESC] to clear the search field, showing all of the contents of the selected sidebar label.
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Previewing Files

Live allows you to preview samples, clips, and instrument presets in the browser before they are
imported into the program. To enable previewing, activate the Preview switch next to the Preview
Tab at the bottom of the browser.

The Preview Switch.

Hint: You can preview files even when the Preview switch is not activated by pressing [Shift][En-
ter] or the right arrow key.

Click on afile (or use the up and down arrow keys) to select it. Click in the Tab’s scrub area
to make playback jump to that point. (Note that it is not possible to scrub clips that have been
saved with Warp turned off.)

You can select Live Clips in the browser to load them into the Preview Tab.

You can also preview Live's instrument presets in the Preview Tab. When selected, you'll hear a
short audio example of the preset, so you can get an idea of how it sounds before loading it.

With the Raw button enabled, files will preview at their original tempo and will not loop. With
Raw disabled, Live will try to preview files in sync with the current Set, so that you can better
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judge which samples will work for you. Please note that scrubbing is not possible when Raw is
enabled.

The previewing volume can be adjusted using the mixer’s Preview Volume knob.

The Preview Volume Knob.

If your audio hardware offers multiple audio outs, you can privately audition, or cue, files via
headphones connected to a separate pair of outs — while the music continues to play. To learn
how to set up Live for cueing, please refer to the relevant section (page 242) of the Mixing
chapter.

Adding Clips from the Browser

There are several ways to add clips to a Live Set:

* Files can be dragged and dropped from the browser into tracks in the Session or Arrange-
ment View. Dragging and dropping material from the browser into the space to the right of
Session View tracks or below Arrangement View tracks will create a new track and place

the new clip(s) there.

Dropping a Clip to Create a New Track.
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* In the Session View, double-clicking or pressing [Enter] on a file in the browser will auto-
matically create a new track to the right of the other tracks and load it with the clip.

* Files can be dropped directly into Live from the Explorer (Windows)/Finder (Mac).

Hot-Swap Mode

In addition to the drag-and-drop method of loading files from the browser, Live offers a Hot-
Swap Mode to reduce your mouse travel. Hot-Swap Mode can be toggled on and off with

the [Q] key, and establishes a temporary link between the browser and, for example, a virtual
instrument. While in Hot-Swap Mode, you can step through samples or presets to audition them
“in place,” that is, within the instrument. Hot-swapping for presets is covered in the Live Device
Presets section (page 264). Let's go through an example of hot-swapping samples:

Live's built-in Impulse instrument features eight sample-player slots that can be filled by dropping
samples into them. Alternatively, we can click the Hot-Swap button that appears as we move the

Clicking the Hot-Swap button or pressing the [Q] key engages Hot-Swap Mode:

mouse over a slot.

Impulse

The Hot-Swap Button in an Impulse Slot.

The Browser in Hot-Swap Mode.
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While in Hot-Swap Mode, pressing the up or down arrow key moves to the next file in the con-
tent pane, and pressing [Enter] or double-clicking the file loads it into the Impulse slot (presum-
ably while Impulse is playing incoming MIDI notes). The link between the browser and the in-
strument will be broken if a different view is selected, or if the [Q] key or the Hot-Swap button is
pressed again. Hot-swapping can also be cancelled with a press of the [ESC] key or by pressing
the close button in the Hot-Swap bar at the top of the browser.

When Hot-Swap Mode is re-entered, the browser will show the location of the currently loaded
sound and pre-select it.

5.2  Sample Files

A sample is a file that contains audio data. Live can play both uncompressed file formats (WAV,
AIF and Sound Designer Il for Mac) and compressed file formats (MP3, AAC, Ogg Vorbis, Ogg
FLAC and FLAC). (Please note that not all of these file formats can be played in the Lite Edition.)

A note on using Variable Bit Rate (VBR) files: Please install QuickTime for decoding purposes if
you do not already have it on your system. It can be downloaded from the Apple website®.

As Live plays the samples directly from disk, you can work with a large number of (large)
samples without running into RAM memory limitations. Please note, however, that you may run
into disk throughput problems if your disk is nearly full, and/or (on Windows systems) highly
fragmented. Hard drive rotation speed can also affect disk performance. Refer to the section on
managing the disk load (page 717) for more information.

Live can combine uncompressed mono or stereo samples of any length, sample rate or bit depth
without prior conversion. To play a compressed sample, Live decodes the sample and writes the
result to a temporary, uncompressed sample file. This usually happens quickly enough that you
will be able to play the sample right away, without waiting for the decoding process to finish.

Note: When adding a long sample to a project, Live might tell you that it cannot play the sample
before it has been analyzed. Please see the section on analysis (page 73) for an explana-
tion.

5 http://www.apple.com/quicktime/download
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5.2.1 The Decoding Cache

To save computational resources, Live keeps the decoded sample files of compressed samples
in the cache. Maintenance of the cache is normally not required, as Live automatically deletes
older files to make room for those that are new. You can, however, impose limits on the cache
size using the File/Folder Preferences’ Decoding Cache section. The cache will not grow larger
than the Maximum Cache Size setting, and it will always leave the Minimum Free Space on the
hard disk. Pressing the nearby Cleanup button will delete all files not being used by the current
Live Set.

Preferences for the Decoding Cache.

5.2.2  Analysis Files (.asd)

An analysis file is a little file that Live creates when a sample file is brought into the program
for the first time. The analysis file contains data gathered by Live to help optimize the stretching
quality, speed up the waveform display and automatically detect the tempo of long samples
(page 161).

When adding a long sample to a project, Live might tell you that it cannot play the sample be-
fore it has been analyzed. This will not happen if the sample has already been analyzed (i.e.,
Live finds an analysis file for this sample), or if the Record/Warp/Launch Preferences’ Auto-
Warp Long Samples preference (page 155) has been deactivated.

An analysis file can also store default clip settings for the sample:
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Clicking the Clip View's Save button (page 145) will store the current clip’s settings with the
sample’s analysis file. The next time the sample is dragged into Live, it will appear with all its clip
settings intact. This is particularly useful for retaining Warp Marker settings with the sample. Stor-
ing default clip settings with the analysis file is different from saving the clip as a Live Clip.

While analysis files are a handy way to store default information about a particular sample’s
settings, keep in mind that you can use different settings for each clip within a Live Set — even if
those clips refer to the same sample on disk. But if you drag a new version of the sample into a
Live Set, Live will use the settings stored in the analysis file for the newly created clip.

The analysis file’s name is the same as that of the associated sample, with an added “.asd” ex-
tension. Live puts this analysis file in the same folder as the sample.

Samples that have an .asd file are displayed like this in the browser.
Samples without an .asd file look like this.
The analysis files themselves do not appear in Live's browser.

Note that you can suppress the creation of .asd files by turning off the Create Analysis Files op-
tion in the File/Folder Preferences. All data (except for the default clip settings) can be recreated
by Live if the .asd file is missing, however this will take some time for longer samples.

5.2.3  Exporting Audio and Video

The File menu’s Export Audio/Video command allows you to export Live's audio output as new
samples. The resulting files can be used to burn an audio CD for listening purposes or a data
CD, which could serve as a backup of your work or be used with other digital audio applica-
tions. If your set includes video, you can also use the Export Audio/Video command to export
this to a new video file, which will be created in the same directory as the rendered audio files.
(Note: video export is not available in the Lite and Intro Editions.) You can also upload your ex-
ported audio files directly to your SoundCloud account.
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Selection Options

The Render Dialog'’s Selection Options.

The Export dialog’s Rendered Track chooser offers several options for which audio signal to
render:

The Rendered Track Chooser.

* Master — the post-fader signal at Live's Master output. If you are monitoring the Master
output, you can be sure that the rendered file will contain exactly what you hear.

* All Individual Tracks — the post-fader signal at the output of each individual track, includ-
ing return tracks and MIDI tracks with instruments. Live will create a separate sample for
each track. All samples will have the same length, making it easy to align them in other
multitrack programs.

* Selected Tracks Only — this is identical to the All Individual Tracks option, but only renders
tracks that were selected prior to opening the Export dialog.
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* (single tracks) — the post-fader signal at the output of the selected track.
The other Selection fields determine the start time and length of the exported material:

* Render Start — sets the position at which rendering will begin.

* Render Length — determines the length of the rendered sample.
Tip — a fast way to set both the Render Start and Length values is to select a range of time in
the Arrangement View prior to invoking the Export Audio/Video command. But remember — a
rendered audio file contains only what you heard prior to rendering. So, for example, if you're

playing back some combination of Session View clips and Arrangement material, then that is
what will be captured in your rendered file — regardless of which view is active when you ren-

der.

Rendering Options

Audio Rendering Options.
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The Export dialog offers several audio rendering options:

* Render as Loop — If this is activated, Live will create a sample that can be used as a loop.
For example, suppose your Live Set uses a delay effect. If Render as Loop is on, Live will
go through the rendering process twice: The first pass will not actually write samples to
disk, but add the specified delay effect. As the second pass starts writing audio to disk, it
will include the delay “tail” resulting from the first pass.

Convert to Mono — If this is activated, Live will create a mono file instead of a stereo file.

Normalize — If this is activated, the sample resulting from the render process will be nor-
malized (i.e., the file will be amplified so that the highest peak attains the maximum avail-
able headroom).

Create Analysis File — If this is activated, Live will create an .asd file that contains analysis
information about the rendered sample. If you intend to use the new sample in Live, check
this option.

Sample Rate — Note that your choice of sample rate works as follows: if you select a
sample rate equal to or higher than the rate you're using in your project (as set in the Audio
tab of Live's Preferences), Live will export in a single step, at the sample rate you've chosen
in the Export dialog. If you export at a sample rate that is lower than your current project
sample rate, Live will first export at the current project sample rate and then downsample
the file in a second step using a high-quality process. Note that this may take a few mo-
ments.

* Upload Audio to SoundCloud — If activated, a helper application will launch that will al-
low you to upload your exported audio file to SoundCloud.
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Encoding Options

Audio Encoding Options.

* Encode PCM — If activated, a lossless audio file is created.
* File Type — WAV, AIFF, and FLAC formats are available for PCM export.

* Bit Depth, Dither Options — If you are rendering at a bit depth lower than 32-bit, choose
one of the dither modes. Dithering adds a small amount of noise to rendered audio, but
minimizes artifacts when reducing the bit depth. By default, Triangular is selected, which
is the “safest” mode to use if there is any possibility of doing additional processing on
your file. Rectangular mode introduces an even smaller amount of dither noise, but at the
expense of additional quantization error. The three Pow-r modes offer successively higher
amounts of dithering, but with the noise pushed above the audible range. Note that dither-
ing is a procedure that should only be applied once to any given audio file. If you plan to
do further processing on your rendered file, it's best to render to 32-bit to avoid the need
for dithering at this stage. In particular, the Pow-r modes should never be used for any
material that will be sent on to a further mastering stage — these are for final output only.
(Please note that the Pow-r modes are not available in the Intro and Lite Editions.)

* Encode MP3 — If activated, a CBR 320 kbps MP3 file is created. It is possible to export
PCM and MP3 simultaneously. If neither toggle is enabled, the Export button will be dis-
abled.
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Video Rendering Options

Video Rendering Options.

(Note: video rendering is not available in the Intro and Lite Editions.)

In addition to settings for audio rendering, the Export dialog provides additional options for
rendering video:

* Create Video — If this is activated, a video file will be created in the same directory as
your rendered audio. Note that this option is only enabled if you have video clips in the
Arrangement View. Also, it is not possible to only render a video file — enabling video
rendering will always produce a video in addition to rendered audio.

* Video Encoder — This chooser allows you to select the encoder to use for the video ren-
dering. The choices you have here depend on the encoders you have installed.

* Video Encoder Settings — This button opens the settings window for the selected encoder.
Note that the settings options will vary depending on the encoder you have chosen. Cer-
tain encoders have no user-configurable options. In this case, the Edit button will be dis-

abled.

Once you've made your selections and clicked Export to begin the rendering process, audio
rendering will begin. After the audio rendering is complete, the video will be rendered. Note
that, depending on the encoder used, video rendering may occur in more than one pass. Live
will display a progress bar that will indicate the status of the process.

Unless you've specified a special window size or aspect ratio in the encoder settings, the ren-
dered video file will play back exactly as it appeared during real time playback in Live. The
video file will also contain the rendered audio.
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For more information about working with video in Live, see the chapter on video (page 325).

Real-Time Rendering

Normally, rendering happens as an offline process. But if your set contains an External Audio
Effect (page 369) or External Instrument (page 461) that routes to a hardware effects device

or synthesizer, the rendering process is a bit different. In this case, rendering the master output
happens in real time. If you render single tracks, all tracks that don’t route to an external device
anywhere in their signal paths will be rendered offline. Then, any tracks that do access these
devices will be rendered in real time. Live will automatically trace each track’s signal flow and
detect if real-time rendering is necessary. You'll then be presented with several options when you

start to render:

Waiting for External Devices to Become Silent.

* Skip — By default, Live will wait for ten seconds before starting a real-time render. This
should allow any sound from external devices to fade out, but if you need more time (for
example, if you're waiting for a long reverb tail), you can increase the wait time by typing
a new number in the number box. On the other hand, if you're sure that your external de-
vices aren’t making any sound, you can speed the process along by pressing “Skip,” which
will start the render immediately.

After the render has begun, the dialog changes to show a recording progress bar:

Real-Time Rendering in Progress.
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* Auto-Restart on drop-outs — Rendering in real-time requires somewhat more CPU power
than non-real-time rendering, and in some cases drop-outs (small gaps or glitches in the
audio) can occur. Live detects when drop-outs happen, and rendering will start again from
the beginning if the Auto-Restart option is enabled.

* Restart — manually restarts the rendering process.
* Cancel — stops the rendering process and deletes the partially rendered file.

The number of rendering attempts (if there has been more than one) will also be listed in the dia-
log box. If you find that dropouts and restarts keep happening, you should close other running
applications to allow more processing power for rendering. Please see the chapter on computer
audio resources (page 713) for more tips on improving performance.

5.3  MIDI Files

A MIDI file contains commands that prompt MIDI compatible synthesizers or instruments, such
as Live's Simpler, to create specific musical output. MIDI files are exported by hardware and
software MIDI sequencers. Importing MIDI files into Live works differently than with samples:
MIDI file data is incorporated into the Live Set, and the resulting MIDI clips lose all reference to
the original file. MIDI files appear with a special icon in the browser.

A MIDI File in the Browser.

You can import MIDI files by using the browser or the Create menu’s Import MIDI File... com-
mand. Note that when using the Import MIDI File... command in the Arrangement View, the file
will be inserted at the Insert Marker position. When using the command in the Session View, the
file will be inserted in the currently selected clip slot.
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5.3.1  Exporting MIDI Files

Live MIDI clips can be exported as Standard MIDI files. To export a MIDI clip, use the File
menu’s Export MIDI Clip command. This command will open a file-save dialog, allowing you to
choose the location for your new MIDI file.

Exporting a MIDI file is different from saving the clip as a Live Clip.

5.4 Live Clips

Individual audio or MIDI clips can be exported to disk in the Live Clip format for easy retrieval
and reuse in any project. Audio clips only contain references to samples on disk (rather than the
audio data itself), so they are very small, which makes it easy to develop and maintain your own
collection.

To save a clip from the open Live Set to disk, simply drag it to the Places section of the browser
and drop it into the Current Project or any user folder. For audio clips, Live will manage the
copying of the clip’s sample into this new location based on the selection in the Collect Files on
Export chooser (page 96). You can then type in a new name for the clip or confirm the one
suggested by Live with [Enter].

A Llive Clip in the Browser.

Live Clips are a great way of storing your ideas for later use or development, as they save not
only the original clip, including all its clip and envelope settings, but also the original track’s de-
vices. In order to recreate a Live Clip's device chain, either drag it into a track containing no clips
or devices, or drag it into the space in the Session or Arrangement View containing no tracks.
Note that Live Clips that are imported into tracks already containing devices or clips will appear
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with their clip settings but not their devices. You could, for instance, drop a bassline Live Clip on
an existing track that drives a bass instrument, rather than creating a new track.

Clips belonging to any Live Sets already on disk are also Live Clips. Please see the section on
merging Sets (page 84) for more on this topic.

Note that storing default clip settings with a sample’s analysis file is different from saving a Live
Clip. The default clip in the .asd file annotates the sample with sensible default values (warp,
gain and pitch settings) so that it will play in a defined way when it is added to a Set. Live Clips,
on the other hand, are stored on disk as separate musical ideas. For example, you could create
a number of variations from the same audio clip by using different warp, pitch, envelope and
effect settings, and store them all as separate Live Clips. In the browser, you could then inde-
pendently sort and preview these clips, even though they are all referring to the same source
sample.

55 Live Sets

The type of document that you create and work on in Live is called a Live Set. Think of this as a
single “song.” Sets must be saved inside projects, so that Live can keep track of and manage all
of the various components of the Live Set: Live Clips, device presets, any samples used, etc.

5.5.1  Creating, Opening and Saving Sets

Use the File menu’s New Live Set command to create new Live Sets, and the Open Live Set or
Open Recent Set command to open existing ones. In the browser, you can double-click or press
[Enter] on a Live Set to open it.

The File menu’s Save Live Set command saves the current Live Set exactly as it is, including all
clips and settings.

You can use the Save Live Set As command to save the current Live Set under a different name
and/or in a different directory location, or the Save a Copy command to create a copy of the
current Live Set with a new name and/or new directory location.
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5.5.2  Merging Sets

Live makes it easy to merge Sets, which can come in handy when combining work from differ-
ent versions or pieces. To add all tracks (except the return tracks) from one Live Set into another,
drag the Set from the browser into the current Set, and drop it onto any track title bar or into

the drop area next to or below the tracks. The tracks from the dropped Set will be completely
reconstructed, including their clips in the Session and Arrangement View, their devices, and their
automation.

Session View Drop Area for Importing Live Sets.

Arrangement View Drop Area for Importing Live Sefs.

If you prefer to import individual tracks from a Set, you can unfold the Live Set in the browser just
as if it were a folder.
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Unfolding a Set to Reveal its Contents.

You can now drag the individual tracks and drop them as described at the beginning of this
section. Any grooves (page 195) that were saved with your Set are also available as a folder
within the unfolded Set.

You can also drag Group Tracks (page 236) and nested Group Tracks from Live's browser.
Group Tracks can be expanded in the browser, allowing you to load an individual track from

within.

In addition to unfolding Sets, you can further unfold the tracks within the Sets to access the indi-
vidual Session View clips that were used on the track:

Revealing the Session View Clips Contained in a Sef.
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You can browse, preview and import Session View clips from the Set as if they had been stored
as individual Live Clips. This means that any Live Set can serve as a pool of sounds for any other,
suggesting creative reuse and crossover.

5.5.3  Exporting Session Clips as New Sets

You can export a selection of Session View clips as a new Live Set by dragging them to the
browser. To export a Set, first click and drag, or use the [Shift] or [CTRL](PC) / [ALT](Mac) modi-
fiers, to select more than one Session View clip. Then, simply drag and drop the clips into the
Current Project or any user folder, where you can either confirm Live's suggested name or type in
one of your own.

5.5.4 Template Sets

Use the File/Folder Preferences’ Save Current Set as Default button to save the current Live Set
as the default template. Live will use these settings as the initialized, default state for new Live
Sets. You can use this to pre-configure:

* Your multichannel input/output setup.

* Preset devices, like EQs and Compressors, in every track.

* Computer key mappings (page 583).

* MIDI mappings (page 573).
To delete your custom template Set, press the Clear button in the File/Folder Preferences. This
will restore the built-in factory template. You can also temporarily load the built-in factory tem-
plate by holding [Shift] while selecting New Live Set from the File menu.
In addition to this “master” default template, you can create additional template Sets for differ-
ent types of projects, each with their own unique configuration of tracks, devices, etc. To do this,
create a folder called “Templates” within your User Library. Any Sets saved to this folder will

then function as templates: they will load with the configuration you saved, but with the name
Untitled.als, ready to be used as a new Set.
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Multiple Template Sets in the User Library

5.5.5 Viewing and Changing a Live Set’s File References

To view a list of the files referenced by the current Live Set, choose the Manage Files command
from the File menu, click the Manage Set button, and then click the View Files button. Live will
display one line for each file used by the Live Set. To list all clips or instruments in the Live Set
where the file is actually used, click the triangle to expand the line. Here is what you can do:

* Replace a file — Dragging a file from the browser and dropping it on an entry in the list
makes the Live Set reference the new file instead of the old one. For samples used in audio
clips, Live retains the clip properties; the Warp Markers are kept if the new sample has the
same or a greater length as the old sample and discarded otherwise. Please note that re-
placing a sample will change all clips in your set that reference this sample.

® Replace Files @ O @

List of referenced files. Tell me more.

Name A | Location | Candi... |
@ » Amen Break.wav External
&
Drumloop.wav xterna
) [t | B muVnice aif

Fytarnal

Every Entry in the File Reference List is a Drop Target for Files.

* Hot-swap files — Using the Hot-Swap button at the left-hand side of each entry, you can
quickly browse through alternatives for the file that is currently being referenced. This is like
dragging files here, only quicker.
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The File Reference List's Hot-Swap Button.

* Edit a referenced sample — using an external application (which can be chosen in the
Preferences’ File/Folder tab). Clicking the Edit button will open the referenced sample in
the external application. The sample will remain offline as long as the Edit switch is en-
gaged. For samples used in audio clips, the current set of Warp Markers is retained only if
the sample length remains the same as before. Note that the Edit button is only available
for samples, not for other types of files such as Max for Live devices (page 553).

) |Edit ]|
@

(&) | Edit |

The File Reference List’s Edit Switch.

* View a file’s location — The Location column states if a file is missing (page 92), or if it
resides in your User Library, a Project or somewhere else (“external”). When unfolded, the
entry shows the specific places in the Set where the file is used.

) |Edit]
) |Edit]

) |Edit]

The File Reference List’s Location Column.

5.6  Live Projects

A Live Projectis a folder containing Live-related files that belong together. Consider, for exam-
ple, work on a piece of music: You start out with an empty Live Set; you record audio and there-
by create new sample files; you drag in samples from collections; you save different versions of
the Live Set along the way so that you can go back and compare. Perhaps you also save Live
Clips or device presets that “belong” to this particular musical piece. The project folder for this
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Live Project will maintain all the files related to this piece of music — and Live's File Manager will
provide the tools you need to manage them (page 92).

5.6.1  Projects and Live Sets

When you save a Live Set under a new name or in a new folder location, Live will create a new
project folder and store the Live Set there — unless you are saving the Live Set into an existing
Live Project. Let's look at an example to illustrate this process:

We have recorded some audio into a new Live Set. We now save the Live Set under the name
“Tango” on the Desktop. The Desktop is available in the browser because we have previously
added it as a user folder. Here is the result as displayed by the Live browser:

A Live Set and its Recordings in a Live Project Folder.

The project folder (“Tango Project”) contains the Live Set (“Tango.als”) and a Samples folder,
which in turn contains a Recorded folder with two samples in it. Note that the current Project is
also indicated in the title bar of Live’s application window.

Next, we record another track into our Project. We save the modified version of the Live Set un-
der a new name so that we do not lose the previous version. Accepting the Save As command’s
default suggestion, we store the new version of the song in the Tango Project folder.
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A Second Version of the Live Set Has Been Added to the Project.

The Tango Project now contains two Live Sets, and its Samples/Recorded folder contains the
samples used by both of them.

And now for something completely different: We choose the File menu’s New Live Set command
and record a samba tune. As this has nothing to do with our tango dabblings, we decide to save
it outside the Tango Project folder, say on the Desktop. Live creates a new project folder named
Samba Project next to Tango Project.

A New Project Was Added Next to Tango Project.

So far we have seen how to create Live Projects and save versions of Live Sets into them. How
do we open a Project? Simply by opening any of its contained Live Sets. Double-clicking “Tango
with Piano.als” opens that Set and the associated Project — as displayed in Live's title bar.
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Let's suppose that, in the course of our work on “Tango with Piano.als,” we get sidetracked: The
piece evolves towards something entirely different, and we feel that it should live in a Project of
its own. So, we “Save As..." under a new name and in some location outside the current Project,
say the Desktop:

A New Project Was Added by Saving a Live Set Outside its Original Project.

Note that the new project folder has no Samples folder (yet). “Electro with Piano.als” is still refer-
encing the piano sample from the original Tango Project. There is nothing wrong with this except
for when the Tango Project is moved away or deleted; then “Tango with Piano.als” will be miss-
ing samples. You can prevent this by collecting external files (page 95). Even after the fact,

Live's tools for searching missing files (page 92) can help solve this problem.

There is actually no need to keep a Project’s Live Set exactly one level below the Project itself.
Within a project folder, you can create any number of sub-folders and move files around to or-
ganize them as desired, although you many need to use the File Manager to “teach” the Project
about the changes you've made (page 99).

In general, Live will do what it can to prevent situations such as orphaned (Project-less) Live Sets,
which have the potential of confusing both the user and Live's file management tools. It cannot,
however, control situations in which Sets or files are moved out of order and become disorga-
nized via the Explorer (Windows)/Finder (Mac).

A note for users of older Live versions: Live does not allow overwriting Live Sets that were cre-
ated by older major versions to prevent compatibility problems. Instead, you will be requested to
“Save As...". Doing this will insure that the newly saved Live Sets reside in project folders.
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5.6.2  Projects and Presets

By default, new instrument and effect presets are stored in your current Project. At times how-
ever, it may make more sense to save a preset to another folder or to your User Library, so that
you can access them from other Projects. You can drag a preset between folders after saving it
(page 266), or simply drag the title bar of the device over a folder in the sidebar, wait for the
content pane to open, and then drop it info the content pane, adding it to the folder.

When saving presets that contain samples to a new location, Live may copy the samples de-
pending on the settings in the Collect Files on Export chooser in the Library Preferences. You can
then type in a new name for the device or confirm the one suggested by Live with [Enter].

5.6.3  Managing Files in a Project

Live's File Manager offers several convenient tools for managing Projects. Once you've opened
a Live Set that is part of the Project you wish to manage, choose the Manage Files command
from the File menu, and then click the Manage Project button. The File Manager will present you
with an overview of the Project’s contents and tools for:

¢ locating files that the Project is missing;
* collecting external files into the Project (page 95);
* listing unused files in the Project (page 97);

* packing a Project in Pack format (page 98);

5.7  Locating Missing Files

If you load a Live Set, Live Clip or preset that references files which are missing from their ref-
erenced locations, Live's Status Bar (located at the bottom of the main screen) will display a
warning message. Clips and instrument sample slots that reference missing samples will appear
marked “Offline,” and Live will play silence instead of the missing samples.

Live's File Manager offers tools for repairing these missing links. Click on the Status Bar message
to access these. (This is actually a shortcut for choosing the Manage Files command from the File
menu, clicking the Manage Set button, and then clicking the Locate button found in the Missing
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Files section.) The File Manager will present you with a list of the missing files and associated
controls.

The File Manager's List of Missing Files.

5.7.1  Manual Repair

To manually fix a broken file reference, locate the missing file in the browser, drag it over to the
File Manager and drop it on the respective line in the list of missing files. Note that Live will not
care if the file you offer is really the file that was missing.

5.72  Automatic Repair

Live offers a convenient automatic search function for repairing file references. To send Live on
a search, click the Automatic Search section’s Go button. To reveal detailed options for guiding
the automatic search function, click the neighboring triangular-shaped button.
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Automatic Repair Options in the File Manager.

* Search Folder — includes a user-defined folder, as well as any sub-folders, in the search.
To select the folder, click the associated Set Folder button.

* Search Project — includes this Set's project folder in the search.
* Search Library — includes the Live Library in the search.

For each missing file, the automatic search function may find any number of candidates. Let’s
consider the following cases:

* No candidate found — you can choose another folder and try again, or locate the sample
manually.

* One candidate found — Live accepts the candidate and considers the problem solved.

* Several candidates found — Live requires your assistance: Click the Hot-Swap button (i.e.,
the leftmost item in every line of the list of missing files) to have the browser present the
candidates in Hot-Swap Mode. You can now double-click the candidates in the browser
to load them, as the music plays if you like.
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5.8  Collecting External Files

To prevent a Live Set from containing broken file references, Live provides the option of collect-
ing (i.e., copying) them into the Set's project folder. This is accomplished via the File Manager:

¢ Choose the Manage Files command from the File menu
* Click the Manage Set button

* Unfold the triangular-shaped fold button in the External Files section.

(X) Current Live Set

v

Options for Collecting External Files.

Separated by location (other Projects, the User Library, installed by factory Packs, and else-
where — sample collections from external drives, for example), the File Manager provides:
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* A file count and the associated disk space used;
* A Show button that will list the files in the browser;
* A Yes/No toggle for engaging or disengaging collection.

Note: Make sure to confirm your choices by clicking the File Manager’s Collect and Save but-
ton!

The File Manager’s Collect and Save Butfon.

The File menu’s Collect All and Save command is a shortcut that collects and saves all external
files referenced by the current Set, including those from Live's Core Library or other installed
Packs. Note that this can cause a lot of copying, especially if your Live Set uses large multisam-
ple collections!

5.8.1  Collect Files on Export

When you save Live Clips, device presets or tracks by dragging them into the Browser, Live man-
ages the copying of associated files based on the selection made in the Collect Files on Export
chooser in the Library Preferences. This chooser provides the following options:

* Always, the default setting, will copy files into the same folder as the clip, preset, or track
without notification.

* When Ask is selected, Live provides a dialog box with options for copying files.

* Never means that files will not be copied when saving.
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5.9 Aggregated Locating and Collecting

Instead of having to deal with problems while you are in a creative mode, you might prefer put-
ting aside some dedicated housekeeping time to solve all the problems in one go. Using Live's
File Manager, you can find missing files and collect external files not only for the current Live Set
but also for:

* The User Library — choose the Manage Files command from the File menu; then click the
Manage User Library button.

* The current Live Project — choose the Manage Files command from the File menu; then
click the Manage Project button.

* Any Live Project — [right-click](PC) / [CTRL-click](Mac) on a Project in the browser’s con-
tent pane, and choose the Manage Project option.

* Any selection of Live Sets, Live Clips, Live Presets — [right-click](PC) / [CTRL-click](Mac)
on the respective items in the browser, and choose the Manage Files command.

Remember to click the Collect and Save button at the bottom of the File Manager when you are
finished. Otherwise your changes will be discarded.

5.10 Finding Unused Files

Live's File Manager can find the unused files in a Project for you. You can then review them and
decide to delete them individually or collectively. When searching for “unused” files, Live will
inspect each file in a Project folder, checking if it is referenced by any of the Live Sets, Live Clips
or device presets in the Project. If not, the file is regarded as unused — even if other Projects or

programs still use it.

To find the unused files for the currently open Project, choose the Manage Files command from
the File menu, click the Manage Project button, and then click on the triangular-shaped fold but-
ton next to “Unused Files” to access a summary and the Show button. Clicking the Show button
makes the browser list the unused files; there, you can preview samples (page 69) and delete
them if you like.
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Note you can also find the unused files from the Library: choose the Manage Files command
from the File menu, then click the Manage Library button, and then see the Unused Files section.

Last but not least, you can find the unused files for all Projects found in a specific folder (and its
sub-folders): [right-click](PC) / [CTRL-click](Mac) on a folder in the browser and choose the
Manage Projects command, then see the Unused Files section. Live inspects each Project indi-
vidually and labels a file unused even if another Projects in the same folder does use that file. To
prevent losses, you may want to first collect the files into their respective Projects and then purge
the Projects of unused files.

5.11 Packing Projects into Packs

Live's File Manager provides the option of packing a Live Project in Pack format for convenient
archiving and transfer. To do this, choose the Manage Files command from the File menu, click
the Manage Project button, and then click on the triangular-shaped fold button next to “Pack-
ing.” Click the Create Pack button to bring up a file-select dialog where you can specify the
name and location of a new Pack file. Creating a new Pack from a Project does not affect the
Project. If you want the Project deleted, you can delete it using the browser.

Live employs lossless compression techniques to minimize the file size of Packs. Depending on
the audio materials in a Project, this saves up to 50 percent in file size.

To unpack a Pack (i.e., to restore the original Live Project), double-click the Pack file (.alp), drag

it into the Live main window, or locate it via the File menu’s Install Pack command. Live will then
install the Pack to its default location and it will appear in the Packs label in the browser.

5.12 File Management FAQs

5.12.1 How Do | Create a Project?

A Project is automatically created whenever you save a Live Set, except when you save it into a
preexisting Project.
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5.12.2 How Can | Save Presets Into My Current Project?

You can save presets directly to the current project by dragging from the device's title bar and
dropping into the Current Project label in the browser. You can then use the File Management
tools, collect any referenced samples, etc.

5.12.3 Can | Work On Multiple Versions of a Set?

If you'd like to work on different versions of the same Live Set, save them into the same Project.
This will usually be the Project that was created when you saved the first version of the Live Set. If
a Project contains multiple Live Sets it will only collect one copy of any samples used by the vari-
ous versions, which can save disk space and help with organization.

5.12.4 Where Should | Save My Live Sets?

You can save Live Sets anywhere you want, but saving to pre-existing Project folders can cause
problems, and should be reserved for special cases. You should only save a Live Set to an exist-
ing Project if it is somehow related to the Project — for example, an alternate version of a song
that's already in the Project.

5.12.5 Can | Use My Own Folder Structure Within a Project
Folder?

You can organize your files any way you want within a Project, but you'll need to use the File
Manager to relink the files that you've moved around:

1. In Live's Browser or via your operating system, reorganize the files and folders within your
Project folder.

2. Navigate to the Project folder in the Browser and choose Manage Project via the [right-
click](PC) / [CTRL-click]{Mac) context menu.

3. If you've changed the original location of any samples used in the Project, the Missing
Samples section of the File Manager will indicate this. Click the Locate button to search for

the samples.

4. Since you know that your samples are all in the Project folder, unfold Automatic Search.
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Then enable the Search Project and Fully Rescan Folders options. Finally, click Go to initi-
ate the search.

5. When searching is complete, click Collect and Save at the bottom of the File Manager to
update the Project.
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Chapter 6

Arrangement View

The Arrangement View displays the Arrangement, which contains music laid out along a song
timeline, like a multitrack tape.

A Piece of Music in the Arrangement View.

The Arrangement View is a powerful editing tool that easily lets you combine and arrange MIDI,
loops, sound effects, video and complete pieces of music.

6.1  Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:
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Navigating the Arrangement View.

1. To smoothly change the zoom level, click and drag vertically in the beat-time ruler at the
top of the Arrangement View (you can also drag horizontally to scroll the display).

2.To zoom in and out around the current selection progressively, you can use the computer
keyboard’s [+] and [-] keys, or scroll with the mousewheel or trackpad while holding the
[CTRL](PC) / [CMD](Mac) modifier. To “pan” the display, click and drag while holding the
[CTRL][ALT](PC) / [CMD][ALT](Mac) modifier. Double-clicking in the beat-time ruler also
zooms to the current selection. If nothing is selected, double-clicking the beat-time ruler
zooms out to show the entire Arrangement.

3. To zoom in the current selection completely, press [Z] or use the View menu’s Zoom to Ar-
rangement Time Selection command. (Note that if you select time on a single Arrangement
clip, the Clip View display (page 138) will zoom in on that selected time.) You can revert
back to the previous zoom state by pressing [Shiff][Z]. Note that pressing [Shiff][Z] another
time will zoom the Arrangement out completely.

4. To vertically zoom a selected track, scroll inside the Track Display Area with the mouse-
wheel or trackpad while holding the [ALT] modifier. Note that if the Arrangement contains
a time selection, all tracks with selected content will zoom vertically.

5.The Arrangement Overview is like a “bird’s-eye view” of your music. It always shows the
complete piece, from start to end. The black rectangular outline represents the part of the
Arrangement that is currently displayed in the Arrangement display below. To scroll the
display, click within the outline and drag left or right; to zoom out and in, drag up and
down.
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6. To change the displayed part of the Arrangement, drag the outline’s left and right edges.

7. To see a specific part of the Arrangement in more detail, click on it in the Overview and
drag downwards to zoom in around that part. Note that you can also drag horizontally to
scroll the display. Using this method, you can zoom and scroll to focus around any part of
the Arrangement with just one mouse motion.

8. To have the Arrangement display follow the song position and scroll automatically, turn on
the Follow switch, or use the Follow command from the Options menu. Follow will pause if
you make an edit or scroll the view horizontally in the Arrangement. Follow will start again
once you stop or restart playback, or click in the Arrangement or clip scrub area.

6.2  Transport

There are a number of ways to control Live's transport with the computer keyboard and mouse:

1. You can start Arrangement playback by clicking the Control Bar's Play button, and stop
playback by clicking the Stop button. Arrangement playback can also be toggled on and
off by pressing the keyboard’s space bar.

The Play and Stop Buttons in the Control Bar.

2. You can set the Arrangement playback position by clicking anywhere along the Arrange-
ment to place the flashing insert marker. You can return the Arrangement play position to

1.1.1 by double-clicking the Stop button or by pressing the Home key (PC) / Function + left
arrow key (Mac).

Arrangement Playback Begins from the Insert Marker.
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To continue playback from the position where it last stopped, rather than from the insert
marker, hold down the [Shift] modifier while pressing the space bar.

3. When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking in the
scrub area above the tracks will make playback jump to that point. The size of these jumps
is quantized according to the Control Bar’s Quantization menu setting. While the mouse is
held down over the scrub areq, a portion of the Arrangement the size of the chosen quan-
tization setting will be repeatedly played. With small quantization settings, or a setting of
“None,” this allows you to scrub through the music. Activating the Options menu’s Chase
MIDI Notes command allows MIDI notes to play back even if playback begins after the
MIDI note’s start time.

When the Permanent Scrub Areas preference is off, you can still scrub by [Shift]-clicking
anywhere in the scrub area or in the beat time ruler.

Scrubbing Arrangement Playback.

4. The song position can be adjusted numerically using the Control Bar’s Arrangement Posi-
tion fields.

>- 6. 4.1 pHO® -+

Setting the Play Position in the Arrangement Position Fields.

The Arrangement Position fields show the song position in bars-beats-sixteenths. To change
the values:

¢ Click and drag up or down in any of these fields.
¢ Click and type a number, then hit [Enter].
¢ Click and decrement or increment the value with the up and down arrow keys .

5. Arrangement playback can be started at a particular point in one of your clips using the
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scrub area in the Clip View (page 131).

6. Several Arrangement playback positions can be set using launchable locators (page
105).

Note that any computer keyboard key or MIDI message can be mapped to the transport con-
trols, as described in the respective chapter (page 573).

6.3  Launching the Arrangement with Locators

Using Locators to Launch Play in the Arrangement.

Locators can be set at any point in the Arrangement. This can be done in real time during play-
back or recording with the Set Locator button, and will be quantized according to the global
quantization value set in the Control Bar. Clicking the Set Locator button when the Arrangement
is not playing will create a locator at the insert marker or selection start. You can also create a
locator using the context menu in the scrub area above the tracks or via the Create menu. Note
that the position of a new locator is quantized according to the Control Bar’s Quantization menu
setting.

The Locator Controls.
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You can recall (jump to) locators by clicking on them, or with the Previous and Next Locator
buttons below the Set button. Locators can also be recalled using MIDI/key mapping (page
573). Note that locator recall is subject to quantization. Double-clicking a locator will select it
and start Arrangement playback from that point.

After jumping to the first or last locator in the Arrangement, the Previous and Next Locator but-
tons will jump to the Arrangement start or end, respectively.

Locators can be moved by clicking and dragging, or with the arrow keys on your computer key-
board.

To name a locator, select it by clicking its triangular marker, and choose the Rename Edit menu
command (or use the [CTRL][R](PC) / [CMD][R](Mac) shortcut). You can also enter your own info
text (page 31) for a locator via the Edit Info Text command in the Edit menu or in the locator’s
[right-click](PC) / [CTRL-click](Mac) context menu. Locators can be removed with your com-
puter’s [Backspace] or [Delete] key , the Create menu, or the Delete Locator button.

Note that the locator [right-click](PC) / [CTRL-click][Mac) context menu offers a quick way of
looping playback (page 108) between two locators with its Loop To Next Locator command.

The locator [right-click](PC) / [CTRL-click](Mac) context menu’s Set Song Start Time Here com-
mand can be used to overrule the default “play starts at selection” rule: when this command is
checked, play starts at the locator.

6.4  Time Signature Changes

Time Signature Changes.

Live's time signature can be changed at any point in the Arrangement by using time signature
markers. These can be added at the insert marker position via the Create menu, or anywhere
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below the beat-time ruler using the [right-click](PC) / [CTRL-click](Mac) context menu. Time
signature markers appear just below the beat time ruler, but this marker area is hidden if a Set
contains no meter changes, freeing up additional space at the top of the Arrangement.

In many ways, time signature markers look and function like locators; they can be moved with
the mouse or with your computer keyboard’s arrow keys, and their value can be changed using
the Edit menu’s Edit Value command (or with the [CTRL][R](PC) / [CMD][R](Mac) shortcut). They
can be also be deleted using the [Backspace] or [Delete] key, or via delete commands in the Edit
and Create menus.

The time signature marker [right-click](PC) / [CTRL-click](Mac) context menu offers a number of
features, including a Delete All Time Signature Changes command and options to loop or select
the area up to the next time signature marker.

Any time signature with a one- or two-digit numerator and a denominator of 1, 2, 4, 8 or 16
can be used as a time signature marker value. The numbers must be separated by a delimiter
such as a slash, comma, period, or any number of spaces. These marker values can also be set
by adjusting the time signature fields in the Control Bar, either by typing in values or dragging
the numerator and denominator sliders. This will change the time signature marker value at the
current play location, and works either with the transport stopped or during playback. When the
Arrangement contains time signature changes, the time signature editor displays an automation
LED in the upper left corner.

Tap | 120.00 NI [1IF80A 8 o0® ~ 1Bar ~

The Time Signature Editor Can Change Time Signature Marker Values, and Shows an Automation

LED.

Time signature markers are not quantized; they may be placed anywhere in the timeline, and
their positioning is only constrained by the editing grid (page 114). This means that it is pos-
sible to place meter changes in “impossible” places — such as before the end of the previous
measure. This creates a fragmentary bar, which is represented in the scrub area by a cross-
hatched region. Live is happy to leave these incomplete measures as they are, but if you'd like
your Set to conform to the rules of music theory, you can use the two [right-click](PC) / [CTRL-
click](Mac) context menu options to “correct” incomplete bars.
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A Fragmentary Bar and its Resolution Options.

Delete Fragmentary Bar Time deletes the duration of the fragmentary bar from the Arrangement,
thereby moving any audio or MIDI on either side of the deleted area closer together in the time-
line. The next time signature marker will now fall on a “legal” barline.

Complete Fragmentary Bar inserts time at the beginning of the fragmentary bar, so that it be-
comes complete. The next time signature marker will now fall on a “legal” barline.

Please note that these resolution options affect all tracks — deleting and inserting time changes
the length of the entire Arrangement.

If you import a MIDI file (page 81) into the Arrangement, you'll be given an option to import
any time signature information that was saved with the file. If you choose to do this, Live will au-
tomatically create time signature markers in the correct places. This makes it very easy to work
with complex music created in other sequencer or notation software.

6.5 The Arrangement Loop

6.2.1'\__/' 10. 2. 0

The Control Bar's Loop Switch.

For Live to repeatedly play a section of the Arrangement, activate the Arrangement loop by
clicking on the Control Bar’s Loop switch.

e RS e

The Loop Start Fields (Left] and the Loop Length Fields (Right).
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You can set loop length numerically using the Control Bar fields: The left-hand set of fields deter-
mines the loop start position, while the right-hand set determines loop length.

The Edit menu’s Loop Selection command accomplishes all of the above at once: It turns the Ar-
rangement loop on and sets the Arrangement loop brace to whatever timespan is selected in the
Arrangement. You can toggle the Loop Selection command on and off using the [CTRL][L](PC) /
[CMD][L](Mac) shortcut.

The Arrangement’s Loop Brace.

The loop brace can be selected with the mouse and manipulated with commands from the com-
puter keyboard:

* the right and left arrow keys nudge the loop brace to the left/right by the current grid set-
ting (page 114).

* the up and down arrow keys shift the loop brace left/right in steps the size of its length.

* The [CTRL](PC) / [CMD](Mac) modifier used with the arrow left and right keys shortens or
lengthens the loop by the current grid setting.

* The [CTRL](PC) / [CMD](Mac) modifier with the arrow up and down keys doubles or
halves the loop length.

You can also drag the Arrangement’s loop brace: Dragging the left and right ends sets the loop
start and end points; dragging between the ends moves the loop without changing its length.

The loop's [right-click](PC) / [CTRL-click](Mac) context menu’s Set Song Start Time Here com-
mand can be used to overrule the default “play starts at selection” rule: when this command is
checked, play starts at the loop start.
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6.6  Moving and Resizing Clips

A piece of audio or MIDI is represented in the Arrangement View by a clip sitting at some song
position in one of Live's tracks.

Moving a Clip.

Dragging a clip moves it to another song position or track.

Changing a Clip’s Length.

Dragging a clip's left or right edge changes the clip’s length.

Clips snap to the editing grid, as well as various objects in the Arrangement including the edges
of other clips, locators and time signature changes.

To slide the contents of a clip within the clip’s boundaries, hold [CTRL][Shift](PC) / [ALT][Shift]
(Mac) while dragging the clip’s waveform or MIDI display. To bypass grid snapping, hold down
[CTRL][ALT][Shift] (PC) / [CMD][ALT][Shiftl[Mac) while dragging the clip’s contents.

6.7  Audio Clip Fades and Crossfades

The beginning and end of audio clips in the Arrangement View have adjustable volume fades.
Additionally, adjacent clips on the same audio track can be crossfaded.
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Fade controls are always available for audio clips, provided that Automation Mode (page
305) is disabled, and the tracks containing those clips are at least three units tall (Note: if a
clip’s track is too small, you can simply adjust the height of the track until the fade controls ap-

pear.)

To access the fade controls in an audio clip, simply hover over that clip with the mouse. Here is
what you can do with the fade controls:

1. Click and drag the fade in and fade out handles to change the length of the fade. The
Fade In Start and Fade Out End handles allow you to change the duration of a fade in or
fade out without affecting the fade peaks. However, fade edges cannot move beyond fade

peaks.

2. Click and drag the fade curve handle to change the shape of the fade’s curve.

Fades in the Arrangement View.

You can also set the length of a fade by selecting a range of time within the clip (page 113)
that includes the clip’s beginning or end and executing the Create Fade In/Out command in the
Create menu.

Adjacent audio clips can be crossfaded. Creating and editing crossfades is similar to creating

and editing start and end fades:
¢ click and drag a fade handle over the opposite clip’s edge to create a crossfade
* click and drag the slope handle to adjust the shape of the crossfade’s curve

* select a range of time that includes the boundary between the adjacent clips and execute
the Create Crossfade command from the Create menu.
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Crossfaded Clips.

Selecting a fade handle and pressing the [Delete] deletes the fade, unless the Create Fades on
Clip Edges option is enabled in the Record/Warp/Launch Preferences. In this case, pressing
[Delete] returns the fade handle to a default length of 4 ms. With this option enabled, new clips
in the Arrangement View will have these short “declicking” fades by default.

Automatically Create Short Fades At Clip Edges.

Another result of enabling the Create Fades on Clip Edges option is that adjacent audio clips will
get automatic 4 ms crossfades. These can then be edited just like manually-created crossfades.

There are some limits to the length of fades and crossfades:
* Fades cannot cross a clip’s loop boundaries.
¢ Aclip's start and end fades cannot overlap each other.
When a fade handle is selected, a dotted black line will appear on the relevant clip to indicate

the limit for that fade handle. This is especially helpful when editing crossfades, because one
clip’s loop boundary may be “hidden” under the other clip.
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Note that fades are a property of clips rather than the tracks that contain them, and are inde-
pendent of automation envelopes (page 301).

6.8  Selecting Clips and Time

With the exception of moving and resizing clips, Arrangement editing in Live is selection-based:
You select something using the mouse, then execute a menu command (e.g., Cut, Copy, Paste,
Duplicate) on the selection. This editing method lends itself to an efficient division of labor be-
tween the two hands: One hand operates the mouse or trackpad, while the other hand issues the
keyboard shortcuts for the menu commands. The menu eventually is only used as a reference for
looking up the keyboard shortcuts.

Here is how selection works:
* Clicking a clip selects the clip.
¢ Clicking into the Arrangement background selects a point in time, represented by a flash-
ing insert marker. The insert marker can then be moved in time with the left and right arrow
keys, or between tracks via the up and down arrow keys. Holding [CTRL](PC) / [ALT](Mac)

while pressing the left and right arrow keys snaps the insert marker to locators and the
edges of clips in the selected track or tracks.

¢ Clicking and dragging selects a timespan.

* To access the time within a clip for editing, “unfold” its track by clicking the ® button next
to the track name.

Adjusting an Unfolded Track’s Height.

* Clicking and dragging in the lower half of the clip’s waveform or MIDI display allows you
to select time within the clip. You can adjust the height of the unfolded track by dragging
the split line below the Unfold Track button. Note that you can resize all tracks in the Ar-



Arrangement View | 114

rangement View at once, by holding [ALT] while resizing a single track. You can also un-
fold all of your tracks at once by holding down the [ALT](PC) / [ALT](Mac) modifier when
clicking the ® button.

* Clicking on the loop brace is a shortcut for executing the Edit menu’s Select Loop com-
mand, which selects all material included within the loop.

Clicking the Loop Brace to Select the Loop for Editing.

* Holding [Shift] while clicking extends an existing selection in the same track or across
tracks. You can also hold [Shiff] and use the arrow keys to manipulate the selection.

* Pressing the [0] key deactivates a selection of material, even if it contains multiple clips.
Note that pressing the [0] key while a track header is selected will deactivate that track.

* ltis possible to reverse (page 147) a selection of audio material, even if it contains mul-
tiple audio clips. To do this, select the range of time you want to reverse, and choose the
Reverse Clip(s) command from the clip’s [right-click](PC) / [CTRL-click](Mac) context menu
or press the [R] shortcut key. (Note that it isn't possible to reverse a selection that contains
MIDI clips.)

* You can use the left and right arrow keys to nudge a selection of material in either direc-
tion.

6.9  Using the Editing Grid

To ease editing, the cursor will snap to grid lines that represent the meter subdivisions of the song
tempo. The grid can be set to be either zoom-adaptive or fixed.



Arrangement View | 115

You can set the width of both zoom-adaptive and fixed grid lines using the [right-click](PC) /
[CTRL-click](Mac) context menu available in either the Arrangement View track area or the Clip
View display.

The following shortcuts to Options menu commands allow quickly working with the grid:

* Use [CTRL][1](PC) / [CMD][1]{Mac) to narrow the grid, doubling the density of the grid

lines (e.g., from eighth notes to sixteenth notes).

* Use [CTRL][2](PC) / [CMD][2](Mac) to widen the grid, halving the density of the grid lines
(e.g., from eighth notes to quarter notes).

* Use [CTRL][3](PC) / [CMD][3](Mac) to toggle triplets mode; this would, for instance,
change the grid from eighth notes to eighth note triplets.

* Use [CTRL][4](PC) / [CMD][4](Mac) to turn grid snapping on or off. When the grid is off,

the cursor does not snap to meter subdivisions.
* Use [CTRL][5](PC) / [CMD][5](Mac) to toggle fixed and adaptive grid modes.

The current spacing between adjacent grid lines is displayed in the lower right corner of the Ar-
rangement View or Clip View.

You can hold down the [ALT](PC) / [CMD](Mac) modifier while performing an action to bypass
grid snapping. If the grid is already disabled, this modifier will temporarily enable it.

6.10 Using the ...Time Commands

Whereas the standard commands like Cut, Copy and Paste only affect the current selection,
their “... Time” counterparts act upon all tracks by inserting and deleting time. Any time signature
markers within the selected region will also be affected.

* Cut Time cuts a selection of time from the Arrangement, thereby moving any audio or MIDI
on either side of the cut area closer together in the timeline. This command reduces the
length of your Arrangement by whatever amount of time you have cut. Note that the Cut
Time command affects all tracks, not only the selected ones.
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A Gap Between Clips Has Been Cut by First Selecting It (Left), Then Executing the Cut Time Com-
mand (Right).

¢ Paste Time places copied time into the Arrangement, thereby increasing its overall duration
by the length of time you have copied.

* Duplicate Time places a copy of the selected timespan into the Arrangement, thereby in-
creasing its overall duration by the length of the selection.

* Delete Time deletes a selection of time from the Arrangement, thereby moving any audio
or MIDI on either side of the deleted area closer together in the timeline. This command
reduces the length of your Arrangement by the amount of time you have deleted. Note that

the Delete Time command affects all tracks, not only the selected ones.

* Insert Silence inserts as much empty time as is currently selected into the Arrangement,

before the selection.

6.11  Splitting Clips

The Split command can divide a clip orisolate part of it.

To split a clip in two halves, do the following:
1. Unfold the track;
2. In the waveform or MIDI display, click at the position where you want the clip to be split;
3. Execute the Split command.

To isolate a part of a clip, do the following:
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1. Unfold the track;

2. In the waveform or MIDI display, drag a selection over the part of the clip you want to
isolate;

3. Execute the Split command to divide the original clip into three pieces.

The Result of Splitting a Clip.

6.12 Consolidating Clips

The Consolidate command replaces the material in the Arrangement View selection with one
new clip per track. This is very useful for creating structure.
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Consolidating Several Clips Into a New Clip.

Suppose you have, by editing or improvising, come up with a layout of clips that sound good in
Arrangement Loop mode. Selecting that part of the Arrangement, for instance by using the Edit
menu’s Select Loop command, and then executing the Consolidate command creates a new clip
that can be treated as a loop. You can now, for instance, drag the clip edges to create more
repetitions. You might also want to drag the new loop via the Session View selector into a Ses-
sion View slot for real-time arrangement purposes.

When operating on audio clips, Consolidate actually creates a new sample for every track in
the selection. The new samples are essentially recordings of the time-warping engine’s audio
output, prior fo processing in the track’s effects chain and mixer. Hence, the new sample incor-
porates the effects of in-clip attenuation, time-warping and pitch shifting, and of the respective
clip envelopes (page 313); however, it does not incorporate the effects. To create a new sam-
ple from the post-effects signal, please use the Export Audio/Video command (page 74).

The new samples can be found in the current Set'’s Project folder, under Samples/Processed/
Consolidate. Until the Set is saved, they remain at the location specified by the Temporary
Folder (page 255).
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Chapter /

Session View

In Live's Arrangement View (page 101), as in all traditional sequencing programs, everything
happens along a fixed song timeline. For a number of applications, this is a limiting paradigm:

* When playing live, or when Dling, the order of pieces, the length of each piece and the
order of parts within each piece is generally not known in advance.

¢ In the theatre, sound has to react to what happens on stage.

* When working along with a piece of music or a film score, it can be more efficient and
inspirational to start with an improvisation, which is later refined into the final product.

This is exactly what Live's unique Session View is for.

7.1  Session View Clips

The Controls for a Session View Clip.
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1. Each clip in the Session View has a triangular button at the left edge. Click the button with
the mouse to “launch” clip playback at any time, or pre-select a clip by clicking on its
name, and launch it using the computer’s [Enter] key. You can then move on to the neigh-
boring clips using the arrow keys. Please refer the manual section on clip launch settings
(page 201) for details on how to customize this behavior.

2. Click on a square Clip Stop button to stop a running clip, either in one of the track’s slots,
orin the Track Status field below the Session grid.

Pressing the [0] key while a Session View clip(s) is selected will deactivate that clip(s).

Clips can be controlled remotely with the computer keyboard or a MIDI controller (page 573).
They can even be mapped to MIDI note ranges so that they play chromatically.

Clips can be played at any time and in any order. The layout of clips does not predetermine their
order; the Session grid offers random access to the clips it contains.

Notice that, even if you stop playback for a Session View clip, the Play button in the Control Bar
will remain highlighted, and the Arrangement Position fields will continue running. These fields
keep a continuous flow of musical time going, so that you can always know your position in song
time during a live performance or while recording into the Arrangement (page 126), regard-
less of what your individual Session clips are doing.

You can always return the Arrangement Position fields to 1.1.1 and stop playback for the entire
Live Set by pressing the Control Bar’s Stop button twice.

== .

The Arrangement Position Fields and the Stop Button.

Slots in Group Tracks (page 236) show a shaded area to indicate that at least one of the
contained tracks contains a clip in that scene. The color of the shading is the color of the left-
most clip in the group. These group slots also contain launch buttons which will launch all of the
respective clips. Group slots which have no corresponding clips contain stop buttons. Clicking in
any group slot selects all of the clips it refers to.
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Group Slots and Group Launch Buttons.

7.2 Tracks and Scenes

Each vertical column, or track, can play only one clip at a time. It therefore makes sense to put
a set of clips that are supposed to be played alternatively in the same columns: parts of a song,

variations of a drum loop, etc.

Resized Session View Tracks.

For convenient access to more clips at once, you can resize Session View tracks by clicking

and dragging at the edges of their title bars. Tracks can be narrowed this way so that only Clip
Launch buttons and essential track controls are visible. Note that you can resize all Session View
tracks at once by holding [ALT] while resizing a single track.
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A Scene in the Session View.

Note that pressing the [0] key while a Session View track header is selected will deactivate that
track.

The horizontal rows are called scenes. The Scene Launch buttons are located in the rightmost
column, which represents the Master track (page 238). To launch every clip in a row simulta-
neously, click on the associated Scene Launch button. This can be very useful in organizing the
live performance of a song with multiple parts.

The scene below a launched scene will automatically be selected as the next to be launched un-
less the Select Next Scene on Launch option in the Launch Preferences is set to “Off.” This allows
you to trigger scenes from top to bottom without having to select them first. Computer keys or a
MIDI controller can be used to launch scenes and scroll between them (page 581).

Scenes can be renamed using the Rename command in the Edit menu or the [right-click](PC) /
[CTRL-click]{Mac) context menu. One can quickly rename several scenes by executing the Re-
name command and using the computer’s [Tab] key to move from one scene to the next. You can
also enter your own info text for a scene via the Edit Info Text command in the Edit menu or in
the scene’s [right-click](PC) / [CTRL-click](Mac) context menu. The context menu also contains a
color palette where you can choose a custom scene color.

Scenes can be reordered by drag-and-drop. Multiple adjacent or nonadjacent scenes can
be selected at once by [Shift]-clicking or [CTRL]-clicking, respectively. If you drag a selection
of nonadjacent scenes, they will be collapsed together when dropped. To move nonadjacent
scenes without collapsing, use [CTRL] + the up or down arrow keys instead of the mouse.

Scene names can be both descriptive and functional; if Live detects a viable tempo and/or time
signature as part of a scene name, the project will automatically adjust to these parameters

when the scene is launched. To assign a tempo to a scene, select the scene and rename it with @
viable tempo (e.g., “96 BPM"). Any tempo can be used, as long as it is within the range allowed
by Live's Tempo control (20-999 BPM). To assign a time signature to a scene, rename the scene
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with a meter in the form of “x/y” (e.g., “4/4"). Any time signature can be used, provided it has a
numerator between 1 and 99 and a denominator with a beat value of 1, 2, 4, 8 or 16.

Tempo and time signature changes can coexist within a single scene name, and can appear
in any position as long as they are separated from each other by at least one character. For
example, “2/4+108 BPM”, “72 BPM;7/8" and “60 BPM Chorus 3/4" are all scene names that

will cause simultaneous meter and tempo changes.

These Scenes Will Change the Tempo and Time Signature.

Scenes with tempo and/or time signature changes in their names will have a colored Scene
Launch button.

7.3 The Track Status Fields

You can tell a track’s status by looking at the Track Status field just above the active track’s mixer

controls:

A Track Playing a Looping Session Clip.

The pie-chart icon in a clip track represents a looping Session clip (page 138). The number to
the right of the circle is the loop length in beats, and the number at the left represents how many
times the loop has been played since its launch. A pie-chart without numbers appears in the
Track Status field for a Group Track if at least one clip in a contained track is currently playing.
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... A One-shot Session Clip...

The progress-bar icon represents a one-shot (non-looping) Session clip. The value displays the
remaining play time in minutes:seconds.

... Monitoring the Input...

A microphone icon appears in an audio track that is set to monitor its input (page 212). A key-
board icon appears in a MIDI track under these same circumstances.

... Playing the Arrangement.

If the track is playing clips from the Arrangement, a miniature display representing the Arrange-
ment clips being played appears.

7.4  Setting Up the Session View Grid

Clips arrive in the Session View by being imported from the browser or through recording (page
245).
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Dropping Multiple Clips Into the Session View.

If you are dragging multiple clips into your Set, Live defaults to arranging them in one track;
vertically in the Session View or horizontally in the Arrangement View. Hold down [CTRL](PC) /
[CMD](Mac) prior to dropping them so as to lay the clips out in multiple tracks instead. Note: this
works for raw audio or MIDI files but not for Live Clips (page 82) (because they can contain
their own embedded devices).

Clips can be moved around the Session grid by drag-and-drop. To move several clips at once,
select them by using the [Shift] or [CTRL](PC) / [CMD](Mac) modifier before dragging. You can

also click into an empty slot and “rubber-band” select from there.

7.4.1 Select on Launch

By default, clicking a Session View clip’s Launch button also selects the clip, since you will typi-
cally want the Clip View to show the newly launched clip. However, some power-users don't
want the current focus (e.g., a return track’s devices) to disappear just because a clip has been
launched, especially when starting a clip in order to try it with the return track device settings.
Turn off the Select on Launch option from the Launch Preferences if you prefer the view to remain
as is when you launch clips or scenes.
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7.4.2  Removing Clip Stop Buttons

Slots Without Clip Stop Buttons.

You can add and remove Clip Stop buttons from the grid using the Edit menu’s Add/Remove
Stop Button command. This is useful for pre-configuring the scene launch behavior: If, for in-
stance, you don't want scene 3 to affect track 4, remove the scene 3/track 4 Stop button.

7.4.3  Editing Scenes

In addition to the standard Edit menu commands such as cut, copy, paste and duplicate, there
are two useful commands in the Create menu that apply specifically to scenes:

* Insert Scene inserts an empty scene below the current selection.

* Capture and Insert Scene inserts a new scene below the current selection, places copies of
the clips that are currently running in the new scene and launches the new scene immedi-
ately with no audible interruption. This command is very helpful when developing materials
in the Session View. You can capture an interesting moment as a new scene and move on,
changing clip properties and trying clip combinations. (Note: the number of scenes is lim-
ited in the Intro and Lite Editions.)

7.5  Recording Sessions into the Arrangement

Your Session View playing can be recorded into the Arrangement, allowing for an improvisa-
tional approach to composing songs and scores.
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The Control Bar's Arrangement Record Button.

When the Arrangement Record button is on, Live logs all of your actions into the Arrangement:
* the clips launched;
* changes of those clips’ properties (page 131);
¢ changes of the mixer and the devices’ controls, also known as automation (page 301);
* tempos and time signature changes, if they are included in the names of launched scenes.

To finish recording, press the Arrangement Record button again, or stop playback.

# MiKey — MIDIL 0% | D

Master

Intro 1
Intro 2

The Arrangement Selector.

To view the results of your recording, bring up the Arrangement View. As you can see, Live has
copied the clips you launched during recording into the Arrangement, in the appropriate tracks
and the correct song positions. Notice that your recording has not created new audio data, only
clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only one can
play at a time. When a Session clip is launched, Live stops playing back that track’s Arrange-
ment in favor of the Session clip. Clicking a Clip Stop button causes the Arrangement playback
to stop, which produces silence.

Arrangement playback does not resume until you explicitly tell Live to resume by clicking the
Back to Arrangement button, which appears in the Arrangement View and lights up to remind
you that what you hear differs from the Arrangement.
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The Back to Arrangement Button in the Session View.

The Back to Arrangement Button in the Arrangement View.

To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the Master
Track Status field. The clips in the Arrangement and in the Session View exist independently from
one another, which makes it easy to improvise into the Arrangement over and over again until it's
right.

The Stop All Clips Button.

Furthermore, you can move clips not only within the Session grid, but also from the Session View
to the Arrangement and vice versa by using Copy and Paste, by dragging clips over the © or @
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selectors, or by simply dragging clips between the two windows if you've enabled the Second
Window option via [CTRL][Shift][W](PC) / [CMD][Shift][W]({Mac) or in the View menu.

When pasting material from the Arrangement into the Session View, Live attempts to preserve
the temporal structure of the clips by laying them out in a matching top-to-bottom order. Moving
through the scenes from the top down, you can reconstruct the original arrangement. This is use-
ful for taking a composed piece of music back to the improvisational stage.

Another way to move material from the Arrangement to the Session is with the Arrangement
View’s Consolidate Time to New Scene command, which is available from the Create menu or
in the [right-click](PC) / [CTRL-click](Mac) context menu of an Arrangement selection. This com-
mand consolidates the material within the selected time range to one new clip per track. The
new clips are placed into a new Session View scene below the previously selected scene. Note
that, as with the Arrangement’s Consolidate command (page 117), this command creates a
new sample for every audio track in the selection that contained at least one clip.
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Chapter 8

Clip View

The Clip View is where clip properties can be set and adjusted.

The Clip View.

Clicking on the Clip Overview or double-clicking a clip in the Session or Arrangement View
opens the Clip View. If you're using dual monitors, the Clip View will open in the same window
you just clicked. To switch the Clip View to the other window, press [Shift][Tab]. (Tip: single-
clicking a clip will show that clip in the Clip View, but will not move the Clip View from its current
window. This allows you to, for example, dedicate one window to detailed clip editing while
using the other window for your work in the Session or Arrangement.)

Clicking the Clip Overview Opens the Clip View.

In the Session View, clicking on a Track Status Field opens the Clip View for editing the clip that
is currently running in the track.
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Clicking o Session View Track Status Field Opens the Clip View.

The properties of more than one clip can be edited collectively in the Clip View as a multi-selec-
tion. To create a multi-selection, click and drag from an empty clip slot to highlight the clips, or
select one clip and use the [CTRL](PC) / [CMD](Mac) or [Shift] modifiers to add to your selec-
tion. The properties available in the Clip View for a multi-selection depend on the contents of the
clips; generally only properties which the clips have in common are shown.

Creating a Clip Mulli-Selection.

Controls such as sliders and knobs behave slightly differently when they are part of a multi-
selection. If the clips in @ multi-selection have differing values for any particular knob or slider
parameter (clip transposition, for example), the range of these values will be displayed and can
be adjusted with the control. Dragging the knob or slider to its absolute maximum or minimum
value will make the clips’ settings thereafter identical, adjustable as a single value.

MIDI clips and audio clips in Live have different sets of properties and, consequently, do not
share the same set of Clip View controls. The two types of clips do have the following in com-
mon:

* The Clip box contains basic clip settings.

* The Envelopes box and the Envelope Editor manage the clip’s envelopes, which are used
to automate or modulate the effects, mixer, and clip or MIDI controls. Clip envelopes and
their associated Clip View components are covered in detail in a separate manual chapter
(page 313).
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* The Launch box controls clip launch behavior and, as such, only appears for Session View
clips. Setting Session View clip launch properties is covered in detail in a separate manual
chapter (page 201).

Audio clips have these additional Clip View controls:

* The Sample Display toggles with the Envelope Editor on the right-hand side of the Clip

View, and controls Live’s sample-warping capabilities and clip playback settings (page

138).

* The Sample box contains settings pertaining to how the clip plays its sample and displays it
in the Sample Display.

The Clip View for an Audio Clip.

MIDI clips have these additional Clip View controls:

* The MIDI Editor toggles with the Envelope Editor on the right-hand side of the Clip View,
and allows editing and creating MIDI notes and velocities (page 171).

* The Notes box contains settings pertaining to how Live plays a MIDI clip, as well as a col-
lection of tools for transforming the notes within the clip.

The Clip View for a MIDI Clip.

To make best use of the screen real estate, you can show or hide the Launch, Envelopes, and
Sample or MIDI boxes using the Clip View Box selector in the Clips box. You can also toggle
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between the Sample Display/MIDI Editor and the Envelope Editor by clicking in the title bars of
the Sample/Notes box and the Envelopes box, respectively.

The Clip View Box Selector Shows and Hides Various Clip View Components.

8.1  The Clip Box

The Clip Box.

8.1.1  Clip Activator Switch

Using this switch, you can deactivate a clip so that it does not play when launched in the Session
View or during Arrangement playback. Clips can also be activated/deactivated directly from
the Session or Arrangement View with their [right-click](PC) / [CTRL-click][Mac) context menus.
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8.1.2  Clip Name and Color

The Clip Name field allows naming the clip. By default, a clip’s name matches the name of the
file it references but, in general, the clip name is independent from the file name.

You can also rename a clip by selecting it in the Session grid or Arrangement View and using
the Rename command in the Edit menu or the clip’s [right-click](PC) / [CTRL-click](Mac) context
menu. This method also allows you to create your own info text for the clip via the Edit Info Text

command.

Renaming an audio clip does not rename the referenced sample file. To rename a file, select it in
Live's browser, and then choose the Edit menu’s Rename command.

Newly created clips take the same color as the track on which they're created, but the Clip
Color chooser allows you to choose a clip color manually.

You can quickly apply the track’s color to each of its clips by using the Assign Track Color to
Clips command in the track header’s [right-click](PC) / [CTRL-click](Mac) context menu.

To apply a Group Track's (page 236) color to all of its contained tracks and clips, you can use
the Assign Track Color to Grouped Tracks and Clips command in the respective Group Track
header’s [right-click](PC) / [CTRL-click](Mac) context menu.

Note that when using the Assign Track Color to Clips or Assign Track Color to Grouped Tracks
and Clips command in Session View, the color change will only affect Session clips. Likewise, us-
ing either command in Arrangement View will only change the color of Arrangement clips.

8.1.3  Clip Signature

Using the Clip Signature fields, you can specify the time signature of a MIDI or audio clip. This
setting is relevant only for display; it does not affect playback. Please note that Clip Signature
is completely separate from the project’s time signature, and can be set independently for each
clip. This makes it easy to create complex polymetric textures by simultaneously triggering clips
with different meters and/or loop lengths.

8.1.4  Clip Groove Chooser

The Clip Groove chooser selects the groove used for the clip from the grooves available in the
Groove Pool (page 196).
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The Clip Groove Chooser.

The “Open Groove Pool” entry in this chooser can be used to open the Groove Pool if it is
closed. If you want to quickly try out a variety of grooves, you can enable the Hot-Swap button
above the chooser and then step through the grooves in the browser while the clip plays.

The Commit button under the chooser “writes” the current groove settings to the clip and disables
the assigned groove. If the groove uses the Velocity parameter, committing on an audio clip will
create a volume Clip Envelope (page 313) in order to convert the groove's velocity informa-

tion info audio volume changes. Note that this will overwrite any volume Clip Envelope that was
already in the clip.

8.1.5  Clip Offset and Nudging

To jump within a playing clip in increments the size of the global quantization period, you can
use the Nudge Backward/Forward buttons in the Clip box.

Using the Nudge Backward/Forward Buttons to Jump Through a Clip.
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These buttons can also be mapped to keys or MIDI controllers (page 573). In MIDI Map
Mode, a scrub control will appear between the Nudge Backward/Forward buttons and can be
assigned fo a rotary encoder wheel for continuous scrubbing.

The Scrub Control in MIDI Map Mode.

With quantization set to values less than one bar, it is easy to offset clip playback from Live's
master clock by launching clips, using the Nudge Backward/Forward buttons or scrubbing
within the clip (page 140).

8.2  The Sample Box

8.2.1  Warp Controls

The Sample Box Warp Controls.
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When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irrespective
of the current Live Set tempo. This is useful for samples that have no inherent rhythmic structure:
percussion hits, atmospheres, sound effects, spoken word and the like. Turn the Warp switch on
to play rhythmically structured samples (such as sample loops, music recordings, complete music
pieces, etc.) in sync with the current song tempo.

Tap § 200-00 [Hl|| IIll 4 / 4 | O® ~ None ~

The Control Bar's Tempo Field.

To verify this, note that a warped sample’s speed follows the tempo as you change the Control
Bar’s Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching qual-
ity (page 165). For accurate warping, Live needs to know the sample’s metrical structure. For
properly prepared loops, tempo and duration are calculated automatically; most of the time this
is accurate enough that the sample is immediately ready for use in Live. For other samples, you
may have to provide some hints. We will examine these topics thoroughly in the Audio Clips,
Tempo, and Warping chapter (page 153).

8.2.2 Sample Loop/Region and Display

Zooming and Scrolling

The Clip Zoom/Scroll Area.
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Zooming and scrolling in the Sample Display work much like they do in the Arrangement View
(page 101). When Warp is disabled, zooming and scrolling can be done anywhere in the
upper half of the Sample Display. When Warp is enabled, however, scrolling only happens in
the beat-time ruler.

Click and drag vertically in these areas to smoothly change the zoom level, and horizontally to
scroll the display.

To zoom in on the current time selection, press [Z] or use the View menu’s Zoom to Clip Selection
command. You can revert back to the previous zoom state by pressing [Shiff][Z]. Note that press-
ing [Shift][Z] another time will zoom the Clip View out completely.

The Clip Overview.

The Clip Overview provides additional zoom/scrolling functionality. It always shows the com-
plete clip, from start to end. The black rectangular outline represents the part of the clip that is

currently displayed. You can click within the outline and drag horizontally or vertically to scroll
or zoom.

To have the Sample Display follow the play position and scroll automatically, turn on the Follow
switch, or use the Follow command from the Options menu. Follow will pause if you make an
edit in the Sample Editor. Follow will start again once you stop or restart playback, or click in the
Arrangement or clip scrub area.

+lelelo

The Follow Switch.
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Playing and Scrubbing Clips

The section of the sample that plays when a clip is launched is set with the clip’s region and loop
controls (page 141). An unlooped clip will play from its start marker to its end marker or until it
is stopped.

The Clip Start and End Markers.

These markers can be clicked and dragged to new positions in the Sample Display, or they can
be moved with the left and right arrow keys. To move the entire clip region (i.e., both the start
and end markers), select either marker, hold down [ALT], and use the arrow keys.

Using Clip Start and End Controls to Change Clip Length.

You can also adjust the clip start and end numerically using the respective value fields to the left
of the Sample Display. For warped clips, these fields display values as bars-beats-sixteenths; for
unwarped clips, the display is in minutes-seconds-milliseconds. Notice that you can use the Set
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buttons here to place the markers during playback. Setting markers this way is quantized ac-
cording to global quantization.

When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking in the lower
half of the waveform or in the beat-time ruler will make clip playback jump to that point.

The Clip Scrub Area.

The size of this jump is quantized by the global quantization setting, which can be quickly
changed using the [CTRL][6](PC) / [CMD][6](Mac), [7], [8], [9], and [0] shortcuts. While the
mouse is held down over the scrub area, a portion of the clip the size of the chosen quantization
setting will be repeatedly played. With small quantization settings, or a setting of “None,” this
allows you to scrub through the music. Activating the Options menu’s Chase MIDI Notes com-
mand allows MIDI notes to play back even if playback begins after the MIDI note’s start time.

When the Permanent Scrub Areas preference is off, you can still scrub by [Shift]-clicking any-
where in the scrub area or in the beat time ruler.

Looping Clips

To have the clip play as a (potentially infinite) loop, turn on the Loop switch. Note that the Warp
switch must be activated before the Loop switch is accessible, as unwarped clips cannot be
looped.

You can click and drag to change the position and length of the loop brace in the Sample Dis-
play, or you can type exact values into the Loop Length and Position fields to the left of the dis-

play.
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The Clip Loop Controls.

The loop brace can be selected with the mouse and its position changed with commands from
the computer keyboard:

¢ the left and right arrow keys nudge the loop brace to the left/right by the current grid set-
ting (page 114).

* the up and down arrow keys shift the loop brace left/right in steps the size of its length.

* [CTRL](PC) / [CMD](Mac) plus the left or right arrow shortens or lengthens the loop brace
by the current grid setting.

* [CTRL](PC) / [CMD](Mac) plus the up or down arrow doubles or halves the loop length.

¢ (MIDI clips only) The loop’s length and its contents can be duplicated at once via the Edit
Menu’s Duplicate Loop command. Any notes to the right of the loop will be moved, so that
they maintain their position relative to the end of the loop.

Regardless of the position of the loop brace, clip play will begin at the position marked by the
start marker, which means you can set up the clip to run into a loop.
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Setting the Clip to Run Info a Loop.

The Loop Length and Position fields are equipped with Set buttons, which can be used to create
loops spontaneously during playback:

Playing the clip and then clicking the Set Loop Position button moves the beginning of loop to the
current playback position (rounded to the global quantization setting) and engages the loop.
Then, clicking the Set Loop Length button moves the end of the loop to the current playback po-
sition. This lets you capture the music in a loop on the fly.

While the loop is still off, you can click the Set Loop Length button to set the loop to end at the
current playback position without changing its preset length. This simultaneously activates loop-

ing.

The Set buttons, the Loop switch, the loop brace and the start/end markers can all be mapped
to MIDI controls (page 573). You could, for example, use a rotary encoder to move the loop
through a sample in increments the size of the chosen quantization interval.
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8.2.3  Clip Pitch and Gain

The Clip Pitch and Gain Controls.

The Transpose control shifts the clip pitch in semitones.
The Detune field fine-tunes the clip in cents (100 cents = one semitone).

The Clip Gain slider, calibrated in dB, changes the clip gain.

8.2.4  Destructive Sample Editing

The Launch Sample Editor Butfon.

The Edit button opens the sample in an external sample editing application, which you can spec-
ify in the File/Folder Preferences. To process a sample in an external program, you have to stop
Live's playback. When you return to Live, the edited version of the sample will be played back.
The current set of Warp Markers is retained only if the sample length remains the same as it did
prior to editing. Remember that changes made to one sample may affect other clips that play the
same sample.
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8.2.5  Saving Default Clip Settings with the Sample

The Save Default Clip Button.

The Save Default Clip button saves the current clip’s settings with the sample. With multiple clips
selected, this button will save them all simultaneously. Once saved, Live will restore the current
clip settings whenever you drop the sample into a Live Set. This is especially useful with regards
to the Warp Markers, which have to be set correctly for Live to play long files in sync. Note that
you can use the Save button without affecting any existing clips; Save just saves default settings
for future clips using this sample.

The clip data becomes part of the analysis file that accompanies the sample (page 73).

Note that storing default clip settings with the sample is different from saving the clip as a Live
Clip (page 82), which also saves devices and device settings.

8.2.6  High Quality Interpolation

The High Quality Switch.

If the High Quality switch is on, Live uses an advanced sample-rate conversion algorithm that
provides better sound quality at the expense of a higher CPU load. Samples processed with the
Hi-Q algorithm generate less distortion, particularly at high frequencies, when transposing a
sample and/or matching an imported sample’s sampling rate to the system’s sampling rate. With
this mode enabled, samples can be transposed roughly 19 semitones in either direction before
aliasing is likely to be audible.

Note: As of Live 7, the Hi-Q mode uses an algorithm that produces even smaller audible artifacts
than in previous versions. Although we think this has greatly improved sound quality, any Sets
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made in older versions that used Hi-Q mode may now sound different. For this reason, we have
provided a Legacy Hi-Q Mode option, which is enabled by default in the Options menu when-
ever you load an old Set that has Hi-Q enabled for any clips. Simply disable this option if you
wish to use the new mode.

8.2.7  Clip Start and End Fades

The Clip Fade Switch.

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to avoid
clicks at the clip edges. The length of the fade is signal-dependent and ranges from 0-4 millisec-
onds.

This switch is only available for clips in Session View. In Arrangement View, clip fades are ad-
justed via envelopes (page 110).

The Clip Fade switch is on by default for all new clips when the Create Fades on Clip Edges op-
tion is enabled in the Record/Warp/Launch Preferences.

Automatically Create Short Fades At Clip Edges.
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8.2.8  Clip RAM Mode

The RAM Mode Switch.

If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the com-
puter’s memory rather than reading it from disk in real time. RAM Mode can help with these
problems:

* Your computer’s hard disk is oo slow to deliver audio for as many tracks as desired in real
time. For more information on disk-related problems, please refer to Managing the Disk
Load (page 717).

* You are experiencing audio dropouts when playing clips in Legato Mode (page 204).

* Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using
the hard disk for swapping out RAM contents that have not been used in a while. The more
clips you are running in RAM Mode, the higher the likelihood for them to be swapped out.
Live can handle disk overloads more gracefully than swapped-out audio arriving late:
Disk overloads result in unwanted mutes, whereas RAM overload results in both mutes and
rhythmical “hiccups.”

8.2.9  Reversing Samples

The Reverse Button.

This function creates a new sample by reversing the sample referenced by the current clip. It then
reapplies the old clip’s settings (according to some rules that we will explain in a moment), and
replaces the original sample with the reversal in the Clip View. The new sample can be found,
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after saving the Live Set, in the Set’s Project folder, under Samples/Processed/Reverse. Until the
Set is saved, new samples remain at the location specified by the Temporary Folder.

There are a few rules for the reversing process. First, any Warp Markers will remain fixed to their
positions in the sample. This means that a Warp Marker on the downbeat of the second bar of

a clip will end up on the downbeat of the second-to-last bar after reversal. Clip loop/region
settings are similarly flipped. Second, clip envelopes remain fixed to their position in time. There-
fore, a mixer volume envelope that lowers the volume of the first half of a clip will continue to do
exactly that after reversal.

The reversal process is quite fast (about as fast as copying), but for very long samples it might
take a little time. When this is the case, the Status Bar in the lower portion of the Live screen

will give you a progress display, and further actions in the program will be temporarily locked
(though running clips will continue to play). You can play the reversed clip and perform other ac-
tions in the program as soon as Live begins to draw the new waveform into the Sample Display.
Once a sample is reversed, a link to the reversed sample will be maintained until you quit the
program, and reversing the same clip again (or a copy) will be instantaneous.

In the Arrangement View, it is possible to reverse a selection of material, even if it contains
multiple clips. To do this, select the range of time you want to reverse, and choose the Reverse
Clip(s) command from the clip's [right-click](PC) / [CTRL-click](Mac) context menu, or press the
[R] shortcut key.

It is not recommended that you reverse clips in a live performance situation, as a slight glitch can
sometimes occur while Live reapplies the warp and loop settings.

8.2.10 Cropping Audio Clips

The Sample Display's [right-click](PC) / [CTRL-click](Mac) context menu includes the Crop Sam-
ple command. This function creates, similarly to the Reverse function, a new sample by copy-

ing the one currently in use - but only the excerpt that is actually used. The new sample can be
found, after saving the Live Set, in the Set's Project folder, under Samples/Processed/Crop. Until
the Set is saved, the new sample remains at the location specified by the Temporary Folder.

8.2.11 Replacing and Editing the Sample

To replace the sample referenced by the clip with a different one, drop the new sample directly
from the browser into the Clip View. Clip settings like pitch and volume will be retained. The
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Warp Markers will be retained only if the new sample has the exact same length as the old
sample.

The Sample Display’s [right-click](PC) / [CTRL-click](Mac) context menu includes the Manage
Sample File command. This opens the File Manager for the current Set with the sample refer-
enced by the clip selected. From there, you can replace and destructively edit the sample (page
87), in such a way that all clips and instruments referencing the sample will be affected. You

can also use the Show in Browser command in the [right-click](PC) / [CTRL-click](Mac) context
menu to reveal the file in the browser.

8.3  The Notes Box

The Notes Box.

8.3.1 Transform Tools

The Notes Box Transform Tools.
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The Note Box's transform tools allow for fast manipulation of a MIDI clip’s contents. These con-
trols affect the selected notes or time range. If nothing is selected, they affect the whole clip.

¢ the Transpose slider transposes the selection. Type a number to transpose by semitones.
Type a note name to set the lowest note. Adding a “-” before the note name sets the highest
nofe.

* the :2 and *2 buttons double or halve the playback speed of the selection, respectively.

* Rev reverses the selection so that the last note swaps places with the first note.

* Inv flips the selection “upside-down” so that the highest note is swapped with the lowest
note.

* Legato lengthens (or shortens) each selected note so that it is just long enough to reach the
beginning of the next note.

* Dupl. Loop doubles the material within the loop brace (as well as the length of the loop
brace itself), zooming as necessary to show the entire loop. Any notes to the right of the

loop will be moved, so that they maintain their position relative to the end of the loop.

For a more detailed discussion of MIDI editing, see the chapter on this topic (page 171).

8.3.2  Bank and Program Change

The Notes Box Bank and Program Controls.

Live can send MIDI bank/program change messages to external devices and plug-ins that sup-
port MIDI program change messages. According to the settings in these controls, launching a
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clip also sends its bank/program change message. If you are using Live to send MIDI to your
synth, this means that each MIDI clip in your Live Set can play a different sound on your synth.
Live offers messages for 128 banks with 128 sub-banks, each of which has 128 programs.
Please see the documentation that came with your synthesizer to determine how many of these
messages it can use. If you do not want your clip to send program or bank change messages,

"

simply set the bank/program choosers to “---.

8.3.3  MIDI Loop/Region

The Notes Box Clip Start/End and loop Controls.

These controls manage how the contents of a MIDI clip are played and shown in the MIDI Edi-
tor. They work the same way as those for audio clips (page 138).

In the MIDI Editor, the zoom/scroll area is located above the beat-time ruler, the scrub area just
below.

8.4  Clip Defaults and Update Rate

You can change the rate at which Live applies your Clip View settings to a running clip. Clip
View changes will be quantized by the rate selected from the Clip Update Rate chooser in the
Record/Warp/Launch Preferences. Certain clip settings, such as Launch Mode and Warp
Mode, can be set up as defaults for all new clips. This is also done in the Record/Warp/Launch
Preferences.
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Chapter @

Audio Clips, Tempo, and
Warping

Unlike music stored on tape or in a traditional digital audio workstation, the music in Live remains
“elastic” at all times. Live is capable of time-warping samples while streaming them from disk so
as to synchronize them to the current Live Set’s tempo. This happens without affecting the pitch,
which can be changed independently. Mixing and matching audio from different origins is
therefore extremely easy.

9.1 Tempo

9.1.1  Setting the Tempo

Tap §1200.00 |0l [l 4 / 4 | O® ~ None ~

The Control Bar's Tempo Field.

The Control Bar’s Tempo field allows you to change the playback tempo of your Live Set at any
time, in real time. You can even automate the tempo (page 311) to create smooth or sudden
tempo changes along the song timeline. For maximum tempo control during performance, you
can MIDI map (page 573) separate controllers to the Tempo field on both sides of the decimal
point. Setting one knob to control coarse tempo in BPM and another to control fine tempo in
hundredths of a BPM allows for enough precision to adjust to live performers or other unsynchro-
nized sources.
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You can have an external sequencer (or drum machine) play along with Live or have Live play
along with the sequencer. The respective settings are made in the Link/MIDI Preferences. Please
refer to the chapter on synchronization (page 705) for details.

9.1.2  Tapping the Tempo
110.00 (M1 I} 4 / 4 | O® ~ 1Bar ~

The Tap Button.

You can use Live's Tap Tempo function to set the tempo at any time. As you click the Control Bar’s
Tap Tempo button once every beat, the tempo of the Live Set will follow your tapping.

LM] MIDI| 0% |D

The Key Map Mode Switch.

You can also assign the Tap button to a computer key instead of using the mouse. Click on the
Control Bar’s KEY switch to enter Key Map Mode; then select the Tap button; press the key you
would like to use for tapping; click the KEY switch again to leave Key Map Mode. The assign-
ment will take effect immediately. The Tap button can also be assigned to a MIDI note or control-
ler, like a foot switch, in a similar fashion. Although Live responds to your tapping immediately,

it does apply some degree of inertia to prevent sluggish behavior in the software. The more taps
Live receives in a row, the more precisely it will be able to conclude the desired tempo.

If the “Start Playback with Tap Tempo” button is enabled in Live's Record/Warp/Launch Prefer-
ences, you can also use tapping to count in: If you are working in a 4:4 signature, it takes four
taps to start song playback at the tapped tempo. Starting playback of Live's transport by tapping
the tempo will automatically adjust the playback position of any apps that are connected via
Ableton Link (page 705). This ensures that those apps remain tempo synced, and also at the
correct position in the musical phrase.
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9.1.3  Nudging the Tempo

Tap 110.00 4 / 4| 0@ v 1Bar ~

The Phase Nudge Up/Down Butfons.

Although Live can be easily synchronized via Link or to external MIDI devices (page 705), you
may find yourself in situations in which you need to adjust to sources that aren’t locked to one
tempo, such as live musicians or turntables. As long as your Set’s tempo is basically the same as
that of the unsynchronized material, you can use the Phase Nudge Up/Down buttons to tempo-
rarily speed up or slow down Live’s playback to match what you hear. As with the Tap button,
these buttons are much easier to use when mapped to MIDI controllers.

9.2 Time-Warping Samples

Live's ability to play any sample in sync with a chosen tempo is a unique and important feature.
In addition, you can “warp” the rhythmic flow of a piece, changing its “feel,” or even move notes
to other meter positions.

An audio clip’s warping properties are set in the Sample box (page 137), which is a sub-
section of the Clip View.

The Sample Box's Warping Controls.
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The most significant control here is the Warp switch, which toggles an audio clip’s warping on or
off. The Warp section of Live's Preferences will determine the default warp settings for new clips,
but they can always be overridden here on a per-clip basis.

When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irrespective
of the current Live Set’s tempo. This is useful for samples that have no inherent rhythmic structure:
percussion hits, atmospheres, sound effects, spoken word and the like. Turn the Warp switch on
to play rhythmically structured samples (such as sample loops, music recordings, complete music
pieces, efc.) in sync with the current song tempo.

To direct Live's assumptions about new samples, use the Record/Warp/Launch tab of Live's
Preferences. If the Auto-Warp Long Samples preference is on, Live assumes that long samples
contain music that should be played in sync with the Live Set’s tempo. If you would rather have
Live default to playing long samples as they are, disengage this preference.

9.2.1 Tempo Master/Slave

All warped clips in the Arrangement View have one further option: They can be defined as tem-
po masters by toggling their Master/Slave switches. Any number of clips can be set as tempo
masters, but only one clip at a time can actually be the tempo master. This distinction is always
granted to the bottom-most, currently playing clip in the Arrangement View.

The clip that is the current tempo master will play as if warping was off, but with one important
difference — the rest of the Live Set will be warped so that it plays in sync with the current tempo

master.

This is achieved by adding tempo automation to the Master track for the duration of the tempo
master clip. You will notice that the Tempo field in Live's Control Bar becomes disabled in this
state; this is because all tempo control is handed over to the tempo master clip.

When toggling a clip’s Master/Slave switch, or when deleting a clip that was set as tempo
master, the Master track tempo automation is removed again, restoring the proper tempo to the
region. If you wish instead to keep the generated tempo automation to continue working with it,
then [right-click](PC) / [CTRL-click](Mac) on the Control Bar’s Tempo field, and choose the Un-
slave Tempo Automation command. All clips will then be set to Slave, but the tempo automation
will remain in place.

Note that when Live's EXT switch is enabled (page 708), the Master/Slave switch has no effect
and appears disabled).
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9.2.2  Warp Markers

Think of a sample as a rubber-band that you want to pin to a (musical time) ruler. In Live, the
pins are called Warp Markers. A Warp Marker locks a specific point in the sample to a specific
place in the measure. You can use any number of Warp Markers to create an arbitrary mapping
of the piece’s inherent rhythm to a musical meter.

Warp Markers are set in the Clip View’s Sample Display by double-clicking in the upper half of
the sample. They can then be dragged or moved with the arrow keys to different points in time.
Warp Markers can also be deleted by double-clicking them, or by pressing the computer key-
board’s [Backspace] or [Delete] key after selecting them.

Double-Clicking In the Sample Creates a Warp Marker.

When working with your clip, you can have Live scroll the Sample Display to follow playback.
Use the Control Bar's Follow switch to activate this feature. (Note that Follow will pause if you
make an edit in the Sample Editor. Follow will start again once you stop or restart playback, or
click in the Arrangement or clip scrub area.)

It also might be helpful to vertically resize the Sample Display by dragging on the split line be-
tween the Clip View and the Session View track area.

The Follow Switch in the Control Bar.

Transients and Pseudo Warp Markers

When you first load a sample into Live, Live automatically analyzes the audio and finds its
transients. These are the points in the audio where notes or events begin, and are usually good
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places to put Warp Markers. Transients appear as small markers at the top of the sample display
after zooming in.

1/3

Transient Markers.

As you mouse over transients, temporary “pseudo” Warp Markers appear. These have the
same shape as regular Warp Markers, but they're gray. Double-clicking or dragging a pseudo
Warp Marker creates an actual Warp Marker or, if there are no Warp Markers later in the clip,
changes the tempo for the clip segment. Holding the [CTRL](PC) / [CMD](Mac) modifier while
creating a Warp Marker on a transient also creates Warp Markers at the adjacent transients.
Holding the [Shift] modifier while clicking on a pseudo Warp Marker allows you to drag the
transient to a new position. Once a Warp Marker has been created, holding [Shift] while drag-
ging the Warp Marker will move the waveform beneath the marker, rather than the marker itself.

You can also select a range of time and create Warp Markers at all of the transients within the
range via the Create menu's “Insert Warp Markers” command. If there are no transients within
your time selection, a Warp Marker will be created at the end of the selection.

Although Live usually does a good job of placing transients in the right places, you can delete
and create transients as well, via the corresponding commands in the Create menu.

Saving Warp Markers

Your Warp Markers will automatically be saved with the Live Set, but you may also want to save
them with the sample file itself, so that they are reconstructed anytime you drag the file into Live.
To do this, click the Clip View's Save button (page 145).

Note that if a sample has a saved set of Warp Markers (page 73), Auto-Warp will have no
effect. When this is the case, you can use any of the [right-click](PC) / [CTRL-click](Mac) context
menu commands described in this section to initiate auto-warping.
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9.2.3  Using Warp Markers

In the following sections, we will look at a couple of applications for time-warping samples.
Warping is, of course, an optional property of clips.

Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in length,
Live usually makes the correct assumptions to play the loop in sync with the chosen tempo. It cre-
ates two Warp Markers, one at the sample’s beginning and one at the end.

A Two-Bar Loop as It Appears in the Clip View, by Default.

The Seg. BPM field displays Live's guess of the loop’s tempo; if you happen to know the tempo of
the loop, you can type it in here. Sometimes Live's guess of the original tempo is wrong by half or
double. If so, correct this by clicking on the buttons labeled *2 and :2, respectively. The sample
plays at double speed when you press :2 because you are changing Live's interpretation of the
sample’s tempo, which serves as a point of reference for determining the required time-stretch
factor.

Note that it's possible to fine-tune the Seg. BPM value by:
* adjusting its slider control in the Sample Box

* or, in the Arrangement, holding [Shiff] while dragging a clip’s edge
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Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it out of sync.
Suppose there is a portion of silence at the sample beginning, prior to the first beat. You can
easily correct this by placing a Warp Marker at the beginning of the audio and dragging it so
that it lines up with the beginning of bar one in the timeline. Likewise, you can eliminate silence
after the actual loop end by placing a Warp Marker at the sample’s right edge.

Setting the Warp Markers for a Poorly Cut Loop.

Syncing Odd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is eight
bars long (or four, depending on its length) and plays it out of sync. For correct playback, the
marker at the end of the sample needs to be at the beginning of bar eight, not bar nine. To fix
this, simply drag the ending marker to the correct position.

If Live's initial guess had been a four-bar loop, the eighth bar may not initially be visible. In that
case, you can drag the Warp Marker at the end toward the right until the eight becomes visible.

Manipulating Grooves

You can now create any number of Warp Markers by double-clicking within the clip or on tran-
sient locations. Drag in a “straight” looped sample, set a few Warp Markers, and move them
around to see what happens. Warp Markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;
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2. to mess up the flow of time in the sample.

If a single event in a percussive audio loop comes late, just pin a Warp Marker to it and drag the
marker to the correct beat position. You may want to pin the adjacent events as well, to avoid
affecting neighboring regions in the sample.

Using Warp Markers to Manipulate the Groove.

“Removing” a sample’s natural groove by applying Warp Markers is an interesting creative
method, particularly in conjunction with Live’s ability to impose an artificial groove onto clips in
real-time (page 195).

Syncing Longer Pieces

Live's Auto-Warp algorithm makes longer samples and entire songs readily available for in-
tegration into your project. You can use the browser or the Create menu’s Import Audio File...
command to import long samples or MP3, AAC, Ogg Vorbis, Ogg FLAC and FLAC files. (Please
note that not all of these file formats can be played in the Intro and Lite Editions.)

Note that when using the Import Audio File... command in the Arrangement View, the file will be
inserted at the Insert Marker position. When using the command in the Session View, the file will
be inserted in the currently selected clip slot.

When you drag an audio file into Live that is too long to justify the assumption that it is a loop or
a one-shot, Live will auto-warp the clip by default (though this can be changed in the Record/
Warp/Launch Preferences).
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Note that, for the auto-warp mechanism to work, files which are being imported into the pro-
gram for the first time will need to undergo a first-time analysis process and will not be immedi-
ately available for playing or editing.

Auto-Warp's Results in the Clip View.

As long as Auto-Warp made the correct set of informed guesses, the clip will be ready to play
in perfect sync with the Live Set's tempo. However, if Auto-Warp does not quite do what you
want, you can control its results. The remainder of this section will focus on various ways of guid-
ing Live's auto-warping. Remember that the metronome in the Control Bar will probably come in
handy as you warp longer pieces.

Tap | 110.00 [ W11} 4 7 4 1Bar -

The Metronome Switch.

It might happen that Auto-Warp guesses the tempo correctly but gets the downbeat wrong. To
remedy this, you can do one of the following:

* Hold the [Shift] key while dragging the first Warp Marker. This will allow you to adjust the
position of the waveform under the Warp Marker.

* Zoom in and create a Warp Marker on the downbeat. Then drag it to the beginning of bar
1 in the timeline;

* Use the start marker’s [right-click](PC) / [CTRL-click](Mac) context menu to select the Set
1.1.1 Here command.
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Crop Sample
Manage Sample File
in Browser

in Finder

Set 1.1.1 Here

Warp From Here

Warp From Here (Start at 110.00 BPM)
Warp From Here (Straight)

Warp 110.00 BPM From Here

Warp Sample as 128-Bar Loop

Adaptive Grid:

Using the Context Menu to Direct Auto-Warp.

Directing Auto-Warp is also relatively simple when you have imported a perfectly cut loop. You
can tell Auto-Warp to work accordingly using the Warp Sample As ...-Bar/Beat Loop com-
mand. Live will propose a loop length that makes the most sense given the current Live Set's
tempo. Decreasing the Live Set's tempo can, for instance, lead Live to assume the loop is 8 bars

at 90 BPM instead of 16 bars at 180 BPM.

You can also direct Auto-Warp to work on a selected portion of a sample. This is useful if, for
example, you'd like to warp and loop an isolated breakbeat from a full song. To do this, first
drag in the background of the sample editor to select the part of the sample you'd like to warp.
Then use the Warp Selection As ...-Bar/Beat Loop command. Live will make its best guess about
the correct loop length, set the loop markers to match, and then warp the selection so that it fits

in this time.

Warp From Here

Warp From Here (Start at 110.00 BPM)
p From Here (Straight)

Warp 110.00 BPM From Here

Warp Selection as 2-Bar Loop

Adaptive Grid:

Warping a Selected Portion of a Sample.

Sometimes more accurate control of Auto-Warp is necessary. The best way to go about warping
a clip that requires more detailed attention is in sections, working gradually from left to right. You
can set a Warp Marker by double-clicking in the sample to the right of each correctly warped
section, “pinning” it into place. The shortcuts for working with the clip loop brace and start/end

markers can speed up this process considerably (page 138).
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You might also find it helpful to select multiple Warp Markers for moving by selecting them with
the [Shift] or [CTRL](PC) / [CMD](Mac) modifiers held down.

The four Warp From Here commands provide various ways of resetting Warp Markers to the
right of the selected grid marker or Warp Marker, leaving Warp Markers to the left untouched.
These commands are also available from the start marker.

* Warp From Here runs the Auto-Warp algorithm on the material to the right of the selected
marker.

* Warp From Here (Start At ...) directs Auto-Warp to use the current Live Set’s tempo as a
starting point for tempo tracking. The strategy here is as follows:

1. Deactivate the Warp switch for the clip so that it plays unwarped;

2. Use the Control Bar’s Tap Tempo button to tap along, thereby setting the Live Set's tempo
to match that of the clip;

Turn warping on again and use the Warp From Here (Start At ...) command to tell Auto-Warp to
use your tapped tempo as a reference.

* Warp From Here (Straight) tells Auto-Warp that this is a clip with no tempo variations
(common in electronically produced works). Auto-Warp will then set a single Warp Marker
derived from its guess of the file’s original tempo.

* Warp ... BPM From Here will also set a single Warp Marker, but in this case, Auto-Warp is
forced to interpret the clip as exactly matching the Live Set’s tempo. This is useful in cases
when you happen to know the exact BPM value of an electronically-produced work and
can type it into the Control Bar before warping.

Multi-Clip Warping

When clips of equal length are multi-selected, adding or changing Warp Markers for one clip
will apply identical Warp Markers to all. This is convenient in any situation where several tracks
have the same rhythm, and you wish to alter the timing of each recording in the same way. A
common scenario would be when multi-tracking a band’s performance, where the musicians all
play in time with each other, yet the timing itself is in some way flawed.
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9.2.4  Quantizing Audio

In the previous section, you learned how to adjust the timing of events in audio files by manu-
ally dragging Warp Markers along the timeline. But it is also possible to automatically snap the
entire sample to the grid at once by using the Quantize command. To do this, click in the back-
ground of the sample editor and choose the Quantize command from the Edit menu, or use the
[CTRL](PC) / [CMD](Mac) hotkey. This will quantize using default settings, or the settings that
you previously applied.

To adjust your quantization parameters, open the Quantization Settings dialog from the Edit

menu.

Quantizing Audio Samples.

Using the options presented here, you can select either the current grid size or a specific meter
value for quantization. You can also quantize without that “quantized” feel by adjusting the
Amount control, which will move Warp Markers by a percentage of the set quantization value.

9.3  Adjusting for Good Stretching Quality

Live offers a number of time-stretching modes to accommodate all sorts of audio material. Each
clip’s time-stretching mode and associated parameters are set in the Clip View’s Sample Box.

The warp modes are different varieties of granular resynthesis techniques. Granular resynthesis
achieves time compression and expansion by repeating and skipping over parts of the sample
(the “grains”). The warp modes differ in the selection of grains, as well as in the details of over-
lapping and crossfading between grains.
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Let's investigate which warp modes work best for different types of signals and how to adjust the
warping controls for “clean” stretching. It's also fun to “misuse” these controls to achieve interest-
ing artifacts instead of accurate stretching.

9.3.1 Beats Mode

Beats Mode works best for material where rhythm is dominant (e.g., drum loops as well as most
pieces of electronic dance music). The granulation process is optimized to preserve transients in
the audio material.

Use the Preserve control to preserve divisions in the sample as boundaries when warping. For
the most accurate results, particularly with percussive material, choose Transients. This setting
uses the positions of the analyzed (or user-created) transients to determine warping behavior. To
preserve specific beat divisions regardless of the sample’s contents, choose one of the fixed note
values. For some interesting rhythmic artifacts, choose large note values in conjunction with pitch
transposition.

The Transient Loop Mode chooser sets the looping properties for the clip’s transients:

Loop Off — Each segment of audio between transients plays to its end and then stops. Any
remaining time between the end of a segment and the next transient will be silent.

Loop Forward — Each segment of audio between transients plays to its end. Playback then
jumps back to a zero-crossing near the middle of the segment and continues looping until the
time when the next transient occurs.

Loop Back-and-Forth — Each segment of audio between transients plays to its end. Play-
back then reverses until it reaches a zero-crossing near the middle of the segment, and then
proceeds again towards the end of the segment. This pattern continues until the time when the
next transient occurs. This mode, in conjunction with the Preserve Transients selection, can often
result in very good quality at slower tempos.

The Transient Envelope slider applies a volume fade to each segment of audio. At 100, there is
no fade. At O, each segment decays very quickly. Long envelope times can help to smooth clicks
at the end of segments, while short times can be used to apply rhythmic gating effects.
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9.3.2 Tones Mode

Tones Mode serves well for stretching material with a more or less clear pitch structure, such as
vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain size is
determined in a signal-dependent manner. For signals with a clear sense of pitch contour, a
small grain size works best. Larger grain sizes help avoid artifacts that can occur when the pitch
contour is unclear, but the trade-off can be audible repetitions.

9.3.3  Texture Mode

Texture Mode works well for sound textures with an ambiguous pitch contour (e.g., polyphonic
orchestral music, noise, atmospheric pads, etc.). It also offers rich potential for manipulating all
kinds of sounds in a creative way.

The Grain Size control determines the grain size used, but unlike in Tones Mode, this is a setting
that Live will use unaltered, without considering the signal’s characteristics.

Fluctuation introduces randomness into the process. Larger values give more randomness.

9.3.4  Re-Pitch Mode

In Re-Pitch Mode, Live doesn't really time-stretch or compress the music; instead, it adjusts the
playback rate to create the desired amount of stretching. In other words, to speed up playback
by a factor of 2, it's transposed up an octave. This is like the “DJ stretching method” of using
variable-speed turntables to sync two records, or what happens to samples in traditional sam-
plers when they're transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.

9.3.5 Complex Mode

Complex Mode is a warping method specifically designed to accommodate composite signals
that combine the characteristics covered by other Warp Modes; it works well for warping entire
songs, which usually contain beats, tones and textures.
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Complex Mode is a rather CPU-intensive function, using approximately ten times the CPU
resources required by the other Warp Modes. As such, you may want to freeze tracks (page
715) where Complex Mode is used or record (page 245) the results as a new clip to use as
a substitute.

Please note that Complex Mode is not available in the Intro and Lite Editions.

9.3.6 Complex Pro Mode

Complex Pro Mode uses a variation of the algorithm found in Complex mode, and may offer
even better results (although with an increase in CPU usage.) Like Complex Mode, Complex Pro
works especially well with polyphonic textures or whole songs.

The Formants slider adjusts the extent to which the formants of the sample are compensated
when transposing. At 100%, the original formants will be preserved, which allows for large
changes in transposition while maintaining the sample’s original tonal quality. Note that this
slider has no effect if the sample is played back untransposed.

The Envelope slider also influences the spectral characteristics of the material. The default setting
of 128 should work well for most audio. For very high-pitched samples, you may have better
results with lower Envelope values. Likewise, low-pitched material may sound better with higher

values.

Please note that Complex Pro Mode is not available in the Intro and Lite Editions.

9.3.7 REX Mode

REX Mode differs from the other Warp modes in several ways. Most notably, it is not available
as an option in the Clip View's Sample Box, but is instead enabled automatically when loading
a file in REX format. REX files, associated with the program ReCycle by Propellerhead Software,
contain embedded tempo and timing information and will synchronize to your Set's tempo just
like any other audio file.

Although REX files are audio files, they can quickly be transformed into playable instruments via
the Slice to New MIDI Track command (page 189), which is available in the Create Menu or
the [right-click](PC) / [CTRL-click](Mac) context menu for the clip.

Warp Markers/parameters, Clip Envelopes (page 313) that affect warping properties, and
the Clip Nudge (page 136) controls are not available for REX files.
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Please note that REX file support is not available in the Intro and Lite Editions.
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Chapter 10

Editing MIDI Notes and
Velocities

A MIDI clip in Live contains notes and controller data for playing a MIDI instrument. This instru-
ment can be a virtual instrument in a MIDI track’s device chain (page 259) or an external synth
fed via the track’s output routing (page 211). The MIDI clip (page 48) provides the device

with a musical score to play, specifying note pitch, length, position and dynamics (referred to as
velocity in the MIDI lexicon). MIDI is composed and edited in Live's MIDI Editor.

10.1  Creating an Empty MIDI Clip

MIDI clips are created
* by means of recording (page 245);
* or by capturing MIDI (page 257);
* or by double-clicking an empty Session slot in a MIDI track;

* or by selecting an empty Session slot in a MIDI track and choosing the Create menu's In-
sert MIDI Clip(s) command;

* or by double-clicking on the track display of a MIDI track in the Arrangement View;

* or, in the Arrangement View, by selecting a timespan in a MIDI track and choosing the
Create menu's Insert MIDI Clip(s) command.
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10.2 The MIDI Editor

To bring up the MIDI Editor, double-click a MIDI clip to open the Clip View. You can use the Clip
View Box selector to make sure the Notes box (page 149) is showing, then click in the title bar
of the Notes box to bring up the MIDI Editor on the right-hand side of the screen.

The MIDI Editor.

The MIDI Editor is divided into two editing windows: the upper Note Editor and the lower Veloc-
ity Editor. You can resize the Velocity Editor by dragging on the split line that runs between it and
the Note Editor. You can also show and hide the Velocity Editor using the triangular button on
the left-hand side of the split line.

|]]] Key - MIDI| 8% | D

The Control Bar's Draw Mode Switch.

Switch to Draw Mode by activating the Control Bar’s Draw Mode switch or by pressing the

[B] key. You can now draw MIDI notes into the Note Editor with the mouse. Deactivating Draw
Mode allows notes to be selected and moved around via clipboard operations or by clicking
and dragging, either vertically to change their transposition, or horizontally to change their po-
sition in time. MIDI notes can also be added and deleted by double-clicking when Draw Mode
is inactive.
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Previewing MIDI Notes.

Provided your MIDI track’s device chain contains an instrument (page 259), activating the
Preview switch in the MIDI Editor allows you to hear notes as you select and move them. If the
MIDl track is armed, activating Preview also allows you to step record (page 251) new notes
into the clip. Note that the Preview switch’s on/off state applies to all MIDI tracks in the Live Set.

Note velocity is adjusted in the Velocity Editor, by clicking and dragging on the associated
markers. You can also use Draw Mode in the Velocity Editor: It will draw identical velocities for

all notes within a grid “tile.”

After drawing a few notes and moving them around, you will probably want to know how to get
around in the Note Editor. So, before we get into detailed editing information, we will first ex-
plain MIDI Editor navigation.
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10.3 MIDI Editor Navigation and Transport

Note Scale Position Is Shown Vertically and Beat-Time Horizontally.

The MIDI Editor has both vertical and horizontal navigation. Along the horizontal axis lies a
time ruler, which shows note position along a musical timeline. The vertical axis contains the note
ruler, displaying octaves C-2-C8, and a representation of a piano keyboard (the piano roll).
Note that if the Preview switch at the top of the piano roll is activated, you can listen to the results
of your piano roll playing.

MIDI Editor Navigation.

1. To smoothly change the time-zoom level, click and drag vertically in the time ruler. Drag
horizontally in the time ruler to scroll from left to right.
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2. Click and drag vertically in the note ruler to change which octaves are shown, or drag
horizontally to change the vertical zoom size of MIDI notes and the keyboard.

3. Click and drag over one or more notes to select them, or over a portion of the editor’s
background to select a range of time. Then, double-click on the note ruler or time ruler to
automatically zoom in on your selection. If nothing is selected, double-clicking the note
ruler will zoom in on the area from the lowest to the highest note in the clip, while double-
clicking the time ruler will zoom out to show the time between the first and last note.

4.To zoom in and out around the current selection, use the computer keyboard'’s [+] and [-]
keys.

5. The Clip Overview just beneath the MIDI Editor can also be used for navigation. It always
shows the complete contents of the selected MIDI clip. The black rectangular outline repre-
sents the part of the clip that is currently displayed in the Editor above. To scroll, click within
the outline and drag left or right; to zoom in and out, drag up and down.

6. Change the length of what is shown in the Editor by dragging the left or right edges of the
outline in the Clip Overview.

7. To quickly change what is shown in the Editor, click on a section that you want to examine
in the Clip Overview, then drag downwards to zoom in, or scroll by dragging left and
right.

453.4.2 b HO® +- ilo

The Control Bar’s Follow Switch.

The area displayed in the Note Editor can be set to scroll with playback using the Follow switch
from the Control Bar. Follow will pause if you make an edit in the Note Editor, and will start
again once you stop or restart playback, or click in the Arrangement or clip scrub area.

When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking in the scrub
area below the beat-time ruler starts playback from that point, rounded by the global quantiza-
tion setting. (Tip: activating the Options menu’s Chase MIDI Notes command allows MIDI notes
to play back even if playback begins after the MIDI note’s start time.)

When the Permanent Scrub Areas preference is off, you can still scrub by [Shift]-clicking any-
where in the scrub area or in the beat-time ruler. Learning about the loop/region controls (page
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151) and associated shortcuts can also be helpful in getting around in the MIDI Editor and

playing selections quickly and easily.

As you work with MIDI, you may find yourself needing extra screen space. You can click and
drag vertically on the window split between the Session or Arrangement View and the Clip View

to enlarge the MIDI Editor.

Enlarge the MIDI Editor by Dragging the Window Split Between Session and Clip Views.

10.4 Editing MIDI

10.4.1 Non-Destructive Editing

You can always return your MIDI clip to its previous state by using the Edit menu’s Undo com-
mand. Furthermore, if the MIDI clip being edited originated in a MIDI file on your hard drive,
none of your editing will alter the original MIDI file, as Live incorporates its contents into your

Live Set when importing.

10.4.2 Folding and Looping

An important feature of the MIDI Editor is the Fold button, located in the upper left corner. Acti-
vating this button will immediately hide all rows, or key tracks, that do not contain MIDI notes in
each MIDI clip. This means that the available key tracks in each clip in your Set will differ, de-

pending on which notes exist in that clip.
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This is very useful when working with percussion kits, for example, which are oftentimes mapped
out along a keyboard in sections corresponding to percussion type (e.g., snares grouped to-
gether two octaves down from hi-hat cymbals, etc.). When working with a MIDI file created by
such a mapping, sometimes only one or two of each type of percussion sound is used, and it
becomes unnecessary to view the entire keyboard range. (Note: folding the Note Editor is not
possible when editing multiple clips (page 185).)

The Fold Button Extracts Key Tracks Containing Notes.

When editing MIDI, you might find that you want to change which part of the clip you are listen-
ing to, or loop the clip in order to listen to it repeatedly. You can use the loop/region markers
(page 138) for this.

Use the Lloop,/Region Markers to Select a Specific Region of the Clip to Play.

If Fold is deactivated on a track containing a Drum Rack (page 292), the MIDI Note Editor
only shows rows with notes corresponding to a pad with devices on it. If Fold is activated, only
rows containing notes are displayed.

Tip: Selecting the loop brace in a MIDI clip and pressing [CTRL][D](PC) / [CMD][D](Mac) dou-
bles the length of the loop brace and zooms as necessary to show the entire loop. Any notes to
the right of the loop will be moved, so that they maintain their position relative to the end of the
loop.
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10.4.3 Grid Snapping

Most functions in the MIDI Editor are subject to grid snapping (page 114). But when adjusting
events with the mouse, the grid is “magnetic”; event positions can be moved freely up to the pre-
vious or next grid line and then will snap if you continue to drag. You can hold down the [ALT]
(PC) / [CMD](Mac) modifier while performing an action to bypass grid snapping.

Note movements will also snap to an “offset,” which is based on the original placement of the
note relative to the grid. This is useful for preserving a groove or loose playing style that you do
not necessarily want to “set straight.”

10.4.4 Editing Notes

Editing in the MIDI Editor is similar to editing in the Arrangement (page 113). In both cases,
your actions are selection-based: you select something using the mouse, then execute a menu
command (e.g., Cut, Copy, Paste, Duplicate) on the selection.

Here is how selection works:

* Clicking a note selects the note. Multiple notes can be selected in unison: “rubber-band”
select more than one note with one mouse motion by clicking in empty space, then drag-
ging to enclose the notes in the dotted line that appears. [Esc] deselects all selected notes.

* Clicking into the background of the MIDI Editor selects a point in time, represented by a
flashing insert marker.

¢ Clicking and dragging in the background selects a timespan. Press [Enter] to toggle the
selection between the timespan and any notes that begin within it.

After placing the insert marker, you can manipulate it using your computer keyboard.

* Press the left or right arrow keys to move the insert marker to the left or right, according to
the grid settings. [CTRL](PC) / [ALT](Mac) plus the left or right arrow keys moves the insert
marker to the next note boundary.

* Hold down [Shiff] while pressing the arrow keys to extend or retract the selected timespan
by moving the insert marker. [ALT](PC) / [ALT](Mac) plus [Shift] while pressing the arrow
keys extends or retracts from the opposite side of the selection.

* The insert marker can be moved to the beginning or end of a MIDI clip by pressing the
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[Home] or [End] key, respectively.

As we have seen, notes in the MIDI Editor can be moved both horizontally (changing their posi-
tion in time) and vertically (changing their transposition). They can be moved either by clicking
and dragging, or with the arrow keys on your computer keyboard. Notes moved with the arrow
keys are always subject to grid and offset snapping, while notes dragged with the mouse can be
freely moved until reaching the previous or next grid or offset point. If you are playing the clip
while you edit notes, you can listen to them play in their new assignments as you change them.

Several key modifiers also apply to note editing:

* To transpose selected notes by octave, hold down [Shift] while pressing the up or down
arrow keys.

* [Shift] plus the left or right arrow keys extends or retracts the duration of selected notes,
according to the grid settings. To extend or retract notes without snapping to the grid, also

hold [ALT](PC) / [CMD](Mac).

* To change the selection to the next note in the same key track, hold [CTRL](PC) / [ALT]
(Mac) while pressing the left or right arrow keys. [CTRL](PC) / [ALT](Mac) plus the up or
down arrow keys moves the selection to the next note in time.

* To nudge notes without snapping to the grid, hold [ALT](PC) / [CMD](Mac) and press the
left or right arrow keys.

* You can use the [Shift] modifier to click and add individual notes or additional “rubber-
band” selections to your current selection. You can also remove a single note from your
selection by holding down [Shift] and clicking on it. Holding [Shift] and clicking on the
piano roll adds all notes in a single key track to the current selection, or removes them if
they were already selected.

Selecting a note (or notes) makes it subject to commands from the Edit menu, such as Copy and
Paste. Notes in the clipboard will be pasted starting at the location of the insert marker. You
can also use the [CTRL](PC) / [ALT](Mac) modifier to click and drag copies of notes to a new
location. If you click and drag to move notes but then decide that you would like to copy them
instead, you can press the [CTRL](PC) / [ALT](Mac) modifier even after starting the drag.

When editing or drawing, you may sometimes place a new note on top of one that already ex-
ists. If the new note overlaps with the beginning of the original note, the original note will vanish.
If the new note overlaps with the “tail” of the original, the original note’s length will change so
that it lasts just until the new note’s beginning.
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10.4.5 Changing Note Length

Clicking and dragging on a note’s left or right edges changes its length. As with note positions,
note lengths can be adjusted freely up to the previous or next grid line but will be quantized

when dragging further unless the [ALT](PC) / [CMD](Mac) modifier is held down.

Changing Note Length.

Tip: To set a group of notes to the same length, select them all, grab the end of the longest one,
drag them all down to zero length and then extend them.

10.4.6 The ...Time Commands in the MIDI Editor

The standard clipboard commands like Cut, Copy and Paste only affect the currently selected
notes (or the notes within a time selection). But, as in Arrangement editing (page 115), there
are “... Time” commands that act upon the entire MIDI clip by inserting and deleting time.

Note that these operations do not change the clip start/end position or the loop brace settings.

* Duplicate Time places a copy of the selected timespan into the clip, along with any con-
tained notes.

¢ Delete Time deletes a selection of time from the MIDI clip, thereby moving any notes on
either side of the deleted area closer together in the timeline.

* Insert Time inserts as much empty time as is currently selected into the clip, before the se-
lection.

10.4.7 Quantizing Notes

There are three options for quantizing MIDI notes in Live. First, you can quantize MIDI notes as
you record them (page 254). Secondly, as previously mentioned, you can move notes so that
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they snap to the visible grid lines. Finally, you can select a note or notes and choose the Quan-
tize command from the Edit menu, or use the [CTRL][U](PC) / [CMD][U]{Mac) hotkey. The first

time you do this, you will see a dialog box with several quantization options. This will quantize
using default settings, or the settings that you previously applied.

To adjust your quantization parameters, open the Quantization Settings dialog from the Edit

menu.

Quantizing MIDI Notes.

Using the options presented here, you can select either the current grid size or a specific meter
value for quantization and set either the note start or end (or both) to be quantized. Quantizing
the note end will stretch the note so that it ends at the chosen meter subdivision. You can also
quantize notes without giving them that “quantized” feel using the Amount control, which will
move notes only by a percentage of the set quantization value.

10.4.8 Editing Velocities

To change velocity for a MIDI note, click and drag on the associated marker in the Velocity Edi-
tor. (To help you locate the velocity marker belonging to a MIDI note that may be stacked verti-
cally with others, Live highlights the velocity marker for whichever note your mouse is hovering
over.) Velocity changes will be shown numerically in a small display in the time ruler.
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Changing Note Velocity.

As in the Note Editor, you can select multiple velocity markers to change by clicking with the
[Shiff] modifier held down.

Tip: To set a group of notes so that they all have the same velocity, select their markers in the
Velocity Editor, drag them up or down to either maximum or minimum velocity, and then adjust
velocity to the desired value.

As we saw earlier, Draw Mode allows drawing identical velocities for all notes within a grid tile.
While in Draw Mode, velocity drawing is limited to only those notes that are currently selected.
To draw markers individually (as you would want to with a crescendo, for instance) deactivate
grid snapping with the [CTRL][4](PC) / [CMD][4](Mac) shortcut, or simply hold down the [ALT]
(PC) / [CMD](Mac) modifier.

Drawing Identical Velocities (Left] and a Crescendo (Right).

Tip: To draw a velocity ramp with notes that are all in the same key track, click a key in the piano
roll to select all notes within the desired key track. Make sure Draw Mode is activated and draw
the ramp into the Velocity Editor. This will affect only the selected notes.
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Tip #2: To draw a linear velocity ramp across a selection of notes, first select the notes that
should be affected (using the [Shift] modifier to select non-adjacent notes if necessary). Make
sure Draw Mode is not activated and draw the line into the Velocity Editor while holding the
[CTRL](PC) / [CMD](Mac) modifier.

Notes in the Note Editor display their velocity in their coloring — light notes play softly, and vice
versa. To change the velocity of notes without the Velocity Editor open, click any selected note

and drag vertically while pressing the [ALT](PC) / [CMD](Mac) modifier.

Vertical movements in Draw Mode correspond to velocity changes. This means that, with one
horizontal motion and one vertical motion, you can draw multiple notes and their velocities
without releasing the mouse button. If you change velocity with this vertical movement, Live will
remember the change and use your new velocity on any notes that you draw afterward.

Note-Off Velocity

By default, the Velocity Editor allows you to adjust note-on velocities. But you can toggle the
editor to show note-off velocities via options in the editor’s [right-click](PC) / [CTRL-click](Mac)
context menu.

The Velocity Editor Showing Note-Off Velocities.

Please note that note-off (or “release”) velocity is a somewhat esoteric parameter, and is only
supported by certain devices. Ableton’s Sampler instrument (page 488), for example, provides
note-off velocity as a controller for a variety of parameters.
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10.4.9 MIDI Note Stretch
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MIDI Note Stretch Markers.

When multiple notes or a range of time are selected in the Note Editor, Note Stretch markers
will appear, allowing notes to be scaled proportionally in time. The markers are a pair of down-
ward-pointing indicators that snap to the beginning and end of the selection.

By clicking and dragging one of the markers horizontally, the selected notes will move and
stretch so that they continue to occupy the same proportion of time that they did when they were
initially selected. As with notes, Note Stretch markers can be freely moved until reaching the pre-
vious or next grid or offset point, after which they will snap to the Note Editor’s grid lines unless
the grid is not shown or the [ALT](PC) / [CMD](Mac) modifier is held while dragging.

When the mouse is between the Note Stretch markers, a “pseudo” stretch marker will appear.
Dragging this stretches or compresses the material between the fixed markers without affecting
the material outside of them. The pseudo stretch marker has the same grid snapping behavior as
fixed markers.

When notes (but not time) are selected, one marker can be dragged beyond the boundary of
the other, which will “reflect” the order of the stretched notes in relation to their initial sequence;
this is sometimes referred to as “retrograde” behavior.

Adjusting the Note Stretch markers will also adjust the timing of any of the clip’s linked clip enve-
lopes. Unlinked clip envelopes are not affected.
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10.4.10 Cropping MIDI Clips

MIDI data that is outside of the loop brace can be deleted by means of the Crop Clip command.
Simply [right-click](PC) / [CTRL-click](Mac) on a MIDI clip in the Session or Arrangement View
and select this option. Unlike cropping audio clips (page 148), cropping a MIDI clip does not
create a new file on disk.

10.4.11 Deactivating Notes

To deactivate, or mute, a note (or notes) in the MIDI Editor, select it and press [0]. The Deacti-
vate Note(s) command will mute the note, making it appear gray in the display. Press [0] again
to reactivate notes. You can de- or reactivate all of the notes in a single key track at once by
clicking a key on the piano roll and pressing [0].

10.4.12 The Transform Tools

In addition to the editing possibilities within the MIDI Editor itself, the Notes Box's transform tools
(page 149) offer a number of ways to quickly manipulate the notes within a MIDI clip.

10.5 Muliti-Clip Editing

In the Note Editor, you can view notes in multiple MIDI clips at the same time. This helps you to
see melodic and rhythmic relationships between different clips when creating and refining musi-
cal ideas, and allows you to edit material across separate tracks and scenes more quickly.

When multiple MIDI clips are selected:

* The notes from these clips will be shown together in the Note Editor. Only one clip will be
active for editing at a time. The active clip’s notes will be shown in that clip’s color, while
the inactive clips’ notes will be shown in gray.

* Loop bars will appear above the Note Editor. Each loop bar represents a different clip in
the current selection. The active clip’s loop bar will be shown in the clip’s color, while the
inactive ones will be shown in grey.
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Multi-Clip Loop Bars in the Note Editor.

* Hovering the mouse over an inactive clip’s notes or loop bar will reveal that clip’s color,
helping you to choose a different clip in the current selection to edit. Clicking on a clip’s
note or loop bar switches to that clip for editing.

* The title bar will show the name of the clip selected for editing. This can be particularly
useful for identifying different clips with the same color. (Note: if a clip has no name, the
title bar will display the name of the track containing the clip instead.)

* You can edit the clips using the Clip Name, Clip Color and Clip Time Signature commands
in the Clip box (page 134).

Note: Folding (page 176) the Note Editor is not possible when editing multiple clips.

Multi-clip editing works differently depending on whether you are working in the Session or Ar-
rangement View. These differences are explained in more detail below.

10.5.1 Editing in the Session View

In the Session View, you can select and view up to eight looped MIDI clips at the same time. In
the Note Editor, loop bars are ordered vertically (first by track, and then by scene).

If multiple clips of different lengths are selected, the Note Editor will show as many loop itera-
tions as necessary for the clips to realign. Loop points are represented by black vertical lines in

the Note Editor. Clips with a start marker set before the loop start are represented by a bar at the
top of the Note Editor.
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While multi-clip editing is useful for looking at clips across different tracks, it can also come in
handy when you need to compare and edit multiple clips within the same track. For example,
you can create evolving pattern progressions by adding notes to a clip, then making a variation
to the clip in the following scene and so on, while maintaining an overview of the other clips in
the track.

10.5.2 Editing in the Arrangement View

In the Arrangement View, it is possible to select and view MIDI clips from up to eight tracks,
across a selection of time. In the Note Editor, loop bars are ordered vertically by track and hori-
zontally by time.

The Note Editor will not show silence before or after the selection of clips — instead, it will fit its
display range to show the beginning of the first clip up to the end of the last clip in the selection.
If the selection contains looped and unlooped clips, the Loop button will appear half colored.
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Chapter 11

Converting Audio to MIDI

(Note: the features discussed in this chapter are not available in the Intro and Lite Editions.)

Although Live's warping allows for audio files to be used much more flexibly than in traditional
audio software, there are also a number of ways to extract musical information from audio clips
and place it into MIDI clips, for additional creative possibilities.

When an audio clip is selected, four conversion commands are available in the Create Menu or
the [right-click](PC) / [CTRL-click](Mac) context menu for the clip.

Freeze Track

Crop Clip(s)

Slice to New MIDI Track

Convert Harmony to New MIDI Track
Convert Melody to New MIDI Track
Convert Drums to New MIDI Track

Remove Stop Button E

«/ Qalart an | atinech (Draf)

Context Menu Commands For Converting Audio To MIDI.

11.1  Slice to New MIDI Track

This command divides the audio into chunks which are assigned to single MIDI notes. Slicing
differs from the Convert commands below, in that it doesn’t analyze the musical context of your
original audio. Instead, it simply splits the original audio into portions of time, regardless of the
content. The Drum Rack (page 292) provides an ideal environment for working with sliced
files, and most of the setup happens automatically after you make a few choices:
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The Slicing Dialog.

When you select Slice to New MIDI track, you'll be presented with a dialog box. This offers a
list of slicing divisions, as well as a chooser to select the Slicing Preset. The top chooser allows
you to slice at a variety of beat resolutions or according to the clip’s transients or Warp Markers.
Since a Rack can contain a maximum of 128 chains, Live won't let you proceed if your choice
would result in more than 128 slices. You can fix this by either setting a lower slice resolution or
by selecting a smaller region of the clip to slice. If your audio file is in REX format (page 168),
the slicing will be based on the file's internal timing information and you won't see this chooser.

The Slicing Preset chooser contains a few Ableton-supplied slicing templates, as well as any of
your own that you may have placed in your User Library’s default presets folder (page 267).

With “Preserve warped timing” enabled, the clip will be sliced in such a way that timing altera-
tions as a result of warping are preserved. With this option disabled, any changes that result
from warping will not be reflected in the sliced clip; the sliced version will instead sound like the
original, “raw” audio.

Once you've made your slicing choices and clicked OK, a number of things will happen:

1. A new MIDI track will be created, containing a MIDI clip. The clip will contain one note for
each slice, arranged in a chromatic sequence.

2. A Drum Rack will be added to the newly created track, containing one chain per slice.
Each chain will be triggered by one of the notes from the clip, and will contain a Simpler
with the corresponding audio slice loaded.

3. The Drum Rack’s Macro Controls will be pre-assigned to useful parameters for the Sim-
plers, as determined by the settings in the selected slicing preset. In the factory Slicing
presets, these include basic envelope controls and parameters to adjust the loop and
crossfade properties of each slice. Adjusting one of these Macros will adjust the mapped
parameter in each Simpler simultaneously.
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Note: Live will take a few moments to process all of this information.

Playing the MIDI clip will trigger each chain in the Drum Rack in order, according to the timing
information that you specified or that was embedded in the audio. This opens up many new edit-
ing possibilities, including:

11.1.1  Resequencing Slices

Rearranging the Sliced MIDI Data.

By default, your sliced MIDI data will form a chromatically-ascending “staircase” pattern in or-
der to trigger the correct chains in their original order. But you can create new patterns by simply
editing the MIDI notes (page 176). You can achieve a similar effect by dragging the Drum
Rack’s pads onto each other to swap their note mappings.

11.1.2  Using Effects on Slices

Because each slice lives in its own chain in the Drum Rack, you can easily process individual slic-
es with their own audio effects. To process several slices with the same set of effects, multi-select
their chains in the Drum Rack’s chain list and press [CTRL][G](PC) / [CMD][G](Mac) to group

them to their own nested Rack. Then insert the effects after this new sub-Rack.

For even more creative possibilities, try inserting MIDI effects (page 423) before the Drum
Rack. The Arpeggiator and Random devices can yield particularly interesting results.
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Slicing is most commonly applied to drum loops, but there’s no reason to stop there. Experiment
with slicing audio from different sources, such as voices and ambient textures. The same sorts of
resequencing and reprocessing operations can be applied to anything you slice — sometimes
with unexpected results.

11.2  Convert Harmony to New MIDI Track

This command identifies the pitches in a polyphonic audio recording and places them into a clip
on a new MIDI track. The track comes preloaded with an Instrument Rack (page 281) that
plays a piano sound (which can, of course, be replaced by another instrument if you choose).

Note that this command, as with the other Convert commands, differs from slicing in that the
generated MIDI clip does not play the original sound, but instead extracts the notes and uses
them to play an entirely different sound.

The Convert Harmony command can work with music from your collection, but you can also get
great results by generating MIDI from audio recordings of yourself playing harmonic instruments
such as guitar or piano.

11.3 Convert Melody to New MIDI Track

This command identifies the pitches in monophonic audio and places them into a clip on a new

MIDI track.

The track comes preloaded with an Instrument Rack that plays a synthesizer sound. Using the
Rack’s “Synth to Piano” Macro, you can adjust the timbre of this sound between an analog-style
synth and an electric piano. The instrument was designed to be versatile enough to provide a
good preview, but can of course be replaced with another instrument if you choose.
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The Melody to MIDI Instrument Rack.

The Convert Melody command can work with music from your collection, but also allows you
to record yourself singing, whistling, or playing a solo instrument such as a guitar and use the
recording to generate MIDI notes.

11.4 Convert Drums to New MIDI Track

This command extracts the rhythms from unpitched, percussive audio and places them into a clip
on a new MIDI track. The command also attempts to identify kick, snare and hihat sounds and
places them into the new clip so that they play the appropriate sounds in the preloaded Drum
Rack. Any additional sounds (such as cymbals, toms, or other percussion) will be retained but
placed on a silent note lane for manual editing.

As with the Convert Melody command, you can adjust the transient markers in the audio clip
prior fo conversion to determined where notes will be placed in the converted MIDI clip.

Convert Drums works well with recorded breakbeats, but also with your own recordings such as
beatboxing or tapping on a surface.

11.5 Optimizing for Better Conversion Quality

The Convert commands can generate interesting results when used on pre-existing recordings
from your collection, but also when used on your own recorded material. For example, you can
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record yourself singing, playing guitar, or even beatboxing and use the Convert commands to
generate MIDI that you can use as a starting point for new music.

For the most accurate results, we recommend the following:

* Use music that has clear attacks. Notes that fade in or “swell” may not be detected by the
conversion process.

* Work with recordings of isolated instruments. The Convert Drums command, for example,
works best with unaccompanied drum breaks; if other instruments are present, their notes
will be detected as well.

* Use uncompressed, high-quality audio files such as .wav or .aiff. Lossy data formats such
as mp3 may result in unpredictable conversions, unless the recordings are at high bitrates.

Live uses the transient markers (page 157) in the original audio clip to determine the divisions
between notes in the converted MIDI clip. This means that you can “tune” the results of the con-
version by adding, moving, or deleting transient markers in the audio clip before running any of
the Convert commands.

Although each of the commands has been designed for a particular type of musical material,
you can sometimes get very interesting results by applying the “wrong” command. For example,
Convert Harmony will usually create chords. So running it on a monophonic clip (like a vocal re-
cording) will often generate notes that weren't present in the original audio. This can be a great
way to spark your creativity.
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Chapter 12

Using Grooves

The timing and “feel” of each clip in your Set can be modified through the use of grooves. Live
comes with a large selection of grooves, which appear as .agr files in the browser.

Groove Files in the Browser.

The easiest way to work with library grooves is to drag and drop them from the browser directly
onto clips in your Set. This immediately applies the timing characteristics of the groove file to
the clip. If you want to quickly try out a variety of grooves, you can enable the Hot-Swap but-
ton above a clip’s Clip Groove chooser (page 135) and then step through the grooves in the
browser while the clip plays.
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The Hot-Swap Groove Button.

Grooves can be applied to both audio and MIDI clips. In audio clips, grooves work by adjusting
the clip’s warping behavior (page 155), and thus only work on clips with Warp enabled.

12.1 Groove Pool

Once you've applied a groove file, you can modify its behavior by adjusting its parameters in
the Groove Pool, which can be opened or closed via its selector button at the bottom of Brows-
er.

[ Desktop » [ sp1200
Add Folder... » £ swing

-@

The Groove Pool Selector Button.

You can also double-click grooves in the browser to load them directly to the Groove Pool be-
fore applying them to a clip. The Groove Pool contains all grooves that have been loaded in this
way or that are being used in clips. “Inactive” grooves (those that are not being used by a clip)
appear with their parameters grayed out.

Note: In Live Intro and Lite, grooves can be loaded from the browser and applied to clips, but
cannot be edited in the Groove Pool.
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The Groove Pool.

12.1.1  Adjusting Groove Parameters

Grooves in the Groove Pool appear in a list, and offer a variety of parameters that can be modi-
fied in real time to adjust the behavior of any clips that are using them. You can also save and
hot-swap grooves via the buttons next to the Groove's name.

The Groove Pool’s controls work as follows:

¢ Base — The Base chooser determines the timing resolution against which the notes in the
groove will be measured. A 1/4 Base, for example, means that the positions of the notes in
the groove file are compared to the nearest quarter note, and all notes in any clips that are
assigned to that groove will be moved proportionally towards the positions of the groove
notes. At a base of 1/8th, the groove’s notes are measured from their nearest eighth note.
Notes in the groove that fall exactly on the grid aren’t moved at all, so the corresponding
notes in your clips will also not be moved.

Quantize — adjusts the amount of “straight” quantization that is applied before the groove
is applied. At 100%, the notes in your clips will be snapped to the nearest note values, as
selected in the Base chooser. At 0%, the notes in clips will not be moved from their original
positions before the groove is applied.

Timing — adjusts how much the groove pattern will affect any clips which are using it.

Random — adjusts how much random timing fluctuation will be applied to clips using the
selected groove. At low levels, this can be useful for adding subtle “humanization” to high-
ly quantized, electronic loops. Note that Random applies differing randomization to every
voice in your clip, so notes that originally occurred together will now be randomly offset
both from the grid and from each other.
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* Velocity — adjusts how much the velocity of the notes in clips will be affected by the veloc-
ity information stored in the groove file. Note that this slider goes from -100 to +100. At
negative values, the effect of the groove's velocity will be reversed; loud notes will play
quietly and vice versa.

Global Amount — this parameter scales the overall intensity of Timing, Random and Veloc-
ity for all of the available groove files. At 100%, the parameters will be applied at their as-
signed values. Note that the Amount slider goes up to 130%, which allows for even more
exaggerated groove effects. If grooves are applied to clips in your Set, the Global Amount
slider will also appear in Live’s Control Bar.

Tap | 100.00 (NI} 4 / 4 0@ =~ None ~

The Global Groove Amount Slider in the Control Bar

12.1.2 Committing Grooves

The Commit Groove Button.

Pressing the Commit button below the Clip Groove chooser “writes” your groove parameters
to the clip. For MIDI clips, this moves the notes accordingly. For audio clips, this creates Warp
Markers at the appropriate positions in the clip.

After pressing Commit, the clip’s Groove chooser selection is automatically set to None.
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12.2 Editing Grooves

The effect that groove files have on your clips is a combination of two factors: the parameter
settings made in the Groove Pool and the positions of the notes in the groove files themselves. To
edit the contents of groove files directly, drag and drop them from the browser or Groove Pool
into a MIDI track. This will create a new MIDI clip, which you can then edit, as you would with
any other MIDI clip. You can then convert the edited clip back into a groove, via the process
below.

12.2.1 Extracting Grooves

The timing and volume information from any audio or MIDI clip can be extracted to create a
new groove. You can do this by dragging the clip to the Groove Pool or via the Extract Groove
command in the clip’s [right-click](PC) / [CTRL-click](Mac) context menu.

Extract Grooves From Audio or MIDI Clips.

Grooves created by extracting will only consider the material in the playing portion of the clip.

Note: grooves cannot be extracted from clips in the Intro and Lite Editions.

12.3 Groove Tips

This section presents some tips for getting the most out of grooves.
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12.3.1 Grooving a Single Voice

Drummers will often use variations in the timing of particular instruments in order to create a
convincing beat. For example, playing hi-hats in time but placing snare hits slightly behind the
beat is a good way of creating a laid-back feel. But because groove files apply to an entire clip
at once, this kind of subtlety can be difficult to achieve with a single clip. Provided your clip uses
a Drum or Instrument Rack, one solution can be to extract the chain (page 298) containing the
voice that you want to independently groove. In this example, we'd extract the snare chain, cre-
ating a new clip and track that contained only the snare notes. Then we could apply a different
groove to this new clip.

12.3.2 Non-Destructive Quantization

Grooves can be used to apply real-time, non-destructive quantization to clips. To do this, simply
set the groove’s Timing, Random and Velocity amounts to 0% and adjust its Quantize and Base
parameters to taste. With only Quantize applied, the actual content of the groove is ignored, so
this technique works the same regardless of which Groove file you use.

12.3.3 Creating Texture With Randomization

You can use a groove’s Random parameter to create realistic doublings. This can be particu-
larly useful when creating string textures from single voices. To do this, first duplicate the track
containing the clip that you want to “thicken.” Then apply a groove to one of the clips and turn
up its Random parameter. When you play the two clips together, each note will be slightly (and
randomly) out of sync with its counterpart on the other track.



Launching Clips | 201

Chapter 13

Launching Clips

The Live Session View is set apart by the fact that it gives you, the musician, a spontaneous en-
vironment that encourages performance and improvisation. An important part of how you take
advantage of the Session View lies within how you configure your various Session View clips.

This chapter explains the group of settings used to define how each Session View clip behaves

when triggered, or “launched.”

13.1 The Launch Box

Remember that clips in the Session View are launched by their Clip Launch buttons (page 119)
or remote control (page 573). Clip launch settings are made in the Launch box. The Launch
box only applies to Session View clips, as Arrangement View clips are not launched but played
according to their positions in the Arrangement.

To view the Launch box, open the Clip View (page 131) of a Session View clip by double-
clicking the clip, then activating the leftmost Clip View Box selector panel.

Use the Clip View Box Selector to Bring up the Launch Box.
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Note that you can edit the launch settings of more than one clip at the same time by first select-
ing the clips and then opening the Clip View.

13.2 Launch Modes

The Clip Launch Mode Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect to
mouse clicks, computer keyboard actions or MIDI notes:

* Trigger: down starts the clip; up is ignored.
* Gate: down starts the clip; up stops the clip.
* Toggle: down starts the clip; up is ignored. The clip will stop on the next down.

* Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly at the clip
quantization rate.
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13.3 Clip Launch Quantization

The Clip Quantization Chooser.

The Clip Quantization chooser lets you adjust an onset timing correction for clip triggering. To
disable clip quantization, choose “None.”

To use the Control Bar’s Global Quantization setting, choose “Global.” Global quantization can
be quickly changed using the [CTRL][6](PC) / [CMD][6](Mac), [7], [8], [?], and [0] shortcuts.

Note that any setting other than “None” will quantize the clip’s launch when it is triggered by
Follow Actions (page 205).

13.4 Velocity

The Velocity Amount Field.
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The Velocity Amount control allows you to adjust the effect of MIDI note velocity on the clip’s
volume: If set to zero, there is no influence; at 100 percent, the softest notes play the clip silently.
For more on playing clips via MIDI, see the respective section (page 573).

13.5 Legato Mode

The legato Mode Switch.

Suppose you have gathered, in one track, a number of looping clips, and you now want to tog-
gle among them without losing the sync. For this you could use a large quantization setting (one
bar or greater), however, this might limit your musical expression.

Another option, which works even with quantization turned off, is to engage Legato Mode for
the respective clips. When a clip in Legato Mode is launched, it takes over the play position from
whatever clip was played in that track before. Hence, you can toggle clips at any moment and
rate without ever losing the sync.

Legato Mode is very useful for creating breaks, as you can momentarily play alternative loops
and jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you might
hear dropouts when launching clips in Legato Mode. This happens because you are unexpect-
edly jumping to a point in the sample that Live has had no chance to pre-load from disk in ad-
vance. You can remedy this situation by engaging Clip RAM Mode (page 147) for the clips in
question.
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13.6 Follow Actions

Follow Actions allow creating chains of clips that can trigger each other in an orderly or random
way (or both). A clip’s Follow Action defines what happens to other clips in the same group after
the clip plays. A group is defined by clips arranged in successive slots of the same track. Tracks
can have an unlimited number of groups, separated by empty slots.

Clip Launch Sample +»
Chorale Sea | | Launch Mode | Chorale Sea.aif Warp Start
¥| | |Trigger ¥|| 44.1kHz 32 Bit 2 Ch 1) 1) 1
Signature Legato Rev.) | seg.BPM |End
4 || 4 Quantization HiQ ||Fade | |RAM 130.77 5| 1)1

Global ¥| | Transpose :2)(*2
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Loop
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The Follow Action Controls.

1. The Follow Action Time control defines when the Follow Action takes place in bars-beats-
sixteenths from the point in the clip where play starts. The default for this setting is one bar.

2. The Follow Action choosers allow selecting two different Follow Actions, A and B.

3. The Chance A and Chance B controls set the likelihood of each of the two Follow Actions
occurring. If a clip has Chance A setto 1 and Chance B set to O, Follow Action A will oc-
cur every time the clip is launched. As we can see from this example, a Chance setting
of 0 means that an action will never happen. Changing Chance B to 10 in this scenario
makes Follow Action A occur much less often — approximately once out of every ten clip
launches.

There are eight Follow Actions available:

“Stop” simply stops the clip after it has played for the chosen Follow Action Time. Note that
this overrides clip loop/region settings.

“Play Again” restarts the clip.
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“Previous” triggers the previous clip (the one above the current one).

“Next" triggers the next clip down in the group. If a clip with this setting is last in a group, this
Follow Action triggers the first clip.

“First” launches the first (top) clip in a group.
“Last” launches the last (bottom) clip in a group.
“Any” plays any clip in the group.

“Other” is similar to “Any,” but as long as the current clip is not alone in the group, no clip will

play consecutively.

There is also the possibility to have no Follow Action by selecting “No Action,” or leaving the
chooser blank.

Note that a Follow Action happens exactly after the duration that is specified by the Follow Ac-
tion Time controls unless clip quantization is set to a value other than “None” or “Global.” Fol-
low Actions circumvent global quantization but not clip quantization.

So why do you need these things2 Music is repetition and change. Music based on loops or
short melodic fragments has a tendency to sound static. Follow Actions allow you to create struc-
tures that will repeat but can also be surprising. Remember that you can always record (page
245) the results of your experiments, so this can provide a good source for new material.

In the following sections we will look at some practical examples and ideas for Follow Actions.

13.6.1 Looping Parts of a Clip

Let's say that you want to play a longer clip, but then you want only the last eight bars to loop.
You can set this up using Follow Actions:

1. Drag the clip into the Arrangement View and make sure that the Clip View's Loop switch is
not activated. Use the Edit menu’s Split command (page 116) to split the clip between the
non-looping and looping parts.

2. Click and drag the resulting two clips into the Session View by letting the mouse cursor
hover over the Session View selector. Drop the two clips into a track. They now form a Fol-
low Action group.
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Creating a Group With the Two Clips.

3. Set up Follow Actions for the first clip. You will want to make Follow Action Time equal to
the clip’s length. Set the Follow Action A chooser to “Next,” with a Chance setting of 1,
leaving Follow Action B alone. Now this clip is set up to advance to the looping clip after it

plays.
4. Activate the Loop switch for the second clip.

The first clip will now proceed to the second after it has played in its entirety; the second clip will
simply play in a loop until it is stopped.

13.6.2 Creating Cycles

One of the most obvious possibilities that Follow Actions open up is using a group of samples to
form a musical cycle. If we organize several clips as a group and use the “Play Next Clip” Fol-
low Action with each clip, they will play one after the other ad infinitum, or until we tell them to
stop.

Cycles can be peppered with occasional rearrangements through the addition of other Follow
Actions, such as “Any,” with smaller relative Chance settings.

13.6.3 Temporarily Looping Clips

There are some interesting applications of Follow Actions when it comes to creating temporary

musical loops.
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The default setting for Follow Action is actually a 1:0 chance that “No Action” happens after the
Follow Action Time, which means that there is effectively no Follow Action. But now, imagine a
group consisting of one single clip. Follow Action A is set to “Play Again,” with a Chance of 8.
Follow Action B is set fo “No Action,” with a Chance of 1. The clip uses a long sample, and Fol-
low Time is set to one bar. Clicking on the clip will play the first bar, after which it will be very
likely that it will play the first bar again. However, after a few repetitions, it will eventually come
to Action B — “No Action” — and continue playing the rest of the sample.

Or, a clip can be played from its start to a specific point, when its Follow Action tells it to “Next.”
The same file can be used in the next clip in the group, but this one can be set to loop. This sec-
ond clip can have any manner of Follow Action settings, so that it might then play forever, for a
specified time or until random chance leads to the next clip in the group.

13.6.4 Adding Variations in Sync

Paired with clip envelopes (page 313) and warping (page 155), Follow Actions can be used

to create all sorts of interesting variations within a group of similar clips. You could, for example,
use Follow Actions to randomly trigger clips with different MIDI controller clip envelopes, so that
fine variations in pitch bend or modulation of an instrument or synth could occur as the clipsin a
group interacted. Audio clips could morph between different effect or clip transposition settings.

Using Follow Actions and Legato Mode together provides a powerful way of gradually chang-
ing a melody or beat. Imagine that you have several identical clips of a melody that form a
group, and they are set up to play in Legato Mode. Whenever their Follow Actions tell them to
move on to another clip in the group, the melody will not change, as Legato Mode will sync the
new play position with the old one in beat-time. The settings and clip envelopes of each clip (or
even the actual notes contained in a MIDI clip) can then be slowly adjusted, so that the melody
goes through a gradual metamorphosis.

13.6.5 Mixing up Melodies and Beats

You can let Follow Actions perform unpredictable remixes and solos for you: Use a clip contain-
ing a beat or melody, and copy it so that there are several instances of it forming a group. Alter-
natively, you can use several different beats or melodies that you want to mix together. The start
and end (page 138) for each clip can be set differently, as can clip envelopes (page 313)

and other clip settings. As long as Follow Action Time in each clip is equal to the length of the
clip that you want to play, you can set up two Follow Actions with different Chance values in
each clip, launch a clip, and surprise yourself.
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13.6.6 Creating Nonrepetitive Structures

Follow Actions are great when it comes to sound installations, as they allow you to create struc-
tures that play for weeks or months and never exactly repeat. You can set the Follow Action Time
controls in a series of clips to odd intervals, and the clips will interact with each other so that they
never quite play in the same order or musical position. Remember that each clip can have two
different Follow Actions with corresponding Chance settings... have fun!
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Chapter 14

Routing and |/ O

In the context of Live, “routing” is the setup of the tracks’ signal sources and destinations (i.e.,
their inputs and outputs). Most routing happens in the mixer’s track In/Out section, which offers,
for every track, choosers to select a signal source and destination. The mixer’s In/Out section is

Live's “patchbay.”

The In/Out section can be independently shown or hidden from the Session and Arrangement
Views. Toggle its visibility using the /O Mixer Section selector, or via the View menu’s In/Out

option.

The Mixer's In/Out Section and Mixer Section Selectors.

For every track that can play clips, the In/Out section has the same layout:

* The upper chooser pair (“Audio/MIDI From”) selects the track’s input. Audio tracks have
an audio input, and MIDI tracks have a MIDI input. Return tracks receive their input from

the respective sends (page 238).

* The Monitor radio button selects the monitor mode: the conditions under which the track’s

input is heard through the track.

* The lower chooser pair (“Audio/MIDI To") selects the track’s output. All tracks have audio
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outputs, except for MIDI tracks without instruments. Remember that instruments convert
MIDI to audio (page 48).

Within a chooser pair, the upper chooser selects the signal category (“Ext.,” for instance, for ex-
ternal connections via an audio or MIDI interface), and is called the Input/Output Type chooser.
If this signal type offers sub-selections or channels, they are available from the lower chooser, or
the Input/Output Channel chooser. In our “Ext.” example, these would be the individual audio/

MIDI inputs and outputs.

14.1 Monitoring

“Monitoring,” in the context of Live, means passing a track’s input signal on to the track’s output.
Suppose you have set up an audio track to receive its input signal from a guitar. Monitoring
then means that the signal from your live guitar playing actually reaches the track’s output, via
the track’s device chain. If the track’s output is set to “Master,” you can hear the guitar signal,
processed by whatever effects are used (and delayed by whatever latency the audio hardware
interface incurs), over your speakers.

The In/Out section offers, for every audio track and MIDI track, a Monitor radio button with the
following three options:

* The default Auto-monitoring setting does the right thing for most straightforward recording

applications: Monitoring is on when the track is armed (record-enabled) (page 245), but
monitoring is inhibited as long as the track is playing clips.
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Audio and MIDI Track Arm Buttons.
* To permanently monitor the track’s input, regardless of whether the track is armed or clips

are playing, choose In. This setting effectively turns the track into what is called an “Aux”
on some systems: the track is not used for recording but for bringing in a signal from else-
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where (for instance, a ReWire slave program). With this setting, output from the clips is
suppressed. An “In” monitoring setting can be easily recognized even when the In/Out
section is hidden by the orange color of the track’s Activator switch.

Monitoring can be turned off altogether by choosing the Off option. This is useful when
recording acoustic instruments which are monitored “through the air,” when using an ex-
ternal mixing console for monitoring or when using an audio hardware interface with a
“direct monitoring” option that bypasses the computer so as to avoid latency. Generally,
it is preferable to work with an audio interface that allows for negligible latencies (a few
milliseconds). If you are recording into Live with monitoring set to “Off,” you may want to
make the Audio Preferences’ Overall Latency adjustment, which is described in the built-in
program tutorial on setting up the Audio Preferences.

If multiple tracks are selected, pressing one of the Monitor buttons applies this selection to all of
the selected tracks.

14.2 External Audio In/Out

An audio interface’s inputs are selected by choosing “Ext. In” from the Input Type chooser of an
audio track. The Input Channel chooser then offers the individual input channels. Entries in this
chooser each have meters next to their names to help you identify signal presence and overload
(when the meter flashes red). Setting up the audio interface’s outputs works the same way via the
output chooser pair. If multiple tracks are selected, any changes you make to these choosers will
be applied to all selected tracks.

The list of available inputs and outputs depends on the Audio Preferences, which can be
reached via the Input and Output Channel choosers’ “Configure...” option. Note that the Audio
Preferences also provide access to the Channel Configuration dialogs, which determine which
inputs and outputs are used, and whether they are available to Live as mono or stereo pairs.
Essentially, the Channel Configuration dialog tells Live what it needs to know about how the
computer is connected to the other audio components in your studio.

You can rename any input and output channels that appear in the Channel Configuration dia-
logs. If changed, the new name(s) will be displayed in the corresponding Input / Output Chan-
nel chooser drop-down. You can rename channels more quickly by using the [Tab] key to move
between them. Note that changed names are always associated with their respective audio
device.
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14.2.1 Mono/ Stereo Conversions

When a mono signal is chosen as an audio track’s input, the track will record mono samples;
otherwise it will record stereo samples. Signals in the track’s device chain are always stereo,
even when the track’s input is mono or when the track plays mono samples.

Mono is turned into stereo simply by using the identical signal for left and right channels. When
a track is routed info @ mono output, the left and right signals are added together and attenu-
ated by 6 dB to avoid clipping.

14.3 External MIDI In/Out

MIDI from the outside world is routed into Live just like audio. From the Input Type chooser of a
MIDI track, you can either select a specific MIDI input port or “All Ins,” which is the merged input
of all external MIDI ports. The Input Channel chooser offers the individual input channels of the
selected MIDI port and the merged signal of all channels, “All Channels.” As is the case with
audio inputs, the Input Channel chooser also has meters next to every entry to represent activity
on the respective input channel. If multiple MIDI tracks are selected, any changes you make to
these choosers will be applied to all selected tracks.

14.3.1 The MIDI Ports List in the Preferences

The MIDI Ports List in the Preferences.

You can configure which MIDI ports are made available to Live using the MIDI Ports section of
the Link/MIDI Preferences. All available input and output ports are listed here. For Live's tracks
to receive/send MIDI from/to a specific MIDI port, the corresponding switch in the Track col-
umn must be set to On. You can use any number of MIDI ports for track input and output; the
mixer’s In/Out choosers allow them to be addressed individually.
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14.3.2  Playing MIDI With the Computer Keyboard

The computer keyboard can be used for generating MIDI notes from computer keyboard
strokes. To turn the computer MIDI keyboard on, use the Control Bar’s Computer MIDI Keyboard
button, or the [M] shortcut to the Options menu entry.

LKey MIDI| 0% |D

Activating the Computer MIDI Keyboard.

The center row of letter keys on the keyboard will play notes corresponding to the white keys
on a piano, beginning on the left with the note C3. The black keys on a piano correspond to the
upper row of computer keys. The four leftmost letters on the lower row of the keyboard (Z,X,C,
and V on a U.S.-English keyboard) are used to transpose the note range and to set velocity, as
follows:

* The leftmost keys (Z and X) adjust the keyboard’s octave range.

* The next two keys (C and V) adjust incoming note velocity by intervals of twenty (20, 40,
60, and so on).

As it happens, when the computer keyboard is set to send notes between C3 and C4, the keys
are mapped to MIDI notes such that the center row of the keyboard (ASDF...) addresses the Im-
pulse percussion sampler’s sample slots (page 463). This means that you can play and record
drum patterns right off the computer keyboard.

Note that when the computer MIDI keyboard is activated, it will “steal” keys that may have oth-
erwise been assigned to remote-control (page 583) elements of the Live interface. To prevent
this, you can turn the computer MIDI keyboard off when it is not needed.

14.3.3 Connecting External Synthesizers

Routing MIDI to an external synthesizer is straightforward: The Output Type chooser is set to
whatever MIDI port the synthesizer is connected to; the Output Channel chooser is used to select
which MIDI channel to send on.

In addition to routing via a track’s In/Out section, it is also possible to route from within a track’s
device chain by using the External Instrument device (page 461). In this case, you can send
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MIDI out to the external synthesizer and return its audio — all within a single track. (Note: the
External Instrument device is not available in the Intro and Lite Editions.)

Important: If you are using a keyboard synthesizer both as a master keyboard to play into Live
and as a sound generator, then please make sure to check the synthesizer’s “Local Off” func-
tion. Every synthesizer has this function, which effectively separates the keyboard from the sound
generator, allowing you to treat both components as if they were separate devices. This allows
you to use Live as the hub of your MIDI studio, which receives MIDI from the keyboard and dis-
patches the incoming MIDI, as well as the MIDI from the clips, as appropriate.

14.3.4 MIDI In/Out Indicators

Live's Control Bar contains three pairs of indicator LEDs that tell you about incoming and outgo-
ing MIDI. These indicators tell you not only about the presence of signals, but also about their
use. In every pair, the upper indicator flashes when a MIDI message is received, and the lower
indicator flashes when a MIDI message is sent.

The Control Bar's MIDI Indicators.

The three indicator pairs represent, from left to right:

1. MIDI Clock and Timecode signals that are used for synchronizing Live with other sequenc-
ers (page 705). Note that this set of indicators is only visible when an external sync
source has been enabled in the MIDI Ports List in the Preferences;

2. MIDI messages that are used for remote-controlling Live's user-interface elements (page
573);

3. MIDI messages coming from and going to Live's MIDI tracks.
MIDI messages that are mapped to remote-control Live's user-interface elements are “eaten up”

by the remote control assignment and will not be passed on to the MIDI tracks. This is a common
cause of confusion that can be easily resolved by looking at the indicators.
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14.4 ReWire Slave Routing

Live can operate as a ReWire master or slave in cooperation with another ReWire application.
As a ReWire master, Live can send MIDI to, and receive audio from, any ReWire slave applica-
tion installed on the same computer.

An Audio Track Receiving Audio From and a MIDI Track Sending MIDI to Reason.

The following example shows how to send MIDI from one of Live’s MIDI tracks into an instrument
within Propellerhead’s Reason, and then route the audio result back into an audio track:

1. First, start Live.
2. Then, start Reason and set up the Reason rack as desired.
3. Select “Reason” from the MIDI track’s Output Type chooser.

4. The Output Channel chooser presents you with a list of the instruments that you currently
have in your Reason rack; select the instrument you want to address.

5. Select “Reason” from the audio track’s Input Type chooser.

6. From the audio track’s Input Channel chooser, select the audio channel that corresponds to
the instrument to which you are sending MIDI.

7. Set the audio track’s Monitor radio button to “In.”

8. Select “All Ins” from the MIDI track’s Input Type chooser.
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9. Arm the MIDI track.
Now, any MIDI that you are playing into Live will arrive in Reason, which will generate the cor-
responding audio back into the audio track, ready for further processing in Live's mixer and
effects. If you want to continue work on the project without reopening Reason, simply record

Reason’s audio by arming the audio track and engaging Record Mode.

A similar procedure is possible with the External Instrument device. The following example shows
how to send MIDI from within a track’s device chain and return the audio to the same track:

1. First, start Live.

2. Then, start Reason and set up the Reason rack as desired.

3. Insert an External Instrument device into a MIDI track.

4. Select “Reason” from the External Instrument’s first MIDI To chooser.

5. The second chooser presents you with a list of the instruments that you currently have in
your Reason rack; select the instrument you want to address.

6. From the External Instrument’s Audio From chooser, select the audio channel that corre-
sponds to the instrument to which you are sending MIDI.

7. Arm the MIDI track.

8. Adjust the External Instrument’s Gain knob as necessary.

14.5 Resampling

Live's Master output can be routed into an individual audio track and recorded, or resampled.
Resampling can be a fun and useful tool, as it lets you create samples from what is currently hap-
pening in a Live Set that can then be immediately integrated. It can be used to record tracks that
include processor-intensive devices, so as to delete the devices, or for quickly previewing before
rendering to disk (page 74).

The “Resampling” option in any audio track’s Input Type chooser will route the Master output to
that track. You can then decide on what exactly you will be resampling and mute, solo or other-
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wise adjust the tracks that are feeding the Master output. You will probably want to use the Mas-
ter Volume meter to make sure that your level is as high as possible without clipping (indicated
by red in the meter). Then you can arm the track and record into any of its empty clip slots (page
248). Note that the recording track’s own output will be suppressed while resampling is taking
place, and will not be included in the recording.

Samples created by resampling will be stored in with the current Set’s Project folder (page
88), under Samples/Recorded. Until the Set is saved, they remain at the location specified
by the Temporary Folder (page 255).

14.6 Internal Routings

Live's mixer and external routing devices allow for inter-track routings. These routings, albeit
potentially confusing, enable many valuable creative and technical options. Via the mixer, inter-
track routing can work two ways:

1. Track A is set up to send its output signal to Track B. This is possible because every track
that can receive an output signal of the appropriate type from Track A shows up in its Out-

put Type chooser.

2. Track B is set up to receive its input signal from Track A. This works because every track that
delivers a signal of the appropriate type appears in Track B's Input Type chooser.

Two Ways to Route Track A into Track B.
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Both approaches result in Track A’s output being fed into Track B. Approach 1 leaves Track B's
in/out settings alone, and we can, at any time, add more tracks that feed their output into Track
B. This is the method of choice for “many-to-one” routings such as submixes or several MIDI
tracks playing the same instrument. In this scenario, soloing Track B will still allow you to hear the
output of the tracks that are feeding it. Also, you can still solo Track A and hear its output signal.
In this case, all other tracks are muted, including those that might also feed into Track B. Techni-
cally, what you hear is the output of Track B, with everything except Track A’s signal removed.

Approach 2, on the other hand, leaves Track A unaffected except for Track B tapping its output.
We can easily add more tracks like Track B that all tap Track A's output. Instrument layering is a
good example of such a “one-to-many” routing setup.

14.6.1 Internal Routing Points

Signals travel from Live's tracks into their respective device chains and then into the track mixer,
where they might become panned or have their levels altered by the tracks’ faders.

Whenever a track’s Audio From input chooser is set to another track (as described in the previ-
ous section’s Approach 2), the signal received can be tapped from one of three different points
chosen from the Input Channel chooser: Pre FX, Post FX or Post Mixer.

Tap Points for Track Routing.

* Pre FX taps the signal that is coming directly from a track, before it has been passed on to
the track’s device chains (FX) or mixer. Therefore, changes that are made to the tapped
track’s devices or mixer have no effect on the tapped signal. Soloing a track that taps an-
other track Pre FX will allow you to hear the tapped track.

* Post FX taps the signal at the output of a track’s device chains (FX), but before it has been
passed back to the track mixer. Changes to the tapped track’s devices will therefore alter
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the tapped signal, but changes to its mixer settings will not. Soloing a track that taps an-
other track Post FX will allow you to hear the tapped track.

* Post Mixer taps the final output of a track, after it has passed through its device chains
and mixer. Soloing a track that taps another track Post Mixer will not allow you to hear the

tapped track.

Routing Points in Racks

Tap Points for Every Chain in a Track.

If a track has one or more Instrument or Effect Racks (page 281) in its device chain, internal
routing points (Pre FX, Post FX and Post Mixer) will also be available for every chain within the
Rack. If a track contains one or more Drum Racks (page 292), internal routing points will be
available for any of the Rack’s return chains. Each Rack will also be listed in the Input Channel

chooser:

* (Rack Name) | (Chain Name) | Pre FX — The signal will be tapped from the point that it
enters the Rack, before it reaches the chain’s devices.

* (Rack Name) | (Chain Name) | Post FX — The signal will be tapped from the end of the
chain, but before it passes to the chain’s mixer.
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* (Rack Name) | (Chain Name) | Post Mixer — The signal will be tapped from the output
of the chain’s mixer, just before the point where all of the chains in the Rack are summed
together to create the Rack'’s output.

Soloing a track that taps a Chain at any of these points will still allow you to hear the output at
that point.

14.6.2  Making Use of Internal Routing

This section presents several internal routing examples in more detail.

Post-Effects Recording

Let's say that you are feeding a guitar into Live, building up a song track by track, overlaying
take onto take. It is certainly powerful to have a separate effects chain per track for applying dif-
ferent effects to different takes — after the fact. You might, however, want to run the guitar signal
through effects (a noise gate or an amp model, for instance) before the recording stage, and
record the post-effects signal.

An Example Setup for Post-Effects Recording.

This is easily accomplished by devoting a special audio track for processing and monitoring the
incoming guitar signal. We call this track “Guitar” and drag the desired effects into its device
chain. We do not record directly into the Guitar track; instead we create a couple more tracks to
use for recording. Those tracks are all set up to receive their input Post FX from the Guitar track.
Note that we could also tap the Guitar track Post Mixer if we wished to record any level or pan-
ning from it.
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As for monitoring, we set the Guitar track’s Monitor radio button to In, because we always want
to listen to our guitar through this track, no matter what else is going on in Live. The other tracks’
Monitor radio buttons are set to Off.

Recording MIDI as Audio

When working with MIDI and complex software instruments, it is sometimes more useful to re-
cord the resulting audio than the incoming MIDI. A single MIDI note can prompt, for example,
Native Instruments’ Absynth to produce something that sounds more like a piece of music than
a single tone. This output lends itself more to representation as an audio waveform than a single
note in a MIDI clip, particularly when comparing the editing options.

Recording the Output of a Complex Instrument in Audio Tracks.

A setup similar to the one described above (page 222) accomplishes the task. We have one
MIDI track hosting the virtual instrument, and we use additional audio tracks to record the audio
result of playing the instrument.
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Creating Submixes

Submixing the Individual Drums of a Drum Kit.

Suppose we have the individual drums of a drum kit coming in on separate tracks for multitrack
recording. In the mix, we can easily change the volumes of the individual drums, but adjusting
the volume of the entire drum kit against the rest of the music is less convenient. Therefore, we
add a new audio track to submix the drums. The individual drum tracks are all set to output to the
submix track, which outputs to the Master. The submix track gives us a handy volume control for

the entire drum kit.

Alternatively, you could combine the separate drum tracks into a Group Track (page 236) for
even more flexibility. This automatically creates the necessary output routings and also allows
you to hide or show the component tracks.

Submixing by setting a track’s Output Type to Sends Only

A third possibility is to use Live's return tracks for submixing. This is done by selecting the Sends
Only option in a track’s Output Type, then turning up a Send control as desired. The correspond-
ing return track will then act as a submixer channel.
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Several MIDI Tracks Playing the Same Instrument

Consider a MIDI track containing a virtual instrument — a Simpler playing a pad sound, for ex-
ample. We have already recorded MIDI clips into this track when we realize that we would like
to add an independent, parallel take for the same instrument. So we add another MIDI track.
We could now drag another Simpler into the new track, but we would really like to reuse the
Simpler from the pad track, so that changing the pad’s sound affects the notes from both tracks.

Feeding an Additional MIDI Track Into an Existing MIDI Track to Reuse its Instrument.

This is accomplished by setting the new MIDI track’s Output Type chooser to “Pad.” Note that
the Output Channel chooser now offers a selection of destinations: We can either feed the new
track’s output into the input of the pad track, or we can directly address the Simpler. The “Track
In” option in the Output Channel represents the pad track’s input signal (the signal to be record-
ed), which is not what we want. We instead select “Simpler Ch. 1” to send the new track’s MIDI
directly to the Simpler, bypassing the recording and monitoring stage. With this setup, we can
choose to record new takes on either track and they will all play the same pad sound.
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The Instrument Has Been Isolated in a Dedicated Track.

We might be bothered by the fact that muting the pad track (by turning off its Activator switch)
also mutes the other MIDI track. To be precise, the other track keeps playing, but its MIDI is
played by an instrument that is out of the mix. This can be easily remedied by cutting the clips
from the pad track and pasting them into a third track that can be independently muted (and that
can hold its own MIDI effects). The original pad track now acts as a mere instrument container.
As we are not recording new clips into this track, we can set its Input Type chooser to “No Input,”
which makes its Arm button disappear and helps to avoid confusion when the mixer’s In/Out
section is hidden.

Tapping Individual Outs From an Instrument

Some software instruments, like Live’s Impulse percussion sampler, offer multiple audio outputs
for the signals they produce. By default, Impulse mixes the output of its eight sample slots inter-
nally and delivers the mix at the instrument’s audio out. Any audio effects following Impulse in
the same track process the composite signal. Sometimes it is desirable to take an individual drum
sound out of the mix for individual effects processing and mixing. This is possible because Im-
pulse offers its sample slots as audio sources to other tracks.
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Using Impulse’s Individual Outs to Separately Process Sample Slots.

We simply create an audio track and select from its Input Type chooser the track with the Im-
pulse. The Input Channel chooser now offers, in addition to Pre FX, Post FX and Post Mixer,
Impulse’s eight individual outputs, labeled according to the sample used in each slot. Notice that
routing an individual output from Impulse into another track automatically takes this signal out

of Impulse’s own internal mix. This convenience is not standard behavior of most plug-in instru-
ments, however. Soloing a track that taps one of Impulse’s sample slots will still allow you to hear
the output of that slot.

Using Multi-Timbral Plug-In Instruments

Many plug-in instruments support multi-timbral operation. A multi-timbral instrument is like sev-
eral instruments in one, with each component “part” (or whatever term the manufacturer uses)
receiving MIDI on a separate MIDI channel. Usually, the multi-timbral instrument offers indi-
vidual outputs so that the parts can be separately routed into the mixer. Or, the instrument might
offer a submixer of its own.
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Tracks Feeding MIDI to and Tapping Audio From the Parts of @ Multi-Timbral Instrument.

Sending MIDI from the mixer to a multi-timbral instrument is a variation of a case described
above (page 225). One MIDI track hosts the multi-timbral instrument, and additional MIDI
tracks are used to feed its individual parts. Each additional MIDI track has its Output Type
chooser pointed to the track that contains the instrument, and its Output Channel chooser refer-
encing the target MIDI channel. Additional audio tracks can then be used to tap the instrument’s
individual outputs, as described earlier (page 226).

It is also possible to use the External Instrument device to route MIDI to (and audio from) the
secondary outputs on multi-timbral plug-ins. This scenario eliminates the need to create an ad-
ditional audio track for each tapped output:

1. Insert the multi-timbral instrument on a MIDI track.
2. Insert an External Instrument device on another MIDI track.

3. Select the track that contains the instrument in the first MIDI To chooser on the External
Instrument device.

4. Select the MIDI channel to route to in the second chooser on the External Instrument de-

vice.

5. From the External Instrument’s Audio From chooser, select a secondary output on the in-
strument to which you are sending MIDI.

Repeat steps 2-5 to feed and tap additional components of your multi-timbral instrument. You
could also put the entire system of External Instrument devices into a single track, by placing
each one in a Rack’s device chain.
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Note that the main outputs of the multi-timbral instrument will still output to the track that contains
the instrument — only auxiliary outputs are available to the External Instrument device.

Feeding Sidechain Inputs

Some effects have so-called “sidechain inputs.” A vocoder, for instance, imposes spectral char-
acteristics taken from one signal (say, spoken word) onto another signal, for instance a string
pad. The vocoder is inserted as an audio effect into the string track. It has a sidechain input for
the speech signal, which has to be delivered from another track. So, we create an additional
audio track named “Speech” and set its Output Type chooser to the “Strings” track. From the
Output Channel chooser, we select the vocoder's sidechain input.

Routing a Speech Signal Into a Vocoder’s Sidechain Input.

Some vocoder plug-ins include a built-in synthesizer to generate the “carrier” signal. In this
case, the only difference from the above procedure is that the vocoder instrument is dragged
into a MIDI track. Feeding the sidechain audio input works as described above.

A number of Ableton’s built-in devices have their own sidechain controls with integrated routing
choosers that match those found in tracks. Thus when using these devices, it is not necessary to
follow the above procedure — you can simply select the sidechain source from within the device
itself.

Layering Instruments

Suppose that we have a MIDI track containing an instrument playing a string sound, which we
would like to augment by adding a brass sound playing the same notes. This can be easily done
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by adding a MIDI track that contains an instrument playing the brass sound and setting its Input
Type chooser to tap the string track’s Post FX signal.

Using an Auxiliary MIDI Track fo Layer Instruments.

Perhaps you wonder why this works, given that the string track’s output is audio and not MIDI.
When routing MIDI in from another track, we are tapping the MIDI at the latest possible stage,
which is after any MIDI Effects, and just before the instrument.
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Chapter 15

Mixing

15.1 The Live Mixer

Live includes a mixer section that is accessible from two views:

The Arrangement View Mixer.

In the Arrangement View, the mixer appears as a horizontal strip to the right of the track area.
To display all mixer controls for a track, unfold the track using the ® button next fo its name, and
adjust its height accordingly.
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The Session View Mixer.

The Session View is a standard vertical mixer layout, which you may find more intuitive than

the Arrangement mixer. Note that the [Tab] key toggles between the Arrangement and Session
Views if you're working with a single window. If you're working with two windows, the [Tab] key
swaps the Arrangement and Session between the windows, which allows you to see your Ar-
rangement while using the Session mixer.

The View menu options listed below show or hide mixer components. You can use different mixer
view setups in the Session View and in the Arrangement View:

* In/Out

* Sends

* Returns

* Mixer

* Track Delays
¢ Crossfader

The Mixer Section selectors on the right-hand side of the screen duplicate the View Menu com-
mands, making it possible to quickly show or hide different mixer components.
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The Mixer Section Selectors.

Let's look at the mixer controls:

-6.0 10L
-inf || -inf 1

3.0, c

-inf || |-inf

The Mixer Controls.

1. The Meter shows both peak and RMS output levels for the track. While monitoring, how-
ever, it shows peak and RMS input levels. Peak meters show sudden changes in level, while
RMS meters give a better impression of perceived loudness.

2. The Volume control adjusts the track’s output level. With multiple tracks selected, adjusting
the volume of one of them will adjust the others as well.

3. The Pan control has two different modes: the default Stereo Pan Mode, and Split Stereo
Pan Mode. In Stereo Pan Mode, the Pan control positions the track’s output in the stereo
field. To reset the Pan control to center, click on its associated triangle. In Split Stereo Pan
Mode, the sliders let you adjust the position of the track’s left and right input channels
separately. Double-click on the sliders to reset them. You can switch between the two pan
modes via the Pan control’s [right-click](PC) / [CTRL-click](Mac) context menu. With mul-
tiple tracks selected, adjusting the pan knob for one of them will adjust the others as well.

4.To mute the track’s output, turn off the Track Activator switch. With multiple tracks selected,
toggling one of their Track Activators will toggle the others as well.

5. The Solo switch solos the track by muting all other tracks, but can also be used for cueing
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(page 242). With multiple tracks selected, pressing any of their Solo switches will solo all
of them. Otherwise, tracks can only be soloed one at a time unless the [CTRL](PC) / [CMD]
(Mac) modifier is held down or the Exclusive Solo option in the Record/Warp/Launch
Preferences is deactivated.

6. If the Arm Recording button is on, the track is record-enabled (page 245). With multiple
tracks selected, pressing any of their Arm switches will arm all of them. Otherwise, tracks
can only be armed one at a time unless the [CTRL](PC) / [CMD](Mac) modifier is held
down or the Exclusive Arm option in the Record/Warp/Launch Preferences is deactivated.
With Exclusive Arm enabled, inserting an instrument into a new or empty MIDI track will

automatically arm the track.

15.1.1 Session Mixer Features

The Session Mixer’s Possibilities.

The Mixer section of the Session Mixer has several additional features that are not visible by
default. The mixer is resizable, and dragging upwards on the top of the mixer will extend the
height of the track meters, adding tick marks, a numeric volume field and resettable peak level
indicators. Increasing a track’s width in this state will add a decibel scale alongside the meter’s

tick marks.

These enhancements are tailored for use in traditional mixing settings, but are available anytime
the Mixer section is displayed.
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Because of the enormous headroom of Live's 32-bit floating point audio engine, Live's meters
can be driven far “into the red” without causing the signals to clip. The only time that signals over
0 dB will be problematic is when routing to or from physical inputs and outputs, like those of
your sound card, or when saving audio to a file.

Nevertheless, Live provides this optional visual feedback for signals that travel beyond 0 dB in
any track.

15.2 Audio and MIDI Tracks

Audio and MIDI tracks in Live are for hosting and playing clips, as explained earlier (page
41).

You can add new audio and MIDI tracks to your Live Set’s mixer using the appropriate Create

menu commands.

Tracks can also be created by double-clicking or pressing [Enter] on files in the browser to load
them, or by dragging objects from the Browser into the space to the right of Session View tracks
or below Arrangement View tracks. Devices or files loaded into Live in this manner will cre-

ate tracks of the appropriate type (e.g., a MIDI track will be created if a MIDI file or effect is
dragged in).

Dragging one or multiple clips from an existing track into the space to the right of Session View
tracks or below Arrangement View tracks creates a new track with those clips and the original
track’s devices.

A track is represented by its track title bar. You can click on a track title bar to select the track
and then execute an Edit menu command on the track. One such command is Rename. One can
quickly rename a series of tracks by executing this command (or the Rename shortcut [CTRL][R]
(PC) / [CMDI][R](Mac)) and then using the [Tab] key to move from title bar to title bar. When a #
symbol precedes a name, the track will get a number that updates automatically when the track
is moved. Adding additional # symbols will prepend the track number with additional zeros. You
can also enter your own info text (page 31) for a track via the Edit Info Text command in the

Edit menu or in the tracks’ [right-click](PC) / [CTRL-click](Mac) context menu.



Mixing | 236

Tracks are Represented by Track Title Bars.

You can drag tracks by their title bars to rearrange them, or click and drag on their edges to
change their width (in the Session View) or height (in the Arrangement View).

Multiple adjacent or nonadjacent tracks can be selected at once by [Shift]-clicking or [CTRL]-
clicking, respectively. If you drag a selection of nonadjacent tracks, they will be collapsed to-
gether when dropped. To move nonadjacent tracks without collapsing, use [CTRL] + arrow keys
instead of the mouse.

When multiple tracks are selected, adjusting one of their mixer controls will adjust the same con-
trol for the other tracks. If the tracks in the multi-selection have differing values for any particular
knob or slider parameter (volume, for example), this difference will be maintained as you adjust
the parameter.

If you drag a track’s title bar to the Browser it will be saved as a new Set. If a track contains au-
dio clips, Live will manage the copying of the referenced sampled into this new location based
on the selection in the Collect Files on Export chooser (page 96). You can then type in a

name for the newly created Set or confirm the one suggested by Live with [Enter].

Tracks are deleted using the Edit menu’s Delete command.

15.3 Group Tracks

You can combine any number of “normal” audio or MIDI tracks into a special kind of summing
container called a Group Track. To create a Group Track, select the tracks to include and ex-
ecute the Edit menu’s Group Tracks command. You also use this command to nest an existing
Group Track(s) within a new Group Track.

Group Tracks cannot contain clips, but they are similar to audio tracks in that they have mixer
controls and can host audio effects. Group Tracks provide a quick way to create submixes (page
224), and also offer the ability o fold and unfold their contained clip tracks via the & button

in the title bar. This can help you to organize large Sets by hiding away tracks that you don't
need to see.
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An Unfolded Group Track Visualized in Session View...

When tracks are placed into a group, their Audio To routing choosers (page 219) are au-
tomatically assigned to their Group Track unless they already had a custom routing (i.e. to a
destination other than “Master.”) You can also use a Group Track purely as a “folder” track by
rerouting the outputs of the contained tracks to some other destination.

..and in Arrangement View.

Once a Group Track has been created, tracks can be dragged into or out of the group. Delet-
ing a Group Track deletes all of its contents, but a group can be dissolved back into individual
tracks by executing the Edit Menu’s Ungroup Tracks command.

Group Tracks in Arrangement View show an overview of the clips in the contained tracks. In
Session View, slots in Group Tracks have launch and stop buttons whenever at least one clip is
available in a given scene. Launching or stopping this button has the same effect as launching or
stopping all contained clips. Likewise, selecting a Group Slot serves as a shortcut for selecting
all of the contained clips.
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To apply a Group Track’s color to all of its contained tracks and clips, you can use the Assign
Track Color to Grouped Tracks and Clips command in the respective Group Track header’s
[right-click](PC) / [CTRL-click](Mac) context menu.

Note that when using the Assign Track Color to Grouped Tracks and Clips command in Session
View, the color change will only affect Session clips. Likewise, using either command in Arrange-

ment View will only change the color of Arrangement clips.

If a Group Track contains a soloed track or nested Group Track, its Solo button will appear half
colored.
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Solo Button of a Group Track Containing a Soloed Nested Group Track.

15.4 Return Tracks and the Master Track

In addition to Group Tracks and tracks that play clips, a Live Set has a Master track and return
tracks; these cannot play clips, but allow for more flexible signal processing and routing.

The return tracks and the Master track occupy the right-hand side of the Session mixer view and
the bottom end of the Arrangement View.

Note that you can hide and show the return tracks using the Returns command in the View menu.

Like the “normal” clip tracks, the returns and the Master can host effects devices. However,
whereas a clip track’s effect processes only the audio within that track, return tracks can process
audio sent to them from numerous tracks.

For example, suppose you want to create rhythmic echoes with a delay effect. If you drag the ef-
fectinto a clip track, only clips playing in this track will be echoed. Placing this effect in a return
track lets it receive audio from any number of tracks and add echoes to them.
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The Send Controls and Pre/Post Toggle.

A clip or group track’s Send control regulates how much of the track’s output feeds the associat-
ed return track’s input. What's more, even the return track’s own output can be routed to its input,
allowing you to create feedback. Because runaway feedback can boost the level dramatically
and unexpectedly, the Send controls in Return tracks are disabled by default. To enable them,
[right-click](PC) / [CTRL-click](Mac) on a Return track’s Send knob and select Enable Send or
Enable All Sends.

Every return track has a Pre/Post toggle that determines if the signal a clip track sends to it is
tapped before or after the mixer stage (i.e., the pan, volume and track-active controls). The “Pre”
setting allows you to create an auxiliary mix that is processed in the return track, independently
of the main mix. As the return track can be routed to a separate output, this can be used to set up
a separate monitor mix for an individual musician in a band.

The Master track is the default destination for the signals from all other tracks. Drag effects here
to process the mixed signal before it goes to the master output. Effects in the Master track usually
provide mastering-related functions, such as compression and/or EQ.

You can create multiple return tracks using the Create menu'’s Insert Return Track command, but
by definition, there is only one Master track.

15.5 Using Live’s Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on different
tracks. Live’s crossfader works like a typical DJ-mixer crossfader, except that it allows crossfad-
ing not only two, but any number of tracks — including the returns.
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The Crossfader and Selector.

The crossfader is accessed via the Session View's mixer selectors. It features seven different
crossfade curves so that you can choose the one that fits your style the best. To change the
curve, [right-click](PC) / [CTRL-click](Mac) on the crossfader, then select an entry from the con-

text menu.

Choose from Seven Crossfader Curves.

The chart below details the power level and response of each crossfader curve.
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A+B Power Level Crossfader Response

Transition

Dipped

Intfermediate /—-

Constant Power /—'

Slow Fade

Slow Cut

'L‘\- Fast Cut

Crossfader Curve Properties.

The crossfader can be mapped to any continuous MIDI controller (absolute or incremental)

(page 573). In addition to the crossfader’s central slider, its absolute left and right positions are

separately available for MIDI or keyboard mapping. There are two special scenarios for remote

control with respect to the crossfader:

* A key mapped to any one of the three assignable crossfader positions (left, center or right)

will toggle the crossfader’s absolute left and right positions.

* Mapping to two of the three fields allows for a “snapping back” behavior when one of the

assigned keys is held down and the other is pressed and released.
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Crossfade Assign Buttons.

Each track has two Crossfade Assign buttons, A and B. The track can have three states with re-
spect o the crossfader:

¢ If neither Assign button is on, the crossfader does not affect the track at all.

¢ If Ais on, the track will be played unattenuated as long as the crossfader is in the left half
of its value range. As the crossfader moves toward the right across the center position, the
track fades out. At the crossfader’s rightmost position, the track is muted.

* Likewise, if B is on, the track’s volume will be affected only as the crossfader moves left
across its center position.

It is important to understand that the Crossfade Assign buttons do not affect the signal routing:
The crossfader merely influences the signal volume at each track’s gain stage. The track can be
routed to an individual output bus regardless of its crossfade assignment. In studio parlance, you
can think of the crossfader as an on-the-fly VCA group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the Ar-
rangement (page 301) for later in-depth editing. To edit each track’s crossfade assignment,
please choose “Mixer” from the Envelope Device chooser and “X-Fade Assign” from the Control
chooser. The crossfader’s automation curve is accessible when “Mixer” is chosen from the Mas-
ter track’s Device chooser and “Crossfade” is selected from its Control chooser.

15.6 Soloing and Cueing

By default, soloing a track simply mutes all other tracks (except in some cases where tracks
are feeding other tracks (page 219)). The signal from the soloed tracks is heard through their
respective outputs, with the pan setting of each track preserved. Soloing a clip track leaves
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any return tracks audible, provided that the Solo in Place option is enabled in the Solo button’s
[right-click](PC) / [CTRL-click](Mac) context menu. Solo in Place can also be set as the default
behavior by selecting the entry in the Options menu.

Soloing a return track mutes the main output of all other tracks, but still allows you to hear any
signals that arrive at the return via track sends.

Live allows you to replace the standard soloing operation with a cueing operation that lets you
preview tracks as though you were cueing a record on a DJ mixer. This allows choosing clips and
adjusting effects without the audience hearing, before bringing tracks into the mix.

In order fo set Live up for cueing, you must be using an audio interface with at least four dedicat-

ed outputs (or two dedicated stereo outputs). The respective settings are accessible in the Ses-
sion View mixer. Make sure you have the Mixer and In/Out options checked in the View menu.
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The Cueing-Related Session Mixer Controls.

1. The Master Out chooser selects the output on your interface to be used as the main output.

2. The Cue Out chooser selects the output on your hardware interface to be used for cueing.
This has to be set to an output other than that selected for the Master. If the desired outputs
don’t show up in these choosers, please check the Audio Preferences.

3. Activate cueing by setting the Solo/Cue Mode switch to “Cue.”

4. The tracks’ Solo switches are now replaced by Cue switches with headphone icons. When
a track’s Cue switch is pressed, that track’s output signal will be heard through the output
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selected in the Cue Out chooser. Note that the Track Activator switch on the same track still
controls whether or not the track is heard at the Master output.

5. The Cue Volume control adjusts the volume of the cueing output.

Note that when cueing is set up and activated, the output of audio files that you are previewing
in the browser is also heard through the Cue Out.

15.7 Track Delays

A Track Delay control is available for every track in Live. The control allows delaying or pre-de-
laying the output of tracks in milliseconds in order to compensate for human, acoustic, hardware
and other real-world delays.

This section of the interface can be shown or hidden using its respective Mixer Section selector.

The Track Delay Control and Selector.

We do not recommend changing track delays on stage, as it could result in undesirable clicks or
pops in the audio signal. Micro-offsets in Session View clips can be achieved using the Nudge
Backward/Forward buttons in the Clip View (page 136), however track delays can be used in
the Arrangement View for such offsets.

Note that delay compensation for plug-ins and Live devices is a separate feature (page 279),
and is automatic by default. Unusually high Track Delay settings or reported latencies from plug-
ins may cause noticeable sluggishness in the software. If you are having latency-related difficul-
ties while recording and playing back instruments, you may want to try turning off device delay
compensation, however this is not normally recommended. You may also find that adjusting the
individual track delays is useful in these cases. Note that the Track Delay controls are unavail-
able when device delay compensation is deactivated.
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Chapter 16

Recording New Clips

This chapter is about recording new clips from audio and MIDI input signals. Note that this is
a different kind of recording than the capturing of Session clips into the Arrangement (page
126).

For successful audio recording, please make sure the audio preferences are set up properly. For
more on this, please see the built-in program lesson on setting up Audio Preferences. Also, keep
in mind that devices such as microphones, guitars and turntables do not operate at line level,

meaning that they will need to have their levels boosted before they can be recorded. For these
devices, you must therefore use either an audio interface with a preamp, or an external preamp.

On MIDl tracks, itis possible to “capture” played material after you've played it, without the
need fo press the Record button beforehand. This allows for more freedom and flexibility when
you want to improvise or experiment. For more information, please refer to Capturing MIDI
(page 257).

16.1 Choosing an Input

A track will record whatever input source is shown in its In/Out section, which appears when the
View menu's In/Out option is checked. (In the Arrangement View, unfold and resize the track in
order to completely see the In/Out section.)
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The Track In/Out Section in the Arrangement (Left) and Session View (Right).

Audio tracks default to recording a mono signal from external input 1 or 2. MIDI tracks default
to recording all MIDI that is coming in through the active external input devices (page 214).
The computer keyboard is, by default, activated as a pseudo-MIDI input device (page 215),
allowing you to record MIDI even if no MIDI controller hardware is currently available.

For every track, you can choose an input source other than the default: any mono or stereo ex-
ternal input, a specific MIDI channel from a specific MIDI-in device, audio from ReWire slave
programs or a signal coming from another track. The Routing chapter (page 211) describes
these options in detail.

16.2 Arming (Record-Enabling) Tracks

Track Arm Buttons in the Arrangement (Left] and Session (Right] Mixers.

To select a track for recording, click on its Arm button. It doesn’t matter if you click a track’s
Arm button in the Session View or in the Arrangement View, since the two share the same set of

tracks.
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By default, armed tracks are monitored, meaning that their input is passed through their device
chain and to the output, so that you can listen to what is being recorded. This behavior is called
“auto-monitoring” and you can change it to fit your needs (page 212).

If you are using a natively supported control surface, arming a MIDI track will automatically lock
this control surface to the instrument in the track (page 574).

Clicking one track’s Arm button unarms all other tracks unless the [CTRL](PC) / [CMD](Mac)
modifier is held. If multiple tracks are selected, clicking one of their Arm buttons will arm the
other tracks as well. Arming a track selects the track so you can readily access its devices in the
Device View.

16.3 Recording

Recording can be done in both the Session and the Arrangement Views. If you want to record
onto more than one track simultaneously and/or prefer viewing the recording linearly and in-
progress, the Arrangement View may be the better choice. If you want to break your recording
seamlessly into multiple clips or record while you are also launching clips in Live, use the Session
View.

16.3.1 Recording Into the Arrangement

SEE | [+] .~ o 2 M Key  MDI 1% | D

Recording Into the Arrangement.

1. Pressing the Control Bar’s Arrangement Record button starts recording. The specific behav-
ior depends on the state of the “Start Playback with Record” button in the Record/Warp/
Launch preferences. When enabled, recording starts as soon as the button is pressed.
When disabled, recording will not start until the Play button is pressed (or Session clips are
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launched.) Tip: regardless of the state of this preference, holding [Shift] while pressing Ar-
rangement Record will engage the opposite behavior.

2. Recording creates new clips in all tracks that have their Arm button on.

3. When MIDI Arrangement Overdub is enabled, new MIDI clips contain a mix of the signal
already in the track and the new input signal. Note that overdubbing only applies to MIDI
tracks.

4.To prevent recording prior to a punch-in point, activate the Punch-In switch. This is useful
for protecting the parts of a track that you do not want to record over and allows you fo set
up a pre-roll or “warm-up” time. The punch-in point is identical to the Arrangement Loop's
start position.

5. Likewise, to prevent recording after the punch-out point, activate the Punch-Out switch. The
punch-out point is identical to the Arrangement Loop’s end position.

6. When you are recording into the Arrangement Loop (page 108), Live retains the audio
recorded during each pass.

You can later “unroll” a loop recording, either by repeatedly using the Edit menu’s Undo com-
mand or graphically in the Clip View: After loop recording, double-click on the new clip. In the
Clip View's Sample Display, you can see a long sample containing all audio recorded during
the loop-recording process. The Clip View's loop brace defines the audio taken in the last pass;
moving the markers left lets you audition the audio from previous passes.

16.3.2 Recording Into Session Slots

You can record new clips, on the fly, into any Session slots.
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Recording Into the Session View.

1. Set the Global Quantization chooser to any value other than “None” to obtain correctly
cut clips.

2. Activate the Arm button for the tracks onto which you want to record. Clip Record buttons
will appear in the empty slots of the armed tracks.

3. Click the Session Record button to record into the selected scene in all armed tracks. A
new clip will appear in each clip slot, with a red Clip Launch button that shows it is cur-
rently recording. To go from recording immediately into loop playback, press the Session
Record button again.

4. Alternatively, you can click on any of the Clip Record buttons to record into that slot. To go
from recording immediately into loop playback, press the clip’s Launch button.

5. To stop a clip entirely, press its Clip Stop button or the Stop button in the Control Bar.

Itis possible to stop playback and prepare for a new “take” with the New button. The New but-
ton stops clips in all armed tracks and selects a scene where new clips can be recorded, creat-
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ing a new scene if necessary. Note that the New button is only available in Key Map Mode and
MIDI Map Mode. Detailed steps for creating keyboard assignments are available in Computer
Keyboard Remote Control (page 583). Please refer to MIDI and Key Remote Control (page
573) for more information about MIDI assignments.

The New Button Appears in the Control Bar When Key Map Mode Is Active.

Note that, by default, launching a Session View scene will not activate recording in empty re-
cord-enabled slots belonging to that scene. However, you can use the Start Recording on Scene
Launch option from the Record/Warp/Launch Preferences to tell Live that you do want empty
scene slots to record under these circumstances.

16.3.3 Overdub Recording MIDI Patterns

Live makes pattern-oriented recording of drums and the like quite easy. Using Live’s Impulse
instrument and the following technique, you can successively build up drum patterns while listen-
ing to the result. Or, using an instrument such as Simpler, which allows for chromatic playing,
you can build up melodies or harmonies, note by note.

1. Set the Global Quantization chooser to one bar.

2. To automatically quantize the notes you are about to record, choose an appropriate value
for Record Quantization (page 254).

3. Double-click any of the Session View slots in the desired MIDI track (the one containing
the Impulse or other instrument). A new, empty clip will appear in the slot. The new clip will
defaultto a loop length of one bar, but you can change that by double-clicking the clip
and changing its loop properties (page 149).

4. Arm the track.
5. Press the Session Record button.

6. The notes you play are added into the looping clip, and you can observe your recording in
the Clip View.
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7. The clip overdubs as it loops, allowing you to build your pattern layer by layer. However, if
you would like to pause recording for @ moment to rehearse, you can deactivate overdub-
bing by pressing the Session Record button again. The contents of the clip will continue
to play, but you can play along without being recorded. When you are ready to record
again, press the Session Record button once again. Subsequent presses of the Session
Record button will toggle between playback and overdub.

Note that holding [ALT](PC) / [ALT](Mac) while double-clicking the empty slot to create a new
clip will implicitly arm the track and launch the clip.

At any time while overdub recording is going on, you can use the Undo command to remove the
last take, or even draw, move or delete notes in the Clip View’s Note Editor.

16.3.4 MIDI Step Recording

The MIDI Editor allows you to record notes with the transport stopped by holding down keys on
your controller or computer MIDI keyboard and advancing the insert marker according to the
grid settings. This process, known as step recording, allows you to enter notes at your own pace,
without needing to listen to a metronome or guide track.
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Step Recording in the MIDI Editor.
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1. Arm the MIDI track that contains the clip into which you want to record.
2. Enable the Preview switch in the clip’s MIDI Editor.

3. Click in the MIDI Editor to place the insert marker at the position where you want to begin
recording.

Pressing the right arrow key on your computer keyboard will move the insert marker to the right,
according to the grid settings. Any notes that are held down as you press the right arrow key will
be added to the clip. If you continue holding notes as you press the right arrow key again, you
will extend their duration. To delete notes that you've just recorded, keep them depressed and
press the left arrow key.

The step recording navigators can also be MIDI mapped (page 255).

16.4 Recording in Sync

Live keeps the audio and MIDI you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time before, after and
even during recording. You could, for instance, cheat a bit by turning down the tempo to record
a technically difficult part, and pull it up again afterwards.

It is important to record in sync to make sure everything will later play in sync.
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The Metronome Switch.

The easiest way to record in sync is to play along with or to use the built-in metronome, which is
activated via its Control Bar switch and will begin ticking when the Play button is pressed or a
clip is launched.
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The Preview Volume Knob.

To adjust the metronome volume, use the mixer’s Preview Volume knob. Further metronome set-
tings can be adjusted via the pull-down menu next to the metronome switch.

Notice that Live’s metrical interpretation of the material in a clip can be edited, at any time, using
Warp Markers (page 157). Warp Markers can be used to fix timing errors and to change the
groove or feel of your audio or MIDI recordings. Using Warp Markers, you can fix things that
would otherwise require complicated editing or could not be done at all.

16.4.1 Metronome Settings

You can access the Metronome Settings menu via the pull-down switch next to the metronome,
or by opening the context menu via [right-click](PC) / [CTRL-click](Mac) on the metronome itself.

The menu lets you set the count-in length for recording (page 254). You can also change the
sound of the metronome’s tick.

The Rhythm settings allow you to set the beat division at which the metronome ticks. With the
default “Auto” setting, the tick interval follows the time signature’s denominator. Beat divisions
that do not fit into one bar of the current time signature will appear disabled.

If the currently selected beat division no longer fits in a bar due to a time signature change, the
metronome’s tick will revert to the “Auto” setting. However, if the time signature is changed in a
way that makes the beat division fit in a bar again, the tick will revert to following the selected
beat division.

When Enable Only While Recording is checked and the metronome is activated, the metronome
will be highlighted while transport is running, but will only be audible while recording. If you are
recording into the Arrangement while the Punch-In switch is active, the metronome will only be
audible after the punch-in point.
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16.5 Recording Quantized MIDI Notes

If you will be recording MIDI, you have the option of automatically quantizing MIDI notes while
recording. The Record Quantization chooser in the Edit menu allows selecting the meter subdivi-
sions with which your recorded notes will align. When recording into the Arrangement, record
quantization is an independent step in Live’s Undo history. This means that if, for example, you
recorded with Record Quantization set to “Eighth Note Triplet Quantization” and then changed
your mind, using the Edit menu’s Undo command would undo only the quantization and leave
your recording otherwise intact.

For Session and Arrangement recording, the Record Quantization setting cannot be changed
mid-recording.

When overdub recording with the Clip View Loop activated, changes to the Record Quantiza-
tion take effect immediately, and they cannot be separately undone with the Edit menu com-
mand.

Recorded MIDI notes can also be quantized post-recording with the Edit menu’s Quantize com-
mand, as described in the chapter on editing MIDI (page 180).

16.6 Recording with Count-in

A count-in for recording can be set via the pull-down menu next to the Metronome switch. When
set to any value other than “None,” Live will not begin recording until the count-in is complete.
The Arrangement Position fields in the Control Bar display the count-in in blue as bars-beats-
sixteenths.

The Count-In is Displayed in the Control Bar.

The count-in runs from negative bars-beats-sixteenths (beginning at -2.1.1., for example, with a
Count-In setting of 2 bars) up to 1.1.1., at which point recording commences.

Note that count-in recording does not apply when using Link or when Live is synced to external
MIDI devices or being used as a ReWire slave (page 705).



Recording New Clips | 255

16.7 Setting up File Types

The following Preferences from the Record/Warp/Launch tab are relevant to the sample files
that are created by recording:

* The sample file type you would like Live to create can be chosen from the File Type choos-
er in the Record/Warp/Launch Preferences.

* The bit depth of the sample file you will create by recording can be chosen from the Bit
Depth chooser in the Record/Warp/Launch Preferences.

You can save time by setting up reasonable defaults for the clips you are recording in the Re-
cord/Warp/Launch Preferences tab. In particular, it is smart to indicate the rough category of
sound to be recorded by choosing the appropriate default Warp Mode. If you decide later on a
different song tempo, the program will automatically maintain good sound quality (page 165),
usually without further adjustment.

16.8 Where are the Recorded Samples?

Recorded samples are stored with the current Set's Project folder, under Samples/Recorded.
Until the Set is saved, it remains at the location specified by the Temporary Folder preference
which is found in the Preferences’ File/Folder tab. To make sure Live will not run out of disk space
while recording into a new Set, please make sure the Temporary Folder is on a drive/partition
with sufficient free space.

16.9 Using Remote Control for Recording

Using Key Map Mode and MIDI Map Mode (page 573), you can operate Live's recording
functions without using the mouse.

You can map the Control Bar’s Arrangement Record and transport controls as well as the track
Arm buttons. For recording into the Session slots, you can map the Session Record and New but-
tons, the individual slots, and the relative navigation controls to initiate recording remotely; for
instance:
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The Scene Up/Down Buttons.

One key is used to jump to the next scene...

A Track Launch Button.

... and another key to start and end recording in the respective track.

You can also map the step recording navigators (page 251).

The Step Recording Arrows.

This allows you to, for example, use MIDI foot pedals to move the clip’s insert marker, thereby
keeping both hands free for playing a keyboard.
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16.10 Capturing MIDI

Live is always listening to MIDI input on armed (page 246) or input-monitored tracks (page
212), and Capture MIDI lets you retrieve the material you've just played on those tracks. This
is particularly useful if you forgot to press the Record button before playing, or if you prefer to
improvise or experiment freely without the stress of recording.

b RO + EO 3. 1. 1|~
The Capture MIDI Button in the Control Bar.

To capture the MIDI notes you just played, press the Capture MIDI button. (Note: on Push (page
585) or Push 2 (page 635), you can trigger Capture MIDI by holding the Record button and
pressing the New button.)

Capture MIDI behaves differently depending on the state of the Live Set. We will look at these
different behaviors below.

(Note: Capture MIDI is not available in the Lite Edition.)

16.10.1 Starting a New Live Set

If the Live Set contains no other clips and the transport is stopped:

* A new clip containing the phrase you played will be created on every monitored MIDI
track. Note that Capture MIDI will only add clips to the Session or Arrangement View,
depending on which View is currently in focus.

* Capture MIDI will detect and adjust the song tempo, set appropriate loop boundaries
and place the played notes on the grid. Note that Capture MIDI’s tempo detection will set
the tempo in the 80-160 BPM range. If you consider the played material to be at a tempo
outside this range, you can adjust the song tempo to your liking. (Tip: to help Capture MIDI
detect a phrase correctly, it is recommended to end playing on the first beat (or “down-
beat”) of the next bar.)

* Live's transport will immediately begin to run, and play back the captured loop. This allows
you to create overdubs if you wish (for more information about overdubbing with Capture
MIDI, refer to the section Adding Material to an Existing Live Set below).
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¢ All of your played material will be saved in the clip, and any notes that you played before
the detected phrase will appear prior to the clip start marker. This enables you to adjust the
start/end or loop markers to set a different loop. (Tip: to discard unwanted material outside
the set loop, simply [right-click](PC) / [CTRL-click](Mac) on the clip and select the Crop
Clip command.)

16.10.2 Adding Material to an Existing Live Set

If Live's transport is running, there are already other clips in the Live Set, or the tempo is slaved
(page 711) or automated (page 311):

¢ Capture MIDI will not detect or adjust the song tempo. Instead, Capture MIDI will use the
existing tempo to detect a meaningful musical phrase from your played material and cre-
ate a loop.

* While the transport is running, you can “play along” with other clips. You can also use
Capture MIDI to “overdub” a playing clip, by playing over it on the same track. Pressing
the Capture MIDI button will add the material you just played on top of the existing clip’s
content, allowing you to build your pattern layer by layer.

* All of your played material will be saved in the clip, and any notes that you played before
the detected phrase will appear prior to the clip start marker. This allows you to adjust the
start/end or loop markers to set a different loop.
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Chapter 1/

Working with Instruments and
Effects

Every track in Live can host a number of devices. These devices can be of three different sorts:
* MIDI effects act upon MIDI signals and can only be placed in MIDI tracks.

¢ Audio effects act upon audio signals and can be placed in audio tracks. They can also be
placed in MIDI tracks as long as they are “downstream” from an instrument.

* Instruments are devices that reside in MIDI tracks, receive MIDI and output audio.

The Device View is where you insert, view and adjust the devices for the selected track. To select
a track and open the Device View to access its devices, double-click the track’s name. The De-
vice View appears in the bottom area of the Live screen.

Devices in the Device View.
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To save space in the Device View, a device can be collapsed by double-clicking on its title bar
or by choosing Fold from its [right-click](PC) / [CTRL-click](Mac) context menu.

Devices Can Be Folded.

To learn about a particular device and how to operate it, consult the Live Audio Effect Reference
(page 333), Live MIDI Effect Reference (page 423) or the Live Instrument Reference (page
435),

To learn about creating and using custom groupings of instruments and effects, check out the
Instrument, Drum and Effect Racks chapter (page 281).

Get “hands-on” with devices by assigning their parameters to MIDI or key remote control (page

573).
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17.1  Using the Live Devices

Devices in Live's Browser.

Live's built-in devices can be accessed in the browser. You will notice that Live’s Synths, Audio
Effects, and MIDI Effects each have their own labels in the browser’s sidebar.

The easiest way to place a device in a track is to double-click on it in the browser, which creates
a new track to hold the device. Alternatively, select a destination track by clicking within it, then
select a device or preset in the browser and press [Enter] to add it to the selected track.

You can also drag devices into tracks or drop areas in the Session and Arrangement Views, or
into the Device View. Dragging a sample to the Device View of a MIDI track creates a Simpler

instrument with this sample loaded.

Note: If you are using an external input signal to feed your Live track using the default settings,
the track’s Arm button in the mixer must be activated in order to hear the input through the de-
vices in your track’s device chain. On MIDI tracks, this is normally activated automatically when

inserting an instrument.
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MIDI and Audio Track Arm Buttons.

This is how you would play live instruments through effects on a track, for example, or use a
MIDI keyboard’s input to play a track’s instrument. Note that you can easily move from this setup
into recording new clips for further use in Live (page 245). If you have alternative monitoring
preferences, please see the Monitoring section (page 212) to learn how to make these set-
tings.

To add another device to the track, simply drag it there or double-click its name to append it to
the device chain. Signals in a device chain always travel from left to right.

You can drop audio effects in at any point in an audio track’s device chain, keeping in mind that
the order of effects determines the resulting sound. The same is true for a MIDI track’s device
chain.

If you drop an instrument into a MIDI track’s device chain, be aware that signals following (to
the right of) the instrument are audio signals, available only to audio effects. Signals preceding
(to the left of) the instrument are MIDI signals, available only to MIDI effects. This means that it's
possible for a MIDI track’s device chain to hold all three types of devices: first MIDI effects, then
an instrument, and finally audio effects.
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A MIDI Track’s Device Chain Can Contain All Three Device Types.

To remove a device from the chain, click on its title bar and press your computer’s [Backspace]
or [Delete] key, or select Delete from the Edit menu. To change the order of devices, drag a de-
vice by its title bar and drop it next to any of the other devices in the Device View. Devices can
be moved to other tracks entirely by dragging them from the Device View into the Session or
Arrangement Views.

Edit menu commands such as cut, copy, paste and duplicate can be used on devices. Pasted
devices are inserted in front of the selected device. You can paste at the end of a device chain
by clicking in the space after the last device, or by using the right arrow key to move the selec-
tion there. Generally, devices can be placed, reordered and deleted without interrupting the
audio stream.
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Device Activator Switches.

Devices are turned on and off using their Activator switches. Turning a device off is like tempo-
rarily deleting it: The signal remains unprocessed, and the device does not consume CPU cycles.
Live devices generally do not load down the CPU unless they are active. For more information,
please refer to the CPU load section (page 713). The Freeze Track command discussed there

is especially helpful when working with CPU-intensive devices.
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Devices in Live's tracks have input and output level meters. These meters are helpful in finding
problematic devices in the device chain: Low or absent signals will be revealed by the level
meters, and relevant device settings can then be adjusted, or the device can be turned off or
removed.

The Level Meters Between Devices in a Chain.

Note that no clipping can occur between devices because there is practically unlimited head-
room. Clipping can occur when an overly strong signal is sent to a physical output or written to a
sample file.

Further information about track types in Live can be found in the Routing and I/O chapter (page
211), including information on using return tracks to distribute the effect of a single device
amongst several tracks. After reading about using devices in Live, it might also be interesting to
look into clip envelopes (page 313), which can automate or modulate individual device pa-
rameters on a per-clip basis.

17.1.1  Live Device Presets

Every Live device can store and retrieve their parameter settings as presets. Each device ap-
pears in the content pane of the browser as a folder that can be opened to reveal its presets.
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Presets in the Browser.

You can browse and load presets quickly with the computer keyboard:
¢ Scroll up and down using the up and down arrow keys.
¢ Close and open device folders using the left and right arrow keys.
* Press [Enter] to load a device or preset.

Pressing [Q] or clicking a device’s Hot-Swap Presets button will temporarily link the browser to a
device and reveal its presets. With the device and browser linked in this manner, you can quickly
browse and audition different presets. In Hot-Swap Mode, devices and presets are loaded au-
tomatically upon selection in the browser. To load a device's default factory settings, select the
parent folder of its presets (i.e., the one with the device’s name) from the browser.

Note that pressing [Q] to enter Hot-Swap mode will swap from the last selected device on a
given track. If no device was selected, swap will be enabled from the first audio effect (on audio

tracks) or the instrument (on MIDI tracks).
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The Hot-Swap Presets Button.

The link between the browser and the device will be broken if a different view is selected, or if
the [Q] key or the Hot-Swap button is pressed again. Preset hot-swapping can also be cancelled
with a press of the [Esc] key or by pressing the close button in the Hot-Swap bar at the top of the
browser.

Note that although importing via the browser is the recommended method, presets can also be
dropped directly into Live from the Explorer (Windows)/Finder (Mac).

Saving Presets

You can create and save any number of your own presets in the browser’s User Library.

The Save Preset Button.

Click the Save Preset button to save a device's current settings (including any custom info text)
as a new preset. You will be redirected to the browser, where you can press [Enter] to use Live's
suggested name, or you can type one of your own. To cancel preset saving, press the [Esc] key.
You can also save presets to specific folders in the Places section of the browser (such as your
Current Project folder) by dragging from the title bar of the device and dropping into the brows-
er location of your choice.

For detailed information on what can be done with the browser, please see the Managing Files
and Sets chapter (page 59). For more on how to store project-specific presets, see the ap-
propriate section (page 92).
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Default Presets

Presets saved to the Defaults folders in your User Library will load in place of the generic device
settings. There are also Defaults folders that allow you to:

* customize how Live responds to various user actions, such as sample dropping, slicing,
and converting audio to MIDI.

* cause newly-created MIDI and audio tracks to load with certain devices already in place,
complete with custom parameter settings.

* load VST and Audio Units plug-ins with a specific collection of parameters already config-
ured in Live's panel.

The Default Presets folders in the User Library.

To save the current settings of a Live device as a default preset, open the [right-click](PC) /
[CTRL-click](Mac) context menu on the device's header and select “Save as Default Preset.” This
works for all of Live's instruments, MIDI effects and audio effects (including the various types of
Racks (page 281)). If you have already saved a default preset for a particular device, Live will
ask you before overwriting it.

To create a default configuration preset for a VST or Audio Unit plug-in:

¢ Load the selected plug-in to a track
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* From the plug-in's Configure Mode (page 273), set up your desired collection of param-
eters

* Open the [right-click](PC) / [CTRL-click](Mac) context menu on the track header and se-
lect “Save as Default Configuration”

If you have both VST and Audio Units versions of a particular plug-in installed, you can create
separate default configuration presets for each type. Note that default presets for plug-ins do
not save the settings of the configured parameters; only the parameter configuration within Live's
panel is saved.

To create default presets for MIDI and audio tracks:

* Load the device(s) you would like as default onto a track (or no devices, if you would like

your default track to be empty)
* Adjust the device parameters as you like

* Open the [right-click](PC) / [CTRL-click](Mac) context menu on the track header and se-
lect “Save as Default [Audio/MIDI] Track”

To specify how Live behaves when dragging a sample to a Drum Rack or the Device View of a

MIDI track:
* Create an empty Simpler or Sampler
¢ Adjust the parameters as you like
* Drag the edited device to the “On Drum Rack” or “On Device View" folder, which can be
found in the Defaults/Dropping Samples folders in your User Library. Drum Rack pad de-

faults can also be saved via a [right-click](PC) / [CTRL-click](Mac) context menu option on
a Drum Rack’s pad

To adjust how Live behaves when slicing an audio file:
* Create an empty Drum Rack
* Add an empty Simpler or Sampler to the Drum Rack to create a single chain

* Add any additional MIDI or Audio Effects to this chain



Working with Instruments and Effects | 269

¢ Adjust parameters in any of the devices
* Assign Macro Controls (page 296) to any of the controls in the chain’s devices
* Drag the entire Drum Rack to the Defaults/Slicing folder in your User Library

You can create multiple slicing presets and choose between them in the Slicing Preset chooser in
the slicing dialog.

Note that slicing is not available in the Intro and Lite Editions.
To create default presets for converting Drums, Harmony, or Melody to MIDI (page 192):

* Create a MIDI track containing the instrument you would like to use as your default for a
particular conversion type. (Note that default presets for converting drums must contain a
Drum Rack)

* Add any additional MIDI or Audio Effects to the track

¢ Adjust parameters in any of the devices

¢ If you're using multiple devices, group them to a Rack

* Drag the entire Rack to the appropriate folder in Defaults/Audio to MIDI in your User Li-
brary

In addition to these “master” default presets, you can also create default presets that are specific
to only one Project. This can be useful if, for example, you're using specialized device or track
configurations for a particular Set, and would like to create variations of the Set which will also
have access to these presets, but without overwriting the more generalized default presets you
use for your other types of work. To create Project-specific default presets:

* Recreate the Defaults folder and any desired subfolders within the Project folder.

* Depending on which types of Project-specific defaults you'd like to work with, adjust the
corresponding device parameters, track settings, etc.

* Save the device or track to the appropriate folder in your Project-specific Defaults folder.

Now, whenever you've loaded a Set from this Project, any default presets that you've saved into
these Project folders will be used instead of those found in the User Library. Note that the [right-
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click](PC) / [CTRL-click](Mac) context menu options for saving default presets will save them to
your main User Library, and so cannot be used to save Project-specific defaults.

17.2  Using Plug-Ins

The collection of devices that you can use in Live can be extended with plug-ins. Live supports
Steinberg Media’s VST Plug-ins format, as well as the Audio Units (AU) Plug-ins format (Mac OS
X only).

Working with VST and Audio Units Plug-ins is very much like working with Live devices. VST and
AU instruments can only be placed in Live MIDI tracks and, like Live instruments, they will receive
MIDI and output audio signals. Plug-in audio effects can only be placed in audio tracks or fol-
lowing instruments. Please see the previous section, Using the Live Devices (page 261), for
details.

Plug-Ins in the Browser.

Audio Units and VST Plug-ins are browsed and imported using the browser’s Plug-In label. Plug-
in instruments can be differentiated from plug-in effects in the browser, as they appear with a
keyboard icon.

Note that plug-in presets are only available in the browser for Audio Units Plug-ins. In some
instances, factory presets for Audio Units will only appear in the browser once the device has
been placed in a track and its Hot-Swap button activated.
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Note: The first time you start Live, no plug-ins will appear in the Plug-In label as you must first
“activate” your plug-in sources. Activating your plug-in sources tells Live which plug-ins you
want to use and where they are located on your computer. Information on activating (and de-
activating) plug-in sources can be found later in this chapter, in the sections on the VST Plug-in
folder (page 275) and Audio Units Plug-ins (page 278).

Note for “Intel® Mac” users: Intel® Mac computers cannot natively run VST or AU plug-ins that
have been written for the PowerPC platform. Only plug-ins of type Universal or Intel® can be
used in Live.

If you install/de-install a plug-in while the program is running, Live will not detect your changes
or implement them in the browser until the next time you start the program. Use the Rescan but-
ton in the File/Folder Preferences to rescan your plug-ins while Live is running, so that newly
installed devices become immediately available in the browser.

You can also rescan if you believe that your plug-in database has somehow become corrupted.

Holding down the [ALT](PC) / [ALT](Mac) modifier while pressing Rescan will delete your plug-
in database altogether and run a clean scan of your plug-ins.

17.2.1  Plug-Ins in the Device View

A VST Plug-In in the Device View.

Once a plug-in is dragged from the browser into a track, it will show up in the Device View. For
plug-ins with up to 64 modifiable parameters, a Live panel will represent all of the parameters
as horizontal sliders. Plug-ins that contain more than 64 parameters will open with an empty
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panel, which you can then configure to show the parameters you want to access. The plug-in’s
original interface can be opened in a separate window (page 272).

The Plug-In Unfold Button.

You can view or hide the plug-in's parameters by toggling the ® button in the plug-in’s title bar.
The X-Y control field can be used to control two plug-in parameters at once and is therefore

especially well-suited for live control. To assign any two plug-in parameters to the Live panel X-Y
field, use the drop-down menus directly beneath it.

Showing Plug-In Panels in Separate Windows

O 1 (@ |Pancake2
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The Plug-In Edit Button.

The Plug-In Edit button opens a floating window that shows the original VST or Audio Units Plug-
in panel. Changing parameters on the floating window has the same effect as changing them in
the Live panel, and vice versa.

There are a few important Plug-In Preference settings for working with plug-in edit windows:

* If activated, the Auto-Open Plug-In Custom Editor Preference assures that plug-in custom
editor windows open automatically when plug-ins are loaded into tracks from the browser.

* If the Multiple Plug-In Windows option in the Plug-In Preferences is activated, you can
open any number of plug-in windows at once. Even with this option off, you can hold
down the [CTRL](PC) / [CMD](Mac) modifier when opening a new plug-in window to
keep the previous window(s) from closing.
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* Using the Auto-Hide Plug-In Windows preference, you can choose to have Live display
only those plug-in windows belonging to the track that is currently selected.

You can use the View menu’s Show,/Hide Plug-In Windows command or the [CTRL][ALT][P](PC)
/ [CMD][ALT][P](Mac) shortcut to hide and show your open plug-in windows. Notice that the
name of the track to which the plug-in belongs is displayed in the title bar of the plug-in editor
window.

Plug-In Configure Mode

The Configure Button.

Configure Mode allows you to customize Live's panel to show only the plug-in parameters that
you need to access. To do this:

* Enter Configure Mode by pressing the “Configure” button in the device’s header.

¢ Click on a parameter in the plug-in edit window to add it to Live’s panel. (For some plug-
ins, it may be necessary to actually change the parameter’s value. Additionally, certain
plug-ins do not “publish” all of their parameters to Live. These parameters cannot be
added to Live's panel.)

While in Configure Mode, parameters in Live's panel can be reordered or moved by dragging
and dropping them to new locations. Parameters can be deleted by pressing the [Delete] key. If
you try to delete a parameter that has existing automation data, clip envelopes, or MIDI, key or
Macro mappings, Live will warn you before proceeding.

The parameters that you assign are unique for each instance of a given plug-in in your Set, and
are saved with the Set. If you would like to save a setup using a particular collection of param-
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efers, you can create a Rack (page 281) containing the configured plug-in. Racks can then be
saved to your User Library and loaded into other Sets. You can also save a particular parameter
configuration as a default preset (page 267).

Certain plug-ins do not have their own windows, and instead only show their parameters in
Live's panel. For these plug-ins, it is not possible to delete parameters when in Configure Mode
(although they can still be moved and reordered).

There are several ways to add plug-in parameters to Live's panel without entering Configure
Mode:

¢ Adjusting a parameter in the plug-in’s floating window creates temporary entries for that
parameter in the clip envelope and automation choosers, as well as the choosers in the
panel’s X-Y field. These entries are removed when you adjust another parameter. To make
the entry permanent (thus adding it to Live’s panel), either edit the parameter’s automation
or clip envelope, select another parameter in the automation or clip envelope choosers or
select the temporary parameter in one of the X-Y field’s choosers.

* When a parameter is changed on a plug-in’s edit window during recording, automation
data is recorded automatically. When recording is stopped, the automated parameters are
automatically added to Live's panels for any plug-ins that were adjusted.

* When in MIDI, key or Macro mapping mode, adjusting any parameter in the plug-in's
window will create it in Live's panel. The new panel entry will be automatically selected,

allowing you to map it immediately.

Once a plug-in is placed in a track and you have (optionally) configured its parameters in Live's
panel, you can use it just like a Live device:

* You can map MIDI controller messages to all of the parameters in Live's panel.

* You can drag or copy the device to different locations in the device chain or to other
tracks, according to the rules of audio effects and instruments.

* You can automate or modulate its continuous parameters with clip envelopes.
* You can use the multiple |/O features of some plug-ins by assigning them as sources or
targets in the routing setup of tracks. See the Routing and /O chapter (page 211) for

details.

* You can create custom info text for the plug-in.
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Macintosh only: The floating editor windows of some VST Plug-ins do not receive computer key
strokes. This is generally an implementation error in the plug-in itself. If it is necessary to type into
a plug-in window, for instance for entering a serial number or unlock code, hold down [Shif]
while clicking the Plug-In Edit button. The editor window will then appear as a “normal” applica-
tion window, rather than as a floating window, and receive your typing. Note that this function-
ality is intended only as a workaround for the limitations of such plug-ins. We recommend clos-
ing the window after you have finished typing, then reopening it normally before working with

the plug-in parameters.

17.3 VST Plug-Ins

17.3.1  The VST Plug-In Folder

When you start Live for the first time, you will need to activate your VST Plug-in sources before
working with VST Plug-ins. Depending on your computer platform, you may also have to tell Live
about the location of the VST Plug-in folder containing the devices you want to use. In order to
set up your VST sources, press the Activate button in the browser’s Plug-In panel, or open the
File/Folder Preferences by pressing [CTRL][,](PC) / [CMD][,]{Mac). There you will find the Plug-

In Sources section.

Setting up VST Plug-In Sources for Windows.

For Windows, proceed as follows:

1. Use the VST Plug-In Custom Folder entry to tell Live about the location of your VST Plug-ins:
Click the Browse button to open a folder-search dialog for locating and selecting the ap-

propriate folder.

2. Once you have selected a VST Custom Folder and Live has scanned it, the path will be
displayed. Note that, on Windows, Live may have found a path in the registry without the

need for browsing.
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3. Make sure that the Use VST Plug-In Custom Folder option is set to “On,” so that your se-
lected folder is an active source for VST Plug-ins in Live. Note that you can choose not to
use your VST Plug-ins in Live by turning off the Use VST Plug-In Custom Folder option.

Plug-In Sources

Rescan Plug-Ins
Use Audio Units m

Browse

Setting up VST Plug-In Sources for Mac OS X.

Set up your VST Plug-ins under Mac OS X by doing the following:

1. Your VST Plug-ins will normally be installed in the following folder in your home and local
directories: /Library/Audio/Plug-Ins/VST. You can turn Live's use of these plug-ins on or
off with the Use VST Plug-ins in System Folders option.

2. You may have an alternative folder in which you store your VST Plug-ins (perhaps those
that you use only with Live). You can use VST Plug-ins in this folder in addition to, or instead
of, those in the System folders. To tell Live about the location of this folder, click the Browse
button next to the VST Plug-In Custom Folder entry to open a folder-search dialog for lo-
cating and selecting the appropriate folder.

3. Note that you can turn off your VST Plug-ins in this folder using the Use VST Plug-In Custom
folder option.

Once you have configured your Plug-In Preferences, the browser will display all plug-ins it finds
in the selected VST Plug-in folder(s) as well as any sub-folders.

Itis also possible to use VST Plug-ins stored in different folders on your computer. To do this,
create a Mac OS or Windows alias of the folder where additional VST Plug-ins are stored, and
then place the alias in the VST Plug-In Custom folder (or in the VST Plug-In System folder on Mac
OS X) selected in Live's File/Folder Preferences. The alias can point to a different partition or
hard drive on your computer. Live will scan the set VST Plug-in folder as well as any alias folders
contained therein.

Some VST Plug-ins contain errors or are incompatible with Live. During the scanning process,
these may cause the program to crash. When you re-launching Live, a dialog will appear to
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inform you about which plug-in caused the problem. Depending on what Live detects about the

plug-in, you may be given the choice between performing another scan or making the problem-
atic plug-in unavailable. If you choose to rescan and they crash the program a second time, Live
will automatically make them unavailable, meaning that they will not appear in the browser and
will not be rescanned again until they are reinstalled.

17.3.2 VST Presets and Banks

Every VST Plug-in instance “owns” a bank of presets. A preset is meant to contain one complete
set of values for the plug-in’s controls.

To select a preset from the plug-in's bank, use the chooser below the title bar. The number of

presets per bank is fixed. You are always working “in” the currently selected preset, that is, all
changes to the plug-in's controls become part of the selected preset.
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The VST Plug-In Preset Chooser.

Note that VST presets are different from Live device presets: Whereas the presets for a Live
device are shared among all instances and Live Sets, the VST presets “belong” to this specific
instance of the VST Plug-in.

To rename the current preset, select the VST's Device Title Bar and execute the Edit menu’s Re-
name Plug-In Preset command. Then type in a new preset name and confirm by pressing [Enter].
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Renaming a VST Plug-In Preset.

VST presets and banks can be imported from files. Clicking a VST's Load Preset or Bank button
brings up a standard file-open dialog for locating the desired file.
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The VST Load Preset or Bank Button (left] and Save Preset or Bank Button (Right).

Windows only: Please select from the File Type filter in the Windows dialog whether you want to
locate VST Presets (VST Program Files) or VST Banks (VST Bank Files).

To save the currently selected preset as a file, click the VST Save Preset or Bank button to bring
up a standard file-save dialog; select “VST Preset” from the Format menu (Macintosh)/from the
File Type menu (Windows); select a folder and name. For saving the entire bank as a file, pro-

ceed likewise but choose “VST Bank” as a file type/format.

17.4  Audio Units Plug-Ins

Audio Units Plug-ins are only available in Mac OS X. In most respects, they operate just like VST
Plug-ins.

An Audio Units Plug-In.

The first time you open Live, Audio Units Plug-ins will not appear in the browser. In order to acti-
vate your Audio Units as a plug-in source, please press the Activate button in the browser’s Plug-
In label, or go to the File/Folder Preferences by pressing [CTRL][,](PC) / [CMD][,](Mac). There
you will find the Plug-In Sources section. Turning on the Use Audio Units option activates Audio
Units Plug-ins so that they appear in Live's browser.
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Note that you can always turn this option off later if you decide not to use Audio Units.

Plug-In Sources

Rescan Plug-Ins
Use VST Plug-In System Folders Off

Activating Audio Units Plug-Ins.

Audio Units Plug-ins sometimes have a feature that allows choosing between different modes for
the device. You might be able to choose, for example, between different levels of quality in the
rendering of a reverb. Choosers for these device modes can only be accessed through the origi-
nal plug-in panel, which is opened using the Plug-In Edit button.

UDistortion

Opening an Audio Units Plug-In Window.

Audio Units have presets that function just like those for the Live effects. However, some AU pre-
sets cannot be dragged to different locations in the browser, as they are read-only.

Audio Units presets have an .aupreset extension and are stored in the following directory ac-
cording to their manufacturer’s name:

[Home]/Library/Audio/Presets/[Manufacturer Name] /[Plug-in Name]

17.5 Device Delay Compensation

Live automatically compensates for delays caused by Live and plug-in instruments and effects,
including those on the return tracks. These delays can arise from the time taken by devices to
process an input signal and output a result. The compensation algorithm keeps Live's tracks in
sync while minimizing delay between the player’s actions and the audible result.
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Device delay compensation is on by default and does not normally have to be adjusted in any
way. However, Live Sets that were created with Live 4 or earlier will open without device delay
compensation. To manually turn latency compensation on (or off), use the Delay Compensation
option in the Options menu.

When Delay Compensation is on, the Reduced Latency When Monitoring option is available in
the Options menu. This option toggles latency compensation on and off for tracks which have in-
put monitoring on. When enabled, input-monitored tracks will have the lowest possible latency,
but may be out of sync with some other tracks in your Set (such as Return tracks, which are still
delay compensated.) When disabled, all tracks will be in sync, but input-monitored tracks may
have higher latency.

Note that tempo-synced effects and other devices that get timing information from Live's internal
clock may sound out of sync if they are placed in a device chain after devices which cause de-

lay.

Unusually high individual track delays (page 244) or reported latencies from plug-ins may
cause noticeable sluggishness in the software. If you are having latency-related difficulties
while recording and playing back instruments, you may want to try turning off device delay
compensation, however this is not normally recommended. You may also find that adjusting the
individual track delays is useful in these cases, but please note that the Track Delay controls are
unavailable when device delay compensation is deactivated.

Note that device delay compensation can, depending on the number of tracks and devices in
use, increase the CPU load.
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Chapter 18

Instrument, Drum and Effect
Racks

Inside An Audio Effect Rack.

A Rack is a flexible tool for working with effects, plug-ins and instruments in a track’s device
chain. Racks can be used to build complex signal processors, dynamic performance instruments,
stacked synthesizers and more. Yet they also streamline your device chain by bringing together
your most essential controls. While Racks excel at handling multiple devices, they can extend the
abilities of even a single device by defining new control relationships between its parameters.

Racks greatly expand upon the concept of device groups introduced in Live 5. The device
groups of any Live Sets imported from Live 5 are automatically converted to Racks. Note that
these Live Sets, once saved, can no longer be opened in older versions of Live.
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18.1 An Overview of Racks

18.1.1  Signal Flow and Parallel Device Chains

Inside An Audio Effect Rack.

In any of Live's tracks, devices are connected serially in a device chain, passing their signals
from one device to the next, left to right. By default, the Device View displays only a single chain,
but there is actually no limit to the number of chains contained within a track.

Racks allow (among other things) additional device chains to be added to any track. When a
track has multiple chains, they operate in parallel: In Instrument and Effect Racks, each chain
receives the same input signal at the same time, but then processes its signal serially through its
own devices. The output of each of the parallel chains is mixed together, producing the Rack'’s
output.

Drum Racks also allow multiple parallel chains to be used simultaneously, but their chains pro-
cess input somewhat differently: Rather than receiving the same input signals, each Drum Rack
chain receives input from only a single assigned MIDI note.

The entire contents of any Rack can be thought of as a single device. This means that adding a
new Rack at any point in a device chain is no different than adding any other device, and Racks
can contain any number of other Racks. If more devices are placed after a Rack in a track’s de-
vice chain, the Rack’s output is passed on to them, as usual.
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18.1.2 Macro Controls

The Macro Controls.

One unique property of Racks are their Macro Controls.

The Macro Controls are a bank of eight knobs, each capable of addressing any number of
parameters from any devices in a Rack. How you use them is up to you — whether it be for con-
venience, by making an important device parameter more accessible; for defining exotic, multi-
parameter morphs of rhythm and timbre; or for constructing a mega-synth, and hiding it away
behind a single customized interface. See Using the Macro Controls (page 296) for a detailed
explanation of how to do this.

For the greatest degree of expression, try MIDI-mapping (page 578) the Macro Controls to
an external control surface.

18.2 Creating Racks

Four Rack variants cover the range of Live's devices: Instrument Racks, Drum Racks, Audio Effect
Racks and MIDI Effect Racks. Just as with track types, each kind of Rack has rules regarding the
devices it contains:

* MIDI Effect Racks contain only MIDI effects, and can only be placed in MIDI tracks.

* Audio Effect Racks contain only audio effects, and can be placed in audio tracks. They
can also be placed in MIDI tracks, as long as they are “downstream” from an instrument.

* Instrument Racks contain instruments, but can additionally contain both MIDI and audio
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effects. In this case, all MIDI effects have to be at the beginning of the Instrument Rack'’s
device chain, followed by an instrument, and then any audio effects.

* Drum Racks (page 292) are similar to Instrument Racks; they can contain instruments as
well as MIDI and audio effects and their devices must be ordered according to the same
signal flow rules. Drum Racks can also contain up to six return chains of audio effects, with
independent send levels for each chain in the main Rack.

There are different ways to create Racks. A new, empty Rack can be created by dragging a
generic Rack preset (“Audio Effect Rack,” for example) from the browser into a track. Devices
can then be dropped directly into the Rack’s Chain List or Devices view, which are introduced in
the next section.

If a track already has one or more devices that you would like to group into a Rack, then simply
select the title bars of those devices in the Device View, and [right-click](PC) / [CTRL-click](Mac)
on one of the title bars to reveal the Group and Group to Drum Rack commands in the context
menu. Note that if you repeat this command again on the same device, you will create a Rack
within a Rack. You can also group multiple chains within a Rack using the same procedure. Do-
ing this also creates a Rack within a Rack. In the Device View, the contents of Racks are always
contained between end brackets: Just as with punctuation or in mathematics, a Rack within a
Rack will have a pair of brackets within a pair of brackets.

To ungroup devices, dismantling their Racks, select the Rack’s title bar, and then use the Edit
menu or the context menu to access the Ungroup command.

18.3 Looking at Racks

-1 1 i 1

Components of an Effect Rack.
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Components of a Drum Rack.

1. Racks have distinct views that can be shown or hidden as needed. Therefore, every Rack
has a view column on its far left side that holds the corresponding view selectors. The ac-
tual view selectors available differ depending on whether an Instrument, Drum or Effect
Rack is being used.

2. Macro Controls
3. Chain List. In Drum Racks, this view can include both drum chains and return chains.
4. Devices

5. Racks are also identifiable by their round corners, which bracket and enclose their content.
When the Devices view is shown, the end bracket visually detaches itself to keep the Rack
hierarchy clear.

6. Pad View (page 294). This is unique to Drum Racks.

To move, copy or delete an entire Rack at once, simply select it by its title bar (as opposed to the
title bars of any devices that it contains). When selected, a Rack can also be renamed by using
the Edit menu’s Rename command. You can also enter your own info text for a Rack via the Edit
Info Text command in the Edit menu or in the Racks's [right-click](PC) / [CTRL-click](Mac) context

menu.

When all of a Rack'’s views are hidden, its title bar will fold into the view column, making the
entire Rack as slim as possible. This has the same effect as choosing Fold from the [right-click]
(PC) / [CTRL-click](Mac) context menu or double-clicking on the Rack’s title bar.

If you would like to locate a particular device in a Rack without searching manually through its
entire contents, you will appreciate this navigation shortcut: [right-click](PC) / [CTRL-click](Mac)
on the Device View selector, and a hierarchical list of all devices in the track’s device chain will
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appear. Simply select an entry from the list, and Live will select that device and move it into view
for you.

Navigate Racks Quickly Via a Context Menu.

18.4 Chain List

The Chain List in an Audio Effect Rack.

As signals enter a Rack, they are first greeted by the Chain List. We will therefore also choose
this point for our own introduction.

The Chain List represents the branching point for incoming signals: Each parallel device chain
starts here, as an entry in the list. Below the list is a drop area, where new chains can be added
by dragging and dropping presets, devices, or even pre-existing chains.
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Note: Racks, chains and devices can be freely dragged into and out of other Racks, and even
between tracks. Selecting a chain, then dragging and hovering over another Session or Ar-
rangement View track will give that track focus; its Device View will open, allowing you to drop
your chain into place.

Since the Device View can show only one device chain at a time, the Chain List also serves as a
navigational aid: The list selection determines what will be shown in the adjacent Devices view
(when enabled). Try using your computer keyboard’s up and down arrow keys to change the
selection in the Chain List, and you'll find that you can quickly flip through the contents of a Rack.

The Chain List also supports multi-selection of chains, for convenient copying, organizing and
regrouping. In this case, the Devices view will indicate how many chains are currently selected.

Each chain has its own Chain Activator, as well as Solo and Hot-Swap buttons. Chains in Instru-
ment, Drum and Audio Effect Racks also have their own volume and pan sliders, and Drum Rack
chains have additional send level and MIDI assignment controls. Like Live Clips, entire chains
can be saved and recalled as presets in the browser. You can give a chain a descriptive name
by selecting it, then choosing the Edit menu’s Rename command. You can also enter your own
info text for a chain via the Edit Info Text command in the Edit menu or in the chain’s [right-click]
(PC) / [CTRL-click](Mac) context menu. The context menu also contains a color palette where
you can choose a custom chain color.

18.4.1 Auto Select

Auto Select in an Audio Effect Rack.

When the Auto Select switch is activated, every chain that is currently processing signals be-
comes selected in the Chain List. In Drum Racks, this feature will select a chain if it receives its
assigned MIDI input note. In Instrument and Effect Racks, Auto Select works in conjunction with
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zones, which are discussed next, and is quite helpful when troubleshooting complex configura-
tions.

18.5 Zones

Zones are sets of data filters that reside at the input of every chain in an Instrument or Effect
Rack. Together, they determine the range of values that can pass through to the device chain.
By default, zones behave transparently, never requiring your attention. They can be reconfig-
ured, however, to form sophisticated control setups. The three types of zones, whose editors are
toggled with the buttons above the Chain List, are Key, Velocity, and Chain Select. The adjacent
Hide button whisks them out of sight.

Note: Audio Effect Racks do not have key or velocity zones, since these two zone types filter
MIDI data only. Likewise, Drum Racks have no zones at all; they filter MIDI notes based on
choosers in their chain lists.

Zones contain a lower, main section, used for resizing and moving the zone itself, and a narrow
upper section that defines fade ranges. Resizing of either section is done by clicking and drag-
ging on its right or left edges, while moving is accomplished by clicking and dragging a zone
from anywhere except its edges.

18.5.1 Signal Flow through Zones

To understand how zones work, let's examine the signal flow in a MIDI Effect Rack. Our MIDI
Effect Rack resides in the device chain of a MIDI track, and therefore processes MIDI signals.
We will assume that it contains four parallel device chains, each containing one MIDI effect.

1. All MIDI data in the track is passed to its device chain, and therefore into the input of the
MIDI Effect Rack.

2. Our MIDI Effect Rack has four device chains, all of which receive the same MIDI data at
the same time.

3. Before any MIDI data can enter a device chain, it must be able to pass through every zone
in that chain. Every chain in a MIDI Effect Rack has three zones: a key zone, a velocity

zone and a chain select zone.
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4. An incoming MIDI note gets compared to a chain’s key zone. If the MIDI note lies within
the key zone, it is passed to the next zone for comparison; if it does not, then we already
know that the note will not be passed to that chain’s devices.

5. The same comparisons are made for the chain’s velocity and chain select zones. If a note
also lies within both of these zones, then it is passed to the input of the first device in that
chain.

6. The output of all parallel chains is mixed together to produce the MIDI Effect Rack’s final

output. If there happened to be another device following after the Rack in the track’s de-
vice chain, it would now receive the Rack’s output for processing.

18.5.2 Key Zones

The Key Zone Editor.

When the Key button is selected, the Key Zone Editor appears to the right of the Chain List, il-
lustrating how each chain maps to the full MIDI note range (nearly 11 octaves). Chains will only
respond to MIDI notes that lie within their key zone. The zones of individual chains may occupy
any number of keys, allowing for flexible “keyboard split” setups.

Key zone fade ranges attenuate the velocities of notes entering a chain.
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18.5.3 Velocity Zones

The Velocity Zone Editor.

Each chain in an Instrument Rack or MIDI Effect Rack also has a velocity zone, specifying the
range of MIDI Note On velocities that it will respond to.

The Velocity Zone Editor, when displayed, replaces the Key Zone Editor to the right of the Chain
List. MIDI Note On velocity is measured on a scale of 1-127, and this value range spans the top

of the editor. Otherwise, the functionality here is identical to that of the Key Zone Editor.

Velocity zone fade ranges attenuate the velocities of notes entering a chain.

18.5.4 Chain Select Zones

The Chain Select Editor.

Activating the Chain button in an Instrument or Effect Rack displays the Chain Select Editor.
These Racks have chain select zones, which allow you to filter chains spontaneously via a single
parameter. The editor has a scale of 0-127, similar to the Velocity Zone Editor. Above the value
scale, however, you will find a draggable indicator known as the Chain selector.
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The chain select zone is a data filter just like the other zones; although all chains in a Rack re-
ceive input signals, only those with chain select zones that overlap the current value of the Chain
selector can be addressed and thereby produce output.

By default, the chain select zones of Instrument and MIDI Effect Racks filter only notes, ignoring
all other incoming MIDI events (such as MIDI CCs). To filter all MIDI events, enable the Chain
Selector Filters MIDI Ctrl option, available in the context menu [right-click](PC) / [CTRL-click]
(Mac) of a Rack’s Chain Select Ruler.

In MIDI Effect Racks, fade ranges attenuate the velocities of notes entering a chain. In Instrument
Racks and Audio Effect Racks, which both output audio signals, fade ranges attenuate the vol-
ume level at each chain’s output. So what happens, then, if the Chain selector is moved outside
of the chain select zone where a sound is currently playing? If the zone ends in a fade range, the
chain’s output volume is attenuated to zero while the Chain selector is outside of the zone. If the
zone had no fade range, the output volume is not attenuated, allowing the chain’s effects (like
long reverb tails or delays) to fade out according to their own settings.

Let's consider how we can make use of chain select zones in a performance situation:

Making Preset Banks Using Chain Select

Using Chain Select Zones to Create Effects Presefs.

Unlike the other zone types, the default length of a chain select zone is 1, and the default value
is 0. From this setup, we can quickly create “preset banks” using the Chain Select Editor.

Again, we will use a Rack with four chains as our starting point. Each of the four chains contain
different effects that we would like to be able to switch between. To make this a “hands-on”
experience, we have MIDI-mapped the Chain selector to an encoder on an external control
surface.
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Let's move the chain select zones of the second and third chains so that each of our zones is oc-
cupying its own adjacent value: The first chain’s zone has a value of O, the second chain’s zone
has a value of 1, the third has a value of 2, and the fourth has a value of 3.

Since each of our chain select zones has a unique value, with no two zones overlapping, we
now have a situation where only one chain at a time can ever be equal to the Chain selector
value (shown at the top of the editor). Therefore, by moving the Chain selector, we determine
which chain can process signals. With our MIDI encoder at hand, we can now flip effortlessly
between instrument or effect setups.

Crossfading Preset Banks Using Fade Ranges

Crossfading Between Effects Presets Using Chain Select Zones.

Taking the previous example one step further, we can tweak our chain select zones to produce a
smooth transition between our “presets.” To accomplish this, we will make use of our zones’ fade

ranges.

To create some room for fading, let's extend the length of our zones a bit. Setting the zones as
shown maintains four exclusive values for our presets, so that each still has one point where
neither of the others are heard. We crossfade between the presets over eight steps. If this is too
rough a transition for your material, simply reposition the zones to maximize the fade ranges.

18.6 Drum Racks

We've already talked a bit about Drum Racks, and most of their features are the same as those
found in Instrument and Effect Racks. But Drum Racks have a slightly different layout, some
unique controls and special behavior that is optimized for creating drum kits.
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The Chain Listin a Drum Rack.

1. In addition to the standard selectors found on all Racks, Drum Racks have four additional
controls in the view column. From top to bottom, these are toggles for the Input/Output,
Send, and Return sections, and the Auto Select button.

2. Input/Output Section. The Receive chooser sets the incoming MIDI note to which the drum
chain will respond. The list shows note names, MIDI note numbers and standard GM drum
equivalents. The Play slider sets the outgoing MIDI note that will be sent to the devices in
the chain. The Choke chooser allows you to set a chain to one of sixteen choke groups.
Any chains that are in the same choke group will silence the others when triggered. This
is useful for choking open hihats by triggering closed ones, for example. If “All Notes" is
selected in the Receive chooser, the Play and Choke choosers are disabled — in this case,
the chain simply passes the note that it receives to its devices. The small Preview button to
the left of these choosers fires a note into the chain, making it easy to check your mappings
away from a MIDI controller.

3. Mixer Section. In addition to the mixer and Hot-Swap controls found in other Rack types,
Drum Racks also have send sliders. These sliders allow you to set the amount of post-fader
signal sent from each drum chain to any of the available return chains. Note that send con-
trols are not available until return chains have been created.

4. Return Chains. A Drum Rack’s return chains appear in a separate section at the bottom of
the chain list. Up to six chains of audio effects can be added here, which are fed by send
sliders in each of the drum chains above.

The Audio To chooser in the mixer for return chains allows you to route a return chain’s output to
either the main output of the Rack or directly to the return tracks of the Set.



Instrument, Drum and Effect Racks | 294

18.6.1 Pad View

Pad View.

The Pad View is unique to Drum Racks and offers an easy way to map and manipulate samples
and devices. Each pad represents one of the 128 available MIDI notes. The pad overview to the
left shifts the set of visible pads up or down in groups of 16, either by dragging the view selector
to a new area or by using your computer keyboard’s up and down arrow keys. Use the [ALT](PC)
/ [CMD](Mac) modifier to shift the view by single rows instead.

Almost any object from Live's browser — samples, effects, instruments and presets — can be
dragged onto a pad, mapping automatically to the pad’s note and creating or reconfiguring
internal chains and devices as necessary. Dropping a sample onto an empty pad, for example,
creates a new chain containing a Simpler, with the dropped sample ready to play from the pad’s
note. If you then drag an audio effect to the same pad, it is placed downstream from the Simpler
in the same chain. To replace the Simpler, simply drop another sample onto the same pad — any
downstream audio effects or upstream MIDI effects will be left intact and only the Simpler and
sample will be replaced.

In addition to dragging objects from the browser, pads can also be filled quickly via Hot-Swap.
If you're in Hot-Swap mode, pressing the [D] key will toggle the Hot-Swap target between the
Drum Rack itself and the last selected pad.

If a multi-selection of samples is dropped onto a pad, new Simplers and chains will be mapped
upwards chromatically from this pad, replacing any other samples that may have already been
assigned to the pads in question (but, as before, leaving any effects devices alone). [ALT](PC) /
[CMD](Mac)-dragging a multi-selection layers all of the samples to a single pad, by creating a
nested Instrument Rack.
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Dragging a pad to another pad swaps the note mapping between the pads. This means that any
MIDI clips triggering the affected notes will now play the “wrong” sounds — although this might
be exactly what you want. [ALT](PC) / [CMD](Mac)-dragging one pad to another will layer any
chains from both pads in a nested Instrument Rack.

You can always change your mappings from within the chain list as well, by adjusting the Re-
ceive choosers. The Pad View will update automatically to reflect your changes. If you set the
same Receive note for multiple chains, that note’s pad will trigger them all.

If you're working with lots of nested Racks, the inner structure can quickly become complicated.
Pad View can make it much easier to work by letting you focus on only the top level: the notes
and sounds. It's important to remember that a pad represents a note, rather than a chain. More
specifically, it represents all chains, no matter how deep in the Rack, that are able to receive that
pad’s note. What you can control with each pad is related to how many chains it represents:

* An empty pad shows only the note it will trigger. When you mouse over it, the Status Bar
will display this note, as well as the suggested GM instrument.

* A pad that triggers only one chain shows the name of the chain. In this case, the pad
serves as a handy front-end for many controls that are normally accessed in the chain list,
such as mute, solo, preview and Hot-Swap. You can also rename and delete the chain via
the pad.

* A pad that triggers multiple chains shows “Multi” as its name, and its mute, solo and pre-
view buttons will affect all of its chains. If you mute and solo chains individually within the
chain list, the pad’s icons reflect this mixed state. Hot-Swap and renaming are disabled for
a Multi pad, but you can delete all of its chains at once.

Although Pad View is designed for easy editing and sound design, it also excels as a perfor-
mance interface, particularly when triggered by a hardware control surface with pads. If your
pad controller is one of Ableton’s natively supported control surfaces (page 574), simply

select it as a control surface in the Link/MIDI tab of Live's Preferences. From then on, as long as
you have a Drum Rack on a track that's receiving MIDI, your pad controller will trigger the pads
that are visible on your screen. If you scroll the pad overview to show a different set of pads,
your controller will update automatically.
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18.7 Using the Macro Controls

Making Macro Control Assignments in Map Mode.

With the potential for developing complex device chains, Macro Controls keep things manage-
able by taking over the most essential parameters of a Rack (as determined by you, of course).
Once you have set up your ideal mapping, the rest of the Rack can be hidden away.

The Macro Control view’s dedicated Map button opens the door to this behavior. Enabling
Macro Map Mode causes three things to happen:

* All mappable parameters from a Rack’s devices will appear with a colored overlay;
* Map buttons will appear beneath each Macro Control dial;
* The Mapping Browser (page 578) will open.
The following steps will get you started mapping:
1. Enable Macro Map Mode by clicking the Map mode button;
2. Select a device parameter for mapping by clicking it once;
3. Map the parameter by clicking on any Macro Control’s Map button. The details will be
added to the Mapping Browser. By default the Macro will take its name and units from the

device parameter it is controlling.

4. Refine the value range if desired using the Min/Max sliders in the Mapping Browser. In-
verted mappings can be created by setting the Min slider’s value greater than the Max
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slider’s value. The current values can also be inverted by pressing [right-click](PC) / [CTRL-
click](Mac) on the entry in the Mapping Browser.

5. Select another device parameter if you'd like to create more mappings, or click on the
Map mode button once more to exit Macro Map Mode.

Note that once assigned to a Macro Control, a device parameter will appear disabled, since
it hands over all control to the Macro Control (although it can still be modulated externally, via
Clip Envelopes (page 313)).

You can edit or delete your assignments at any time using the Mapping Browser (which only ap-
pears when Map Mode is enabled).

If more than one parameter is assigned to a single Macro, the Macro’s name will revert to its ge-
neric name (e.g., Macro 3). The Macro's units will also change to a 0 to 127 scale, except when
all parameters possess both the same unit type and the same unit range.

Macro controls can be given custom names, colors and info text entries via the corresponding
commands in the Edit menu or the context menu.

18.8 Mixing With Racks

Any Instrument or Drum Rack that contains more than one chain can be viewed and mixed
alongside the tracks in the Session View’s mixer. A track that contains these Racks will have a ®
button in its title bar, which will fold the Rack’s mixer in or out. Likewise, any nested chains within
the Rack will also have this button. This makes it easy to get an overview of your Rack’s hierarchy
— or hide it when you just want to work on your mix.
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Mixing Rack Chains in the Session View.

Chains in the Session View mixer look similar to tracks, but they have no clip slots. Their mixing
and routing controls mirror those found in the Rack’s chain list, so any changes made to these
controls in either area will be reflected in the other immediately. Likewise, many chain operations
such as reordering, renaming and regrouping can be performed from either the mixer or the
chain list. Clicking in a chain’s mixer title bar shows only that chain’s devices in the Device View.

As with tracks, when chains are multiselected in the Session View mixer, adjusting a mixer pa-
rameter for one of the chains will adjust the same parameter in the other selected chains. Note
that this behavior only applies to parameters adjusted via the Session mixer and not when ad-
justing the same parameters in the Rack’s chain list.

18.8.1 Extracting Chains

All chains can be dragged from their parent Racks and placed into other tracks or Racks, ei-
ther from the chain list or from the Session View mixer. A Drum Rack’s return chains can also be
extracted, and will create new return tracks if dragged to the mixer. Drum chains have an ad-
ditional feature: when dragged from the mixer to a new track, they take their MIDI notes with
them. For example, if you are working on a MIDI drum loop within a single track and decide that
you would like to move just the snare onto its own track, simply select the snare chain’s title bar
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in the mixer and drag it to the mixer’s drop area. This creates a new track with the full contents of
the snare chain: both its devices and its MIDI data. If you would like to extract only the devices,
drag from the chain list instead of